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ROLE OF SELF INSTRUCTIONAL MATERIAL IN DISTANCE
LEARNING

The need to plan effective instruction is imperative for a successful distance
teaching repertoire. This is due to the fact that the instructional designer, the
tutor, the author (s) and the student are often separated by distance and may
never meet in person. This is an increasingly common scenario in distance
education instruction. As much as possible, teaching by distance should
stimulate the student's intellectual involvement and contain all the necessary
learning instructional activities that are capable of guiding the student through
the course objectives. Therefore, the course / self–instructional material are
completely equipped with everything that the syllabus prescribes.
To ensure effective instruction, a number of instructional design ideas are
used and these help students to acquire knowledge, intellectual skills, motor
skills and necessary attitudinal changes. In this respect, students&#39;
assessment and course evaluation are incorporated in the text.
The nature of instructional activities used in distance education self–
instructional materials depends on the domain of learning that they reinforce
in the text, that is, the cognitive, psychomotor and affective. These are further
interpreted in the acquisition of knowledge, intellectual skills and motor skills.
Students may be encouraged to gain, apply and communicate (orally or in
writing) the knowledge acquired. Intellectual– skills objectives may be met
by designing instructions that make use of students'prior knowledge and
experiences in the discourse as the foundation on which newly acquired
knowledge is built.
The provision of exercises in the form of assignments, projects and tutorial
feedback is necessary. Instructional activities that teach motor skills need to
be graphically demonstrated and the correct practices provided during
tutorials. Instructional activities for inculcating change in attitude and behavior
should create interest and demonstrate need and benefits gained by adopting
the required change. Information on the adoption and procedures for practice
of new attitudes may then be introduced.
Teaching and learning at a distance eliminates interactive communication
cues, such as pauses, intonation and gestures, associated with the face–to–
face method of teaching. This is particularly so with the exclusive use of
print media. Instructional activities built into the instructional repertoire
provide this missing interaction between the student and the teacher.
Therefore, the use of instructional activities to affect better distance teaching
is not optional, but mandatory.



Our team of successful writers and authors has tried to reduce this. Divide
and to bring this Self Instructional Material as the best teaching and
communication tool. Instructional activities are varied in order to assess the
different facets of the domains of learning.
Distance education teaching repertoire involves extensive use of self–
instructional materials, be they print or otherwise. These materials are
designed to achieve certain pre–determined learning outcomes, namely goals
and objectives that are contained in an instructional plan. Since the teaching
process is affected over a distance, there is need to ensure that students actively
participate in their learning by performing specific tasks that help them to
understand the relevant concepts. Therefore, a set of exercises is built into
the teaching repertoire in order to link what students and tutors do in the
framework of the course outline. These could be in the form of students'
assignments, a research project or a science practical exercise. Examples of
instructional activities in distance education are too numerous to list.
Instructional activities, when used in this context, help to motivate students,
guide and measure student's performance (continuous assessment).



PREFACE
We have put in lots of hard work to make this book as user–friendly as
possible, but we have not sacrificed quality. Experts were involved in
preparing the materials. However, concepts are explained in easy language
for you. We have included many tables and examples for easy understanding.
We sincerely hope this book will help you in every way you expect.
All the best for your studies from our team!
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BLOCK 1 : Introduction to Computer

Block Introduction

This block covers fundamental of computer and gives insight

in impact of computer technology on society, education, industry,

government and business. Learner will get introduction to computer

hardware as well as software and different types of software. It also

covers file and data management in windows operating system.

Block Objectives

The objective of this block is to :

1. Examine the impact of computer technology on society, education,
industry, government and business.

2. Operate a personal computer and computer peripherals.

3. Explain effective file and directory in windows operating system.

Block Structure

Unit–1 : Impact and History of Computers

Unit–2 : Computer Hardware

Unit–3 : Software

Unit–4 : File and Data Management



: UNIT STRUCTURE :

1.0 Learning Objectives
1.1 Introduction

1.2 Computer Technology
1.3 Information Technology (IT) – The Concepts
1.4 Computer technology in Work and Play

1.5 Let Us Sum Up
1.6 Answers for Check Your Progress

1.7 Glossary
1.8 Assignment

1.9 Activity
1.10 Case study
1.11 Further Readings

1.0 Learning Objectives :

After studying this unit learner should be able to :

• Define terms and explain characteristics associated with computer
technology.

• Discuss the influence of computer technology in a society.

• Discuss the contributions of computer technology to education.

• Discuss the contributions of computer technology to business.

• Discuss the contributions of computer technology to everyday living.

• Define information technology.

• Explore the main uses of computers in society.

• Describe the impact of computers on society, education, industry,
government and business.

• Identify the advantages and disadvantages of computer technology in
various aspects of society.

• Discuss the man–machine connection.

1.1 Introduction :

Technology influences different areas of society and business, whether
it is a particular age group or gender, or the entire population. We may be
resistant to its influences, whether in the long or short term, until we are
more aware on how this change impacts our lives, families, work,
entertainment, or daily living.

Unit
1

IMPACT AND HISTORY OF
COMPUTERS

1
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This unit explains terms associated with computer technology, explains
its influence, and contributions to various aspects of work and play. Then
it briefly reviews the development of the technology and explains the
different categories of computer systems.

1.2 Computer Technology :

Let us start by understanding the concept of computer technology.
Quickly, in 30 seconds, calculate the answer to 12 + 54 + 23.65 + 12.89
+ 23¼ + 90 + 12 + 980 + 234 + 567 in your head or on paper. Did you
complete it in time ? See the next page for the answer.

You may be surprised to learn that people were the first computers!
The term computer means someone who computes or performs calculations.
Centuries ago, people were called computers. They were usually women
who worked out mathematical problems such as tidal charts or navigational
tables, and so 'Computer' was actually a job title.

However, as you can imagine, performing mathematical tasks every
day, every week, every month would eventually cause boredom which
would cause errors in the calculations.

Therefore, the computer became a machine which automated these
repetitive tasks.

A computer therefore is a machine which:

• accepts data (called INPUT);

• follows instructions given on what to do with the data (called
PROCESSING);

• stores the results for future use (called STORAGE); and

• display the results (called OUTPUT).

Answer : 2008.79
By applying technology to different problems and work environments

we can enhance situations or events that would have been almost
inconceivable without it. For example, voice mail, satellite television or cell
phones are all examples of technology that use a computer to operate the
system. Computer technology therefore involves any machine, tool or piece
of equipment that is essentially controlled by a computer chip that is able
to make calculations.

The role of computers and computer technology is the ability to
manipulate data into

information or commands. Data can be in many forms, such as text,
pictures or sound and can also be retrieved from the environment. An air
conditioner which monitors the temperature in a room to keep it cool at
a specific temperature, or turning on lights outside a building at dusk are
both examples of a computer–controlled environment that requires input to
produce a specific result or output.
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Air Conditioner Automated Lights
Input Current Temperature Dusk

Desired Temperature

Output AC adjusts temperature to Lights On

desired temperature

Computer Technology is Everywhere
Information has become very important as a result of the computer

technology which provides it. Computer driven technology is an integral
part of our daily routines, however we tend not be aware of its presence.
Many of our daily tasks are automated; such as our answering machines,
televisions, cable boxes, vehicles that use this technology. Similarly, as a
cashier prints out our receipt for a purchased item or the mail, we receive
that was stamped by a machine, computer technology supported the
creation of the receipt or the delivery of our mail automatically.

We therefore say that computer technology is ubiquitous, or everywhere
(almost!) once information is present. To summarize, many utility companies
are now recording our usage to prepare monthly bills, which will be printed
by a machine, while a local or overseas phone company record voice
messages and the calls we missed. Also, our banks' automated systems are
automatically charging us every time we use the debit or credit card. The
automated systems are controlled by a computer process based on the input
from your retailer, the machine itself or from the scanner.

Generating Information

Remember that computers store the results or output of processing
the data. Well computer technology has enabled us to access information
at our "finger tips"; from many places, in many places, at any time, and
in many different forms whether printed or stored.

Hence as more information is requested, more information is generated
and more data stored. It seems like a never–ending cycle of information
growing exponentially!

Unfortunately, there is a drawback to generating information on every
transaction. Imagine how one minor error can mushroom into major
problems because of your computer technology, and this can have a
negative impact on businesses and customers alike. In addition, most
people who are not in the computer field may believe that whatever the
computer produces is correct. Consider the consequences of transposing
(switching) two digits in a bank account number or entering the wrong data
in payroll system. This can cause embarrassment to the persons involved
if deposits are made to the wrong account or employees do not receive the
correct pay. Even so, it is also more difficult to locate someone who is
willing to accept responsibility for an error made by a computerized
system. This lack of accountability for the error would be better addressed
if the software glitch was corrected as soon as possible!
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We should also realize that since information is constantly generated,
then it should be possible to store it over a long period of time. It is
reasonable to assume therefore that information cannot be entirely destroyed
or lost.

Accessing Information

Much of the computer information that is generated and held in a
database is available online. For example, customers can use the telephone
or Internet to access current bank balances and perform transactions. Access
to your banking information can be made from almost anywhere in the
world. This has led to a new work ethic where computer technology has
enabled employees to work from various geographic locations, or time
zones. Computer technology has provided people with increased mobility
while talking with someone on the phone, or receiving a fax.

Information can be retrieved and sent in many forms including text,
voice, graphics, photos and video. Additionally, the "information
superhighway" has increased the availability of these forms of information
delivery methods. One major concern of the recording industry is the ability
to reproduce digital material such as video tapes and DVDs, which are
indistinguishable from the original. This technology has caused headaches
to the industry's composers and performers since any digital file can be
easily duplicated and shared.

With access to information, and digital voice and smart technologies
automated voices have replaced operators who traditionally greeted customers
and initially responded to their queries. It is now commonplace to call
businesses and hear an automated switching system and voice–mail system
instead of an actual person who can assist you.

Surveillance

Computer technology has certainly allowed surveillance or the
gathering of information for different of purposes. Surveillance software
allows individuals, companies and government to monitor you in a variety
of locations including other countries. Surveillance equipment such as
cameras and key pads now include transactional data which is collected
from virtually all types of transactions, including cash purchases and the
acquisition of services to analyze trends. One example is the use of Google
Earth to capture topographical pictures of different locations on the earth
and more recently Google has released their street view software that allows
you to wander the streets of your city using 3D technologies.

Changing the Way, We Communicate
With the use of the computer and its technology used extensively

throughout our society, you are probably aware of how computer technology
has changed the way we communicate with another person or among groups
of people. The use of email, instant messenger and text messages have
modified the usual visual and verbal signs when communicating with
someone else. This of course can be both a benefit and a detriment to the
communication process. For example, the use of computer tools such as
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email, instant messenger and text messages mask features such as gender,
race, age, and physical disability, social or marital status.

Even distance learning has changed the way people are educated, as
this manual and your online activities illustrate! Your relationship with the
facilitator is remote and you may only hear a voice or read the words on
a page written by your instructor. Much of the distance or blended learning
materials and content are delivered through the use of databases, audio or
video feeds and other means such as Moodle or Blackboard. This has
become a reality for many who wish to further their education while
employed full–time or those who are unable to access a physical campus
at a local institution.

1.3 Information Technology (IT) – The Concepts :

As noted in Topic 1.2 computers play a major role in our daily lives.
Business demands the use of computers to support business operations. As
an entrepreneur it is important that you understand and use computer
technologies effectively to help grow your business.

Before exploring the details of a business computer environment, you
need to understand what we mean by information technology and how it
influences society.

What is information technology ?

Let's first look at some key terms before we define the concept
information technology. Let's start with the term information. Information
refers to data that has been put into a meaningful and useful context.

Information systems refer to a set of people, procedures and resources
that collects, transforms, and disseminates information in an organization.
Information systems are implemented within an organization for the
purpose of improving the effectiveness and efficiency of that organization.

As an entrepreneur you will need to use a system to provide for the
flow of information within your business. Computers is playing a vital part
in obtaining, processing and sharing information within a business which
means that an entrepreneur will have to make use of a computer–based
information system.

This requires that you must have an understanding technology used
in computer–based information systems – use of hardware, software and
people resources to transform data resources into information.

Back to our question : What is meant by Information Technology ?

Information Technology (IT) is the area of managing technology and
spans a wide variety of areas that include but are not limited to things such
as processes, computer software, information systems, computer hardware,
programming languages, and data constructs. In short, anything that renders
data, information or perceived knowledge in any visual format whatsoever,
via any multimedia distribution mechanism, is considered part of the
domain space known as Information Technology (IT) (Wikipedia).
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TechAmerica defines IT as the study, design and implementation of
computer–based information systems, particularly software applications
and computer hardware. IT deals with the use of electronic computers and
computer software to convert, store, protect, process, transmit and securely
retrieve information (www.answer.com).

The discipline of Information Systems can best be described as the
effective analysis, design, construction, delivery, management and use of
information and information technology in organizations and society. An
Information System, per se, is an organized collection of people, procedures,
data, machines and services that work together to deliver information
(http://www.is.ru.ac.za/?q=content?2). So, we can conclude that:

Information technology (IT) refers to the different ways (electronic
computers and computer software) of obtaining, processing, storing,
and transmitting data in the form of voice, pictures and words.

The term Information Technology (IT) is also known as Information
Communication

Technology (ICT), and we shall continue to use that term henceforth
because it combines computing and communications. The computer is a key
feature of ICT and the key to an effective business is how the entrepreneur
uses his or her ICT resources to grow and manage the business.

It is clear from our brief discussion that computer technology plays
a vital role in everyday life.

IMPACT OF INFORMATION AND COMMUNICATION
TECHNOLOGY (ICT) ON SOCIETY

Today's society is referred to as the 'digital age'. Computers and ICT
devices have become an integral part of our lives and are used everywhere.
Be it the desktop computers, laptop computers or more recently tablet
computers, all contribute to the activities we experience in our daily life.
We use these devices in schools, at home, hospitals, institutions, businesses
and even in government offices.

In general, the impact of computers on society and how we live our
lives is as follows:

• You can use computers to communicate with your family and friends,
create a household budget, book travel and movie tickets, or manage
your business. The internet has also tremendously increased people's
ability to communicate with others from all over the world efficiently
and relatively cheaply.

• In business and industry, you use computers to maintain accounts,
create personnel records, track inventory, prepare presentations and
reports, manage projects, and communicate by e–mail. You can use
computers to design any type of publication ranging from simple
newsletters to fashion magazines, marketing materials, books, or
newspapers.
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• In the field of education, trainers can use computers to deliver
training through audio–visual learning aids, maintain student records
to track performance, search for information on different topics, and
create or submit assignments.

• In government organizations, you use computers to organize
information by storing and updating records. Computers are also used
for providing services to citizens. For example, you can view
information on current policies and government issues on a computer.

• In the field of medicine, doctors use computers to review medical
records of patients. Doctors also use computers to find information
about the latest drugs available to treat a disease.

• Doctors can also use computer technology to discuss and share
information about various diseases.

• You can use computers to view the details of your bank account.
Traders use computer technology to get instant information on stock
markets, to trade stocks, and to manage investments.

• Scientists use computers for scientific research, and to gather and
analyze information. For example, they use computers to view
images from space and to publish information on their recent
research.

• You can also use computers to create drawings and paintings.
Photographers use computers to edit and enhance pictures. Writers
use computers to write content for their books and to also create
illustrations. By using computers, writers can make changes in the
content easily and save a lot of time.

• In the field of entertainment, you can use computers to listen to
music, watch movies, store and print photographs, send greetings,
and play games.

[Source : Microsoft Corporation]

Threats to Information Systems
Computer–based information systems are much more vulnerable to

crime and abuse, natural disaster, and even human error than manual
systems that they have replaced.

A. Computer Crime : Computer Crime ranges from the use of
information technology to commit an act that would be criminal no
matter how committed (such as the theft of money or other property)
to activities more specifically related to computers, such as the
unauthorized access and use of information systems, theft of computer
and telecommunications services, and the theft, intentional alteration,
or destruction of data or programs. The protection of customer data
and business confidential information is an issue that faces all
entrepreneurs.

B. Theft of Money : As financial institutions become more and more
reliant on computers, new opportunities have arisen for criminals to
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use computers to steal or siphon off money. Password protection and
other security tools must be used to protect bank accounts, investments
and other financial resources.

C. Theft of Computers and Computer Parts : As computers and the
various computer parts have become smaller and smaller, it has
become easier to steal. Microprocessor chips, memory chips,
motherboards, modems, disk drives, and power supplies are all
frequent targets. They can be removed relatively easily and sold to
a readily available underground market. Physical security and effective
inventory control measures should be implemented.

D. Alteration or Destruction of Data and Programs : Another form
of computer crime involves the alteration or destruction of data and
programs. Motives for this crime may include monetary gain, revenge
or just being malicious. This tie in with computer viruses, which are
a set of illicit instructions implanted within a program that passes
itself onto other programs with which it comes into contact. Appropriate
software must be used to protect your business files, data and other
online resources from external and internal attacks by cyber criminals
and hackers.

E. System Disasters : In addition to computer crime, information
systems are susceptible to natural disasters (Rain, earthquakes, fire
and floods), terrorist attack, electrical power and telecommunications
line failure, hardware and software malfunction, even human error.
Off–site backups and in some cases backups to computers in another
island or nation is recommended when your region is subjected to
regular national disasters.

1.4 Computer Technology in Work and Play :
Now that we have understood some terminology and features of

computer technology, let us look more closely at various aspects of work
and play, and how technology affects each one.

This section will allow discussion on some of the impacts in the last,
and thoughts on the next decade.

Inventions already introduced into society through computer
technology, have caused the society to change, with the cellular phone (or
cell phone) being the most recent to reach the populations. It is now an
everyday occurrence to reach anyone, anywhere with the use of a cellular
phone. Not as openly known, but still commonplace however, is the use
of the smart prosthesis on someone who previously could not walk after
an accident. Simulations of people walking or running for example have
furthered the invention of essential types of prostheses.

Science, Medicine, Health and Technology
Simulation and simulators are often used in scientific research to

mimic the event that is being studied. These programs quickly perform
number crunching calculations, so that the event can be accelerated, slowed
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or changed to help predict and test certain outcomes. Therefore, programs
can assist with the simulation of training in dangerous situations, without
using expensive resources.

Since health care matters to everyone, it is not surprising that
computer technology has become a natural part of our health and wellbeing,
but its use and relevance has implications in everything we do…and not
do! If you would like to explore how medical organizations are using
simulation and other computer technologies to provide professional
development to health care professionals and support science education in
the schools go to the Howard Hughes Medical Institute, Bio–interactive
site.

Computer technology is integral part of the health and wellness
sector. CTI scanners and other diagnostic tools are driven by computer
technology. Our health records are placed into databases to be used and
retrieved when you visit the hospital or your local doctor.

Science has had an incredible impact within the last century. Toffler
in his book "The Third Wave" has identified computer technology as a new
phase in the evolution of society. Technology has made the following
medical procedures possible. Many of these procedures have generated
considerable debate about the ethics of these procedures.

Some of these procedures include the use of technology to support:

• test tube babies;

• organ transplants;

• cloning;

• nuclear radiation;

• limb replacement;

• gene therapy; and

• nerve regeneration.

Telemedicine
Some of you may have previously seen or heard the terms

teleconferencing or telecommuting. The Greek word 'tele' means 'distance',
so teleconferencing provides opportunities to have a conference without all
persons having to be in the same room, city or country. Similarly
telecommuting or the less popular term, 'tele–working', was first offered
in the 1960s by the information technology industry. This arrangement
allowed employees to work at home and communicate with the office by
methods such as phone, fax and computer.

So, we now have yet another term 'telemedicine', where 'medicine'.
Telemedicine involves telecommunications, where medical personnel and
their patients are separated by some physical distance but are connected
through technology so the professional can complete a medical procedure.
Some of the services offered by telemedicine include medical diagnoses,
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pathology, radiology, and consultation, so that expertise can be made
available in rural and remote areas.

Medical Self–Diagnoses

Many people are using knowledge–based database systems to research
cures and

symptoms of ailments, probably for self–diagnoses. These database
systems, called expert systems perform tasks that would otherwise be
performed by someone with expertise in the field. Expert systems can be
used, not only to diagnose human illnesses, but also to make financial
forecasts, and schedule routes for delivery vehicles. However, it is important
to note that while some expert systems replace human experts, there are
others designed to assist them.

Having a medical complaint which is embarrassing should not be the
sole reason to avoid consulting a doctor. Although there are well–documented
and researched medical expert systems (such as WebMD) being able to
access a website on the Internet to diagnose symptoms does not automatically
validate the authenticity or correctness of the online diagnosis. Only a
doctor can do this.

Database technologies are now used to store dental records, x–rays,
medical insurance forms and other records for administrative, management
and cross referencing. Here are some further examples of the development
of database systems with associated technologies which are used as expert
systems and have become tools for medical research.

Research
Research on genetics has discovered entire sets of genetic instructions

in the cells of our body, their sequences and any possible unique features
or abnormalities. Using computer technology has afforded:

The discovery of a gene which has the pre–disposition to develop
colon cancer can save a life if genetic screening is done early. In contrast,
persons in the early 1970s were either denied insurance coverage or were
asked to pay increased premiums if they carried the gene for sickle cell
anaemia.

Forensic personnel used computer technology to assist in the
identification of people missing at the World Trade Centre. Tools were used
to compare the victims' DNA with an item used by the victims, such as a
toothbrush.

Education and Technology

Computer technology has moved the classroom from a teacher using
a 'chalk and blackboard' to deliver passive instruction to student centred,
discovery learning environments that employ a variety of computer and
Internet technologies. Computer technology has allowed disenfranchised
students in places like rural areas who at one time could not participate in
traditional instruction to benefit from an anywhere, anyplace philosophy for
the delivery of educational programs.
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In Barbados, technology is now becoming a part of the classroom
with the assistance of a government sponsored educational initiative called
Edutech 2000. This programme is providing training in Information and
Computer Technologies (ICTs) for teachers and students alike in order to
develop the country's future workforce and ensure the country has suitable
skills to compete in the international market.

In most countries today the typical public–school program includes
some instruction in computer technology, computer literacy skills and
software familiarization. Most public schools throughout the Caribbean
and parts of Africa have access to computers within their schools.
Technology is being used to support instruction and increase student and
teacher technical knowledge and skills.

The introduction of computers to support classroom instruction has
met mixed reactions. Some teachers embrace it, but many resists it because
they don't have the pre–requisite skills to properly employ the technologies.
Change will take time, resources and more teacher professional development.
The Commonwealth of Learning is supporting the Open School Movement
and the use of ICT to support instruction and student learning. Check it
out.

Computer technologies and the advent of the Internet have allowed
online universities to flourish. Examples of fully online universities include
Indira Gandhi National Open University, National Open University of
Nigeria, Athabasca University and the Open University of the United
Kingdom Online universities and similar organizations around the world
provide opportunities for millions of students to study anywhere and at any
time.

Working professionals are now able to further their education without
having to travel while maintaining full–time employment and an appropriate
quality of life.

There are some disadvantages however with online activities, which
include the lack of opportunity for human interaction and socialization.
Many online students experience the feeling of isolation. Although the
inclusion of online discussion forums and chat capabilities have somewhat
alleviated this problem, there is still an issue with misinterpretation and
miscommunication associated with text messages and phrases.

The online learning environment is slowly embracing new technologies
like Podcasts, social networking software like Facebook, instant messaging
technologies like Skype and web conferencing systems like Elluminate.
Web 2.0 tools are helping close the social divide and providing more
opportunities to interact with peers learners and others in the educational
communities.

Business and Technology
Computer technology has had a major impact on day–to–day business

operations. Today companies that have failed to incorporate technology are
viewed as being 'not–up–to–date' or archaic. Today organizations must
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have a presence on the Internet. Their company's goods and services must
be marketed online. Prolific use of electronic mail (or email) and electronic
forms have replaced paper–based forms and traditional snail mail (letters
mailed through a post office). It is now the norm for business professionals
to use technology to produce every memo, envelope, label and document
using a word processer. Effective marketing materials require the use of
graphic software and more to create and produce the layouts. Business
presentations are created using computer software and delivered via laptop
computers and projectors. Electronic payments and business banking
accounts require the use of e–commerce software and secure Internet
connections. The computer revolution has allowed traditional businesses to
reduce infrastructure costs by allowing their employees to work from home.
In North America over 40 million employees work from home using
different types of Information and Communications Technologies (ICTs).

As traditional business practices become automated business leaders
and HR personnel now demand that their current and future employees be
computer literate. In the many parts of the developing world, it is proving
to be a challenge for those who are unable to reach the required standard
thus impacting their employability.

Social Interactions and Relationships
The ability to text chat in a real time environment with your peers

is known as Internet Relay Chat (IRC). IRC tools to support chat are
available through your cell phone provider or on the Internet. Some of the
more popular real time chat tools include Microsoft Live Messenger, Yahoo
Messenger and others. These tools are becoming the norm for social
interaction (especially among younger computer users) and it challenges in
how people have traditionally interacted with each other – face to face
discussions vice text chats with its own sub–culture language.

Man–Machine Connection
I would hope by now that you would agree much of the world cannot

live without having some form of computer technology in their lives. Does
this mean that we are controlling computer technology or is the technology
controlling us–During the late 1980s and 1990s, the Internet invaded our
lives. Movies and TV shows included the Internet and sophisticated
computers to entertain us. Some interesting ones were the 1982–1986
weekly television crime fighter series 'Knight Rider' which portrayed a
modern–day hero who drove a high–tech smart car equipped with artificial
intelligence. Sandra Bullock's 1995 movie 'The Net', involved an Alfred
Hitchcock style drama about having her identity electronically erased and
replaced with a stranger's information. Then in 1998, there is Will Smith
starring in 'Enemy of the State' which speaks about the use of satellites to
track people, as well as in 'I Robot' in 2004 about a 'humanoid' robot that
is suspected to have murdered its creator. Whether you have seen these
movies or not, the implicit use of computer technology in each of them
sends the message that whether to help or hinder, that technology is
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everywhere. Today it is digitally generated 3D movies and animations like
Avatar have caught our attention. These movies would not be possible
without computer generated images and human machine interactions to
capture life like character movement.

Technology has advanced so fast that more and more computers have
an incredibly high fault tolerance, with robots automating the repair
process, without any human intervention. One example are the robots that
are used by NASA to repair the International Space Station. Seriously, we
are not that far away from computers repairing themselves.

Let us now consider computer logics. Do "they" have the capability
of handling complex thought processes like human ones ? Almost!

An Example – Man Machine Practical Application

In 1998, a technology entrepreneur in northeastern Washington was
implanted with a Radio Frequency Identification (RFID) chip into his hand
in order to experiment with the technology. The chip and supporting
computer technology were used to gain keyless entry to his car and home,
turn on lights, logon to his and other remote and repetitive applications.
The experiment was successful and led to other applications for RFID
technology.

An implantable RFID chip is a minuscule capsule containing a
microchip and an antenna, all enclosed in glass. The chip is about the size
of a grain of rice. RFID chips work by storing a unique identification
number in the microchip. This number can be retrieved by a special RFID
reader that is held within close proximity. Today there are most often
implemented in animals to track their whereabouts and to include owner
information that can be retrieved by a scanner used by a vet or other animal
agency Although RFID technology is relatively old, it is still considered
a controversial technology.

Privacy advocates fear that the technology might be abused by
governments and used to track people. Microchip implants have been used
for years for tracking lost pets. Further European research in the area was
recently dealt a blow when the European Group on Ethics in Science and
New Technologies made a presentation to the European Union raising
privacy concerns over the potential for such chips to be used to track
members of the public.

When employing different technologies, we must be aware of not
only the technical issues, but issues of privacy, morality, society norms and
ethical practices.

Check Your Progress :

1. What is computer ?

2. Define: Information Technology

3. List Threats to Information Systems
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4. Data should be

(a) Relevant (b) Complete (c) Accurate (d) All of these

5. _________ often used in scientific research to mimic the event that
is being studied.

(a) Simulation (b) Simulators

(c) Simulation and simulators (d) None of these

6. The ability to text chat in a real time environment with your peers
is known as

(a) Internet Relay Chat (b) Interactive Relay Chart

(c) Internet Response Chat (d) Interactive Relay Chat

7. ________provides opportunities to have a conference without all
persons having to be in the same room, city or country

(a) Telecommuting (b) Teleconferencing

(c) Telemedicine (d) Expert System

8. What is full form of RFID ?

(a) Radio Frequency Identification

(b) Receiver Frequency Identification

(c) Radio Frequency Incidence

(d) Reciever Frequency Incidence

1.5 Let Us Sum Up :
After reviewing this unit, reading the suggested articles and exploring

the different links you should have concluded that:

• It seems that computer technology is largely responsible for the
'emergency' attitude of modern society. The perception that everything
must be done faster, arrive sooner, or be available immediately has
pushed services and information to be frequently available on a
24–hour basis.

• With computer technology, the types of negative impacts and the
number of people directly affected by a single system error has grown
enormously to where millions can be directly affected.

• There is unprecedented accessibility to information and
communications, available to large numbers of people from nearly
anywhere we happen to be.

• A computer is a machine which accepts data (called input), follows
instructions given on what to do with the data (called processing),
stores the results for future use (called storage) and displays the
results (called output).

• The main role of computers and computer technology is the ability
to manipulate data into information
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• Computer technology is ubiquitous, or (almost) everywhere.

• Computer technology has enabled us to access information at our
'finger tips', from many places, in many places, at any time, and in
many different forms whether printed or stored.

• Information can be retrieved in many forms such as text, voice,
graphics, and video

• Computer technology has allowed surveillance to be made easier
with the additional software that can monitor locations in other
countries.

• Computer technology has changed the way we communicate with
another person or among groups of people

• Computer technology can improve our lives in health and medicine
such as research in cures for diseases

• Teleconferencing provides opportunities to have a conference without
all persons having to be in the same room, city or country

• Telecommuting allows employees to work at home and communicate
with the office by methods such as phone, fax and computer.

• Telemedicine involves telecommunications, where medical personnel
and the patient are separated by some physical distance

• Expert systems perform tasks that would otherwise be performed by
someone with expertise in the field

• Databases are now used to store dental records, x–rays, medical,
insurance and other records for searches and purposes of cross
referencing

• Computer technology has not completely replaced previous inventions;
rather it is enhancing and improving on previous ones

• Businesses have felt most of the impact of computer technology, such
that if there is little technology incorporated then the business may
be frowned upon as being 'not–up–to–date' or archaic.

• Internet relay chat (also known as messenger), is a common method
of chatting with someone either next to you in class, or is a local
phone call away

• Many of us cannot live without having some form of computer
technology in our lives

This unit introduced the general ideas associated with the impact of
technology on different sectors of our society. Are you explored these
impacts, you should have noted that they range from the practical and
necessary to what may be regarded as leading edge or radical ?

However, in all eras of human history, (a subtle change from
'revolution', as in the Industrial Revolution!), our different societies have
been faced with change in almost every aspect of their life. This change
has been accelerated by the intervention and adoption of computer
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technologies. It is hoped that this unit caused you to reflect upon the
advantages and disadvantages of technology and how it impacts all of us.

1.6 Answers for Check Your Progress :

1. A computer therefore is a machine which :

accepts data (called INPUT);

follows instructions given on what to do with the data (called
PROCESSING);

stores the results for future use (called STORAGE); and

display the results (called OUTPUT).

2. Information technology (IT) refers to the different ways (electronic
computers and computer software) of obtaining, processing, storing,
and transmitting data in the form of voice, pictures and words.

3. Following are the threats to information system

•  Computer Crime

•  Theft of Money

•  Theft of Computers and Computer Parts

•  Alteration or Destruction of Data and Programs

•  System Disasters

4. d 5. c 6. a 7. b 8. a

1.7 Glossary :
Computer : A computer therefore is a machine which accepts data

(called INPUT); follows instructions given on what to do with the data
(called PROCESSING), stores the results for future use (called STORAGE);
and display the results (called OUTPUT).

Surveillance : The gathering of information for different of purposes.

Information Systems : A set of people, procedures and resources that
collects, transforms, and disseminates information in an organization.

Information Technology : It refers to the different ways (electronic
computers and computer software) of obtaining, processing, storing, and
transmitting data in the form of voice, pictures and words.

1.8 Assignments :

1. Explain characteristics associated with computer technology.

2. Discuss the influence of computer technology in a society.

3. Discuss the contributions of computer technology to education.

4. Discuss the contributions of computer technology to business.

5. Define information technology.

6. Describe the impact of computers on society, education, industry,
government and business.

7. Discuss the man–machine connection.
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1.9 Activity :

1. Identify the advantages and disadvantages of computer technology in
various aspects of society.

2. Explore the main uses of computers in society.

1.10 Case Study :
• Study the contributions of computer technology to everyday living.

• Describe how computer technology is integrated in the following
sectors :

o  Agriculture

o  Education

o  Theatre or the Arts

1.11 Further Readings :

1. Introduction to Computers, Roger Powley, CD PhD, Wilhelmina
Louw, Glenda Gaye, commonwealth of learning.

2. Linux for IT Managers Course Guide, commonwealth of learning.

3. Business Information Systems, Derrick Thompson, Commonwealth
of Learning.
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2.0 Learning Objectives :
At the end of this unit, you should be able to :

• Explore the history and evolution of computer technology.

• Explain the events that occurred in different the computer generations

• Evaluate the various types of computer systems that have evolved
since 1985.

• Describe the basic components of a computer system.

• Explain how a computer processes data.

• Describe the major developments in each generation of computer
development.

• Evaluate the need for different types of computer systems

• Distinguish between different hardware components of a computer.

• Explain the functions/uses of the different components.

• Distinguish between a computer and a computer system.

• Explain the term general computer system.

• Explain the term embedded system.

• Show diagrammatically the components of a computer system.

Unit
2
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• Describe a central processing unit (CPU).

• Explain arithmetic and logic unit (ALU).

• Define primary memory and how it functions.

• Describe the function of the machine cycle.

• Describe how data moves through the Central Processing Unit
(CPU).

• Define megabyte.

• Explain the difference between RAM and ROM.

• Describe the machine cycle.

• Describe what happens in the instruction and execution phase.

• Define memory addressing.

2.1 Introduction :
This unit discusses the evolution of computer hardware, provides an

introduction the basic components of computer system and explains how
a computer processes data that executes different computer instructions.

2.2 The Evolution of Computer Technology :

Today many jobs mainly depend on the either the creation or
collection, and distribution of information. This topic addresses the
different advancements in computer technology and the various types of
computers and their critical components.

Computer Generations

As each new computer generation improves on its previous generation,
there have been a corresponding reduction in size (or miniaturization) of
computer circuitry. In contrast to this miniaturization, the speed, power, and
memory of computers have proportionally increased. Although this Topic
will describe the major developments of each computer generation, it is
more important to consider how the technology has influenced the
development of current computer systems.

The computer generations are summarized in Table 2.1 below :

Generation Denoted by Approximate range of years

1 Vacuum tube 1940s – 1950s

2 Transistor Mid 1950s – early 1960s

3 Integrated circuit Early 1960s – Early 1970s

4 Very Large–Scale Early 1970s – Mid 1980s
Integration/Microprocessor

5 Parallel processing Mid 1980s – Early 1990s

6 Reduced Instruction Set Mid 1990s to Present
Chip (RISC) and more
inventions to date
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The First–Generation Computer (1940s – 1950s)
Vacuum Tubes
These early computers comprised huge vacuum tubes (similar to light

bulbs) whose main purpose was to strengthen weak signals for transmission.
The vacuum tubes acted as switches to start and stop the instant flow of
electricity. The concept underlying the on/off switch was the idea of ones
and zeros. The combination of ones and zeros or on and off created a type
of machine language that could be used to process information.

The first computer, the Mark 1, was so huge that it filled a typical
stadium field and was said to have used more than 500 miles of wire. Its
success however was its processing power, such as a mathematical problem
that normally took 40 hours to solve, only took the Mark 1, 20 seconds to
produce a result. It was used by the U.S. Navy during World War II, to help
solve strategic military mathematical problems such as cracking secret
codes and creating complex fire tables for naval guns and artillery.
Scientists used the computer to predict weather patterns and for analyzing
problems in airplane design. As noted earlier the language of this first
generation was called machine language, which comprised zeros and ones
for programming the computer.

The next computer, the ENIAC (Electronic Numerical Integrator and
Computer) was an improvement on the Mark 1, since its processing power
was about 1,000 times faster. The ENIAC was about 80 feet (24.4 m) long
by 3 feet (0.9 m) wide, and used about 18,000 vacuum tubes. Unfortunately,
the tubes were very hot, had to be replaced frequently, and were costly in
using much electricity to keep them cool. The UNIVAC (Universal
Automatic Computer) soon replaced the ENIAC by containing a compact
5000 tubes, a reduction from the 18,000 used in the ENIAC.

The Second–Generation Computer (Mid 1950s – early 1960s)
Transistors

During this generation the significantly smaller transistors (a new
technology) eventually replaced vacuum tubes as the processing component
of the computer. This allowed engineers to dramatically reduce the size and
space needed to house a computer. Transistors proved to be cheaper to
produce and emitted no heat, thus reducing the costs of manufacturing and
making the technology more reliable since they conducted electricity faster
vacuum tubes and failed less often.

This generation was noted for making space travel possible, and for
the development of more sophisticated programming languages that allowed
programmers to use short specific terms (e.g., ADD) to represent certain
computer processing instructions. Higher level programming languages
such as FORTRAN, ALGOL and COBOL, which use short English–like
words, were developed during this generation. During this generation
computer hardware and software was created that allowed users to store and
retrieve programming instructions.
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The Third Generation Computer (Early 1960s – Early 1970s)
Integrated Circuits
This generation improved on the previous one by miniaturizing the

transistor and building several onto a single chip of silicon. This compacting
of millions of transistors in a small space, also called an integrated circuit,
greatly increased the power of computer, the processing speed, lowered its
production costs even more and reduced the size of the computer.

During this generation the creation of new input and output devices
were created. Keyboards, monitors, and the mouse made the computer a
more user–friendly environment and eliminated the need for huge stacks
of punch cards to input data into a main frame computer. Output of the
computer calculations could be read on screen vice printing out large
amounts of paper with graphic symbols on them

The Fourth Generation Computer (Early 1970s – Mid 1980s)

The Microprocessor
Again, an improvement on the previous generation, this generation

continued to reduce the size of the silicon chip comparable to the size of
a pencil eraser while vastly increasing its computational speeds. This single
chip with the components and processing speeds of a computer was called
a micro–processor and was initially intended for use in calculators, not
computers.

During this generation the silicon chip technology was harnessed by
the chip manufacturer Intel. Intel in partnership with IBM created the first
microcomputer, or personal computer. A few years later Apple in partnership
with Motorola introduced the Macintosh to compete against the IBM
personal computer. Only recently has Apple recognized the need for
standardization and has embraced the Pentium technologies currently
supported by Intel.

During this periods new and more powerful programming languages
developed. This included Pascal, C and compilers which converted the
program to a lower–level language that the machine could process. The
UNIX operating system was also developed during this time to manage
system resources.

The Fifth Computer Generation Computer (Mid 1980s – Early
1990s)

Artificial intelligence and Parallel Processing
The goal of this generation is to develop devices that are capable of

responding sensibly to a user's natural language and also capable of
learning and self–organization. It is characterized by the introduction of
computers with hundreds of processors that could be assigned to work on
different sections of a single program. This is called parallel processing,
and is being used to develop communication between a computer in natural
spoken language and its user, through access to a vast knowledge database
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to make intelligent inferences and draw logical conclusions in the way that
humans do.

Several programming languages known as artificial intelligence (AI)
languages have been developed simply because they are used almost
exclusively for AI applications. The two most commonly used languages
are LISP and Prolog.

The linking of computers together, called computer networks, and the
increasing use of workstations (explained in table 2.1) were also developed
during this generation.

The Sixth Generation (Mid 1990s to Present)
Computers and Video Games

This era refers to the generation of computer and video games which
became popular around 1998. The Nintendo Game Cube, Sony PlayStation
2, and Microsoft's Xbox are noted to have dominated game playing in all
age groups.

2.3 Types of Computer Systems :

In the past computers were classified as microcomputers,
minicomputers, or main–frame computers, based on their size. Today these
distinctions are rapidly disappearing as the capabilities of even the smallest
units rival that of their earlier big brothers. Today's microcomputers are
faster, more powerful and more versatile than the minicomputers and the
main–frame computers were a few years ago. Table 2.X describes the terms
used to classify todays of computers and computing devices.

Type of Brief Description
Computer
System
Desktop A PC that is expected to be placed on the top of a
Computer computer or other desk. Desktops usually are powerful

and have reasonably large secondary storage. Desktops
require a number of input and out devices to make them
useful.

Laptop Compared to the desktop, laptops are portable computers
that have their monitor, keyboard, and other memory and
storage devices all included in a package that is up 17
inches in size and is powered by a special battery.
Laptops are also called notebooks.

Mainframe Mainly associated with large companies, that process
millions of transactions calculations from multiple sources
at one time, mainframes previously filled large rooms,
but today consist of a number of linked components that
allow the different processors to communicate with one
another and share their total computing power.
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Minicomputer Minicomputers are powerful and can support many users
at once. Their size is between microcomputers (PCs) and
mainframes.

Palmtop More commonly called Personal Digital Assistants
(PDAs). They are compact computers that often use
special secondary flash memory instead of a typical hard
drive for storage. Palmtops usually have optional
keyboards but mainly use touch screens for input. They
are typically, the size of a paperback novel or even
smaller and are very lightweight and use battery power.

Personal Personal Computers (PC) was designed to be used by
Computer individuals for general use. The PC is not usually

associated with the Apple Mac although it is a PC. Often
the term desktop and PC are used interchangeably.

Server A computer that has been optimized to provide services
to other computers over a network. Servers usually have
powerful processors, lots of memory and large hard
drives. They often provide custom services such as an
e–mail server, a backup server, a database server, etc.

Super Supercomputers have the world's fastest processors and
Computer are able to perform millions of computations a minute.

Supercomputers are normally comprised of multiple
high–performance computers working in parallel as a
single system. The best known supercomputers are built
by Cray Super Computers.

Wearable This is the latest trend in computing where common
Computers computer applications such as electronic mail, are

integrated into watches, cell phones, visors and even
clothing.

Workstation A workstation is a desktop computer with a more
powerful processor, and more memory for performing a
special function, such as 3D Graphics

2.4 Computer Hardware and Peripherals :
We have briefly looked at the different types of computer systems

in Topic 1. We will discuss the different hardware components that make
up different computer systems. The hardware and peripherals can be
categorized as either Input, output, process or storage devices.

Input Devices
You use input devices to provide information to a computer, such as

typing a letter or giving instructions to a computer to perform a task. Some
examples of input devices are described in the following list.
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Mouse : A device that you use to interact
with items displayed on the computer screen.
A standard mouse has a left and a right button.

Trackball : This is an alternative to the
traditional mouse and is favored by graphic
designers. It gives a much finer control over
the movement of items on the screen.

Other screen pointing devices are pointing
stick, touch pad, joystick, light pen, digitizing
table.

Keyboard : A set of keys that resembles
a typewriter keyboard. You use the keyboard to
type text, such as letters or numbers into the
computer.

Scanner : A device that is similar to a
photocopy machine. You can use this device to
transfer an exact copy of a photograph or
document into a computer. A scanner reads the
page and translates it into a digital format,
which a computer can read. For example, you
can scan photographs of your family using a
scanner.

Barcode Readers : When used in a
business barcodes provide a lot of information.
Made up of columns of thick and thin lines, at
the bottom of which a string of numbers is
printed.

Multimedia devices : This is the combination of sound and images
with text and graphics. To capture sound and image data, special input
devices are required.

Microphone : Voice input, for instance,
can be recorded via a microphone. A device that
you can use to talk to people in different parts
of the world. You can record sound into the
computer by using a microphone. You can also
use a microphone to record your speech and let
the computer convert it into text.

Webcam : A device that is similar to a
video camera. It allows you to capture and send
the live pictures to the other user. For example,
a webcam allows your friends and family to see
you when communicating with them.
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Digital cameras : record photographs in the
form of digital data that can be stored on a computer.
These are often used to record photographs on
identity cards.

Output Device
Output devices in the computer system are the equipment whereby

the result of a computer operation can be viewed, heard or printed. You
use output devices to get feedback from a computer after it performs a task.
Some examples of output devices are described in the following list.

Monitor : A device that is similar to a
television. It is used to display information,
such as text and graphics, on the computer.

Printer : A device that you use to transfer
text and images from a computer to a paper or
to another medium, such as a transparency
film. You can use a printer to create a paper
copy of whatever you see on your monitor.

Plotter : A plotter is an output device
similar to a printer, but normally allows you to
print larger images. It is used for printing house
plans and maps.

considerably in the quality of their production.

Impact Printers : Dot matrix printers are
an example of impact printers. They form
characters from patterns of dots. They are
inexpensive, but the output can be difficult to
read.

Non–impact Printers :
Inkjet printers work by shooting a jet of

ink in the shape of the character required, they
provide god, low–cost color printing.
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Laser printers – a laser beam is directed at
an electro–statically charged surface, creating a
template of the page to be printed. This template
is then used to transfer the ink to the page. Toner
sticks to the light images and is transferred to
paper.

PROCESS AND STORAGE DEVICES

The system unit is the name given to the main computer box that
houses the various elements as illustrated in the picture below.

How do we get the different computer parts to work together so that
your computer can work ? Let's start of our discussion with the process
devices.

How do we get the different computer parts to work together so that
your computer can work ? Let's start of our discussion with the process
devices.

Motherboard
Inside the systems unit is a

circuit board with tiny electronic
circuits and other components
which is called a mother board.
It is sometimes called a system
board. The motherboard connects input (keyboard, mouse and scanner),
output (monitor, speakers, and printer), processing (CPU, RAM and ROM)
and storage (hard drive, CD–ROM/DVD–ROM and flash drives) components
together and tells the CPU how to run (Lubbe and Benson, 2010:18). Other
components on the motherboard include the video card, the sound card, and
the circuits that allow the computer to communicate with devices like the
printer.

Expansion Cards
Yes, you can play music and video files on your computer. But how

is it possible ? Inside the computer system box, you also find an expansion
card which is another circuit board that can be attached to the motherboard
to add features such as video display and audio capability to your computer.
Expansion cards are also called expansion boards that enable your computer
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to use the multimedia devices. An expansion card either improves the
performance of your computer or enhances its features. Examples of
expansion cards that can be added include:

• Video Card : It is connected to the computer monitor and is used
to display information on the monitor.

• Network Interface Card (NIC) : The NIC allows the computer to
be connected to other computers so that information can be exchanged
between them.

• Sound Card : It converts audio signals from a microphone, audio
tape, or some other source to digital signals, which can be stored as
a computer audio file. Sound cards also convert computer audio files
to electrical signals, which you can play through a speaker or a
headphone. The microphone and the speakers or the headphones
connect to the sound card.

STORAGE DEVICES

All computers need to store and retrieve data for processing. The
CPU is constantly using memory from the time that it is switched on until
the time you shut it down.

There are two types of storage devices as illustrated in the flow chart
below.

Primary Storage is also called main memory or immediate access
store (IMAS). This is necessary since the processing unit can only act on
data and instructions that are held in primary storage. Primary storage
consists of two types of memory chips :

•  Random Access Memory (RAM)

•  Read Only Memory (ROM)

Random Access Memory (RAM) is the main working memory.
RAM is only filled after a computer has been turned on and is given
something to do. It holds data and instructions temporarily while processing
takes place. RAM is volatile – this means that if the power is turned off
or the computer reboots (start up again) all the information held in RAM
will be lost. RAM is measured in MB (megabytes) and most entry level
computers will have 1024 MB RAM but you also find some computers
having up to 3 GB RAM. RAM chips are expensive and the price of a
computer is determined by the amount of RAM space in the chip.

Read Only Memory (ROM) holds data and instructions necessary
for starting up the computer when it is switched on. These instructions are
hard–wired at the time of manufacture. ROM is permanent and cannot be
deleted but can only be accessed or read, hence the name Read Only
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Memory. Data stored in ROM is non–volatile – meaning that memory will
not be lost when power is turned off.

So, we can compare the features of the two memory types as below:

RAM ROM

Needs power Does not need power

Data can be changed Data can't be changed

Data will be lost if power is Data will not be lost if power
turned off is turned off

Volatile Non–volatile

Stores data currently being processed Fixed instructions are stored

Units of Storage
The memory of all digital computers is two–state (bi–stable) devices.

Computers operate using a binary number system – and therefore use binary
digits (bits). Bits have only two values by 0 and 1. A bit is the smallest unit
of storage in a computer.

The amount of data and instructions that can be stored in the memory
of a computer or secondary storage is measured in bytes. A byte is made
up of a combination of eight (8) bits and has the storage power to represent
one character (a character is a letter or symbol or punctuation mark or blank
space).

Units of Storage

1 byte 8 bits

1 kilobyte (K) 1024 bytes

1 megabyte (MB) 1000 kilobytes (approx. 1 million bytes)

1 gigabyte (GB) 1000 megabytes (approx. 1 billion bytes)

1 terabyte (TB) 1000 gigabytes (approx. 1 trillion bytes)

Secondary Storage Devices
PCs use a simple method of designating disk drives to store data.

These drives are assigned letters of the alphabet.

A Drive Floppy drive. Still found in older computers

C Drive Internal hard drive (hard disk drive) situated inside the system
case.

D Drive Usually the CD–ROM/DVD–ROM drive although can also
be used for another virtual or physical hardware if a second
one is deployed.

E Drive Usually use for any other disks, such as CD–writer, USB
or flash drive, external hard drive, etc.
Higher
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Data and information stored on a permanent basis for later use.
Secondary storage is cheaper to purchase and access. Hard disks, Zip
drives, Optical disks (CD's and DVD's) are all examples of secondary
storage.

Internal Hard Disks are rigid inflexible
disks made of highly polished metal. Data is
stored magnetically. They can contain a single
disk or two or disks stacked on a single
spindle. They come in a variety of sizes but
all have a very high storage capacity compared to floppy disks. An average
computer has a hard disk of about 80 – 250 GB. It provides direct access
to information.

External hard Disks/Drive – same
features as the internal hard disks, but are
external to the system unit and therefore can be
carried around. USB port is used to connect the
external hard drive to the

Optical Disks are disks that are read by laser beams of lights. The
three main types are CD–R, CD–RW and DVD.

• CD–R or CD–ROM (Compact Disk – Read
Only Memory) are so called because you can
only red the information on the CD–ROM.
They are particularly useful for storing
multimedia (texts, graphics, sound and videos),
application software packages (encyclopedias,
training programs etc.).

• CD–R or Compact Disk Recordable allows
you to write information onto the disk only
once using a CD recordable burner.

• CD–RW or Compact Disk Rewriteable, allows
you to write and erase information from the
disk many times. They are used to store large
volumes of information such as texts, graphics,
sound and video.

• DVD disks or Digital Versatile Disks are
specifically created to store movies. A typical
DVD disk can hold between 4.7GB and 17GB
of information.

USB flash drive – consists of a flash memory data
storage device integrated with a USB (Universal Serial
Bus) interface. USB flash drives are typically removable
and rewritable. They come in a variety of sizes to include
128 MB, 256 MB, 512 MB, 1 G, 2 G, 8 G etc.
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Memory Card – Use mainly with
digital cameras, cellular phones and music
players (MP3, MP4 and iPods). They offer
high–re–record ability and fast and power–
free storage. Data can be access by linking the card to a computer using
a USB cable or a memory card reader.

2.5 Computers and Computing :

GENERAL PURPOSE COMPUTER SYSTEMS
When you look at a desktop computer, it comprises a monitor,

keyboard, mouse, and a vertical or horizontal box called a system unit. It
is acceptable to refer to all of these components as a computer. Technically
the systems unit houses the actual 'computer' or programmable machine
(hardware, firmware and software), which executes (carries out) or responds
to a sequence of program instructions. A computer system then is a
collective term for a computer (housed within the system unit), as well as
these other components that are attached to it to allow the user to input data
and view output using different devices. Some of these components include
a monitor, keyboard, mouse, printer, disk drives, scanners, microphones,
and speakers, which are also referred to as peripherals. The peripherals
work together to help the user accomplish a given task effectively.
Therefore, as an example, when you perform a calculation, the keyboard
– a peripheral device – is used to input the data. It is the system unit that
accepts and processes the data, and generates the results. Other peripheral
devices such as the hard drive store the data and results, which can be
viewed on the monitor.

The peripheral devices mentioned above are collectively called
hardware devices, since they can be physically attached to the computer.
However, computer systems also include software, or programs that are
integral in the functioning of some of these peripheral devices and are
necessary to make the computer operate. Every computer system, for
example, requires an operating system. An operating system is a program
that establishes communications with the various peripherals and acts as
a bridge to other application specific software programs. An operating
system is like the command center of the ship. It makes all of the decisions
about how the computer will function and work with others.
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EMBEDDED COMPUTER SYSTEMS
The typical personal computer or laptop described in the last

discussion is categorized as a general–purpose computer system. This
section will explore a special type of computer system called an embedded
system. Embedded systems are designed to perform a very small number
of very specific functions. For example, a GPS computer in a car only
provides driving instructions. It cannot perform any other computing
function. A typical embedded system also uses certain types of hardware,
and limited resources, such as small keyboards, screen and reduced
memory. These systems are also actually built into the device they are
controlling.

Compared to a typical computer, embedded systems are often smaller
in size, tend to be cheaper, and as a result many are mass–produced.
Embedded systems range from small portable devices to large complex
systems. The major difference is that they are single purpose devices with
only one form of input or output. Some may also have simple user
interfaces or displays which include buttons, or touch screens, while others
have none at all.

Table – Examples of systems and devices which comprise
embedded systems

Portable devices Large complex systems

• Digital watches • Traffic lights

• MP3 players • Systems controlling nuclear power

• Microwave ovens • plants

• Washing machines • Controllers used in remote

• Television sets • machine operation

• DVD players • Navigation Systems

• Air conditioners • Military Weapons Systems

• Sprinklers

• Security monitoring system

• Handheld computers

• Thermostats

Mobile (cellular) phones and handheld computers may be categorized
as embedded systems, but since these devices can be enhanced with the
addition of other applications and peripherals, they are better suited to the
category of general–purpose computer systems and not really embedded
systems.

COMPUTER SYSTEM – HOW IT WORKS
The major components of a computer system include input and

output devices as well the important processor or central processing unit
(CPU). The CPU comprises a set of electronic circuits kept within the
system unit. The CPU is the brain of a computer system and is responsible
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for processing the data that is input from a peripheral device and output
to another peripheral device. Figure 2.2 illustrates the major components
of a system unit that is attached to an input and output device.

The Central Processing Unit (CPU), also known as the processor or
microprocessor has components that control the operating system and other
software installed on the computer. The CPU also sends commands and data
to the peripherals attached to the computer, such as the monitor or printer.
Therefore, the speed (how fast the electrons move around the chip) at which
the CPU executes its tasks (or commands) determines how quickly you can
view or hear the output from the command; such as printing a page or
allowing you to view a letter on the monitor. This speed is called 'clock
speed', and is measured in megahertz (MHz). A computer system that
responds to commands quicker means that its clock speed is working faster
to execute these commands.

Figure 2.2 : Central Processing Unit
Table 2 compares some common CPUs and their clock speeds.

Different CPUs use different silicon chips to execute the commands and
process data. Different types of chips have different clock speeds based on
the technology that was used to create them. Some examples are provided
below.

Table 2.1 : Typical CPU Speeds Based on Chip Type
Name of CPU Average CPU Speed

Intel Celeron 500 MHz – 800 MHz

Intel Pentium II 233 MHz – 450 MHz

Intel Pentium III 450 MHz – 1 GHz

Intel Pentium 4 1.4 GHz – 2 GHz

Intel Core i7 3.6 Ghz

AMD Athlon XP 1.4 GHz – 1.8 GHz

Macintosh G4 733 MHz
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Now let's look deeper into the operation of the CPU. All computer
systems have a CPU which comprises (1) a control unit and (2) arithmetic
and logic unit (ALU).

The Control Unit (CU)
The control unit is similar to an efficient manager. It is responsible

for directing other parts of the computer system in order to carry out the
instructions for the task required. The control unit (CU) must interact with
the arithmetic and logic unit (ALU) and memory to complete its tasks. As
instructions are fetched from memory, the CU interprets the instruction.
The CU then sends commands to other components to gather data that may
be needed to complete the instruction, even if it involves a transfer of data
from other components and devices. The CU than determines where to send
the result. This may include activating the printer, showing the result on
the monitor or playing a sound on the speakers.

Arithmetic and Logic Unit (ALU)
The Arithmetic and Logic Unit (ALU) is the part of the CPU which

performs all arithmetic and logic operations this involves arithmetic
calculations including addition, subtraction and multiplication. As
calculations are required, the Control Unit sends them to be performed in
the ALU which sends the result back to the Control Unit. It also performs
logic operations such as comparisons of numbers or letters to test for, such
as equal–to (=), less–than (<), greater–than (>) and other combinations,
such as less–than or equal–to (<=).

Memory
Primary memory is necessary to store instructions and data for

processing, but they are not part of the CPU. Memory are separate chips
stored on a mother board which connects all the hardware together.
Program instructions or data are kept in primary memory for only as long
as the program currently using them. In human terms this would be
considered "short term memory". The original instructions and data are lost
once the computer is turned off; therefore, primary memory is deemed
volatile. In later units we discuss those non–volatile devices which allow
data and instructions to be permanently stored in a computer system for
use later on. Primary memory is also as – memory, main memory, primary
storage, main storage, internal storage, computer memory and RAM
(Random Access Memory).

2.6 Data Processing :
Processing data is the most important activity in the computer, and

so the task of the processor is to interpret and execute program instructions,
in order to transform data into information. The processor is also responsible
for interacting with the input, output and storage devices.

PROCESSING DATA AND COMPUTER MEMORY
Keeping instructions and data in primary memory when a program

is not in use is not feasible for three reasons :
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• The processed data may be too much to be held in primary memory.

• Generally primary memory only stores data and instructions while the
computer is turned on, but once the computer is turned off, the data
and instructions are lost.

• If more than one program or application is opened at the same time,
then, a single program should not exclusively use all the memory;
some memory should be available for the other programs to use.

The amount of memory available to hold the data and instruction is
measured in megabytes or MB. A personal computer with a minimal amount
of memory of say less than 512 MB may not be able to perform efficiently
and may be rather slow in executing the applications. Memory is also
loosely known as RAM which is an acronym for Random Access Memory.
It should be noted there that the word random implies that data can be
retrieved quickly, and in the same length of time, regardless of where the
data is located (that is, the address of the data).

Read Only Memory (ROM)

Read–only memory or ROM is an integrated circuit, programmed
with specific data when it is manufactured. It is used in computer systems
and other electronic devices. RAM and ROM are different since data stored
in ROM cannot be modified easily. In other words, ROM is ideally suitable
for storing a set of data for the life of the device, and is therefore
nonvolatile.

Modern types of ROM include such as Programmable ROM (PROM),
Erasable Programmable ROM (EPROM), Electrically Erasable
Programmable ROM (EEPROM) and flash memory can be erased and
re–programmed many times, although they are still called ROM because
the reprogramming process is usually rarely done. Many ROM chips are
often identified by the prominent circular 'window' which allows ultraviolet
(UV) light to enter and erase its contents.

Flash memory (or simply flash) is a modern type of EEPROM which
can be erased and rewritten faster than EEPROM. Flash memory is mainly
used in memory cards, USB flash drives, memory stick, flash stick and jump
drive), which are used for general storage and transfer of data between
computers and other digital products.

Function of the Machine Cycle Consider a user who needs to add two
numbers, 10 and 15. These numbers may be input at the keyboard and the
results shown on a screen. The processing of this simple addition is carried
out in the CPU.

Let us examine how a single instruction is executed or carried out in
the central processing unit. Of course, computers today generally execute
one instruction at a time, although as quickly as a fraction of a second.
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In order to carry out an instruction, the program instructions and data
must be moved into memory from either an input device or a secondary
storage device. Once in memory, the control unit and ALU in the CPU work
together to perform the following four steps (fetch, decode, execute, and
store) for each instruction. These steps are collectively known as the
machine cycle or the processing cycle. This machine cycle has two phases,
the instruction cycle (instruction time, or I–Time) and the execution cycle
(execution time or E–Time). Let us examine these cycles in more detail.

Phase A : Instruction Cycle
1. Fetch Instruction : The control unit fetches (gets) the program

instruction from memory.

2. Decode Instruction : The control unit decodes the instruction
(decides what it means) and then moves the necessary data from
memory to the ALU.

Phase B : Execution Cycle

3. Execute Instruction : The ALU performs the requested action, by
executing the arithmetic or logical instructions on the data.

4. Store (write) Result : The ALU writes or stores the result of this
operation in memory or in a temporary register.

Once these two phases are complete, the control unit instructs
memory to send the result to an output device or a secondary storage
device. The figure below illustrates how these cycles interact to produce
a result.

Check Your Progress :
State whether the following statements are true or false

1. RAM is memory where fixed instructions is being stored

2. Data is another word for information

3. A byte of memory can store an entire word

4. DVD's are used mainly for storing movies

5. Data on CD–R disks can be erased and rewritten

6. Back up files are usually created on hard disks

7. The smallest unit of data is a bit

8. ROM is volatile memory

9. Trackballs, pointing sticks and touch pads do the same function as
a mouse
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10. Input devices take raw data and turn it into information

11. The most suitable input device for creating a short report would be
a :

(a) Mouse (b) Scanner (c) Keyboard (d) Joystick

12. The most suitable input device for selecting (highlighting) text on a
screen would be a :

(a) Joystick (b) Mouse (c) Keyboard (d) Touch Screen

13. In order to create a digital image from a paper photograph you would
first need to input it using a :

(a) Scanner (b) Joystick

(c) Digital Camera (d) Touch Screen

14. Magnetic Ink Character Recognition is often used on :

(a) Receipts (b) Photographs (c) Cheques (d) Barcodes

15. Multiple choice answers on a test paper can be input using :

(a) Barcode Reader

(b) Optical Mark Reader

(c) Magnetic Ink Character Recognition

(d) Magnetic Strip Reader

2.8 Let Us Sum Up :

• Computer hardware consists of input, output, process and storage
devices.

• You use input devices such as keyboard, mouse, scanner and
multimedia devices to provide information to a computer.

• Output devices are used to get feedback from a computer after it
performs a task. Examples include monitor, printer and multimedia
devices.

• CPU takes raw data and turns it into information. The CPU is made
up of Control Unit, Arithmetic Logic Unit (ALU) and the main
memory.

• Storage devices are divided in primary and secondary storage devices.

• Primary/main memory is subdivided into ROM and RAM.

• Random Access Memory (RAM) is the main memory and allows you
to temporarily store commands and data.

• Read Only Memory (ROM) retains its contents even after the
computer is turned off.

• A bit is the smallest unit of storage in a computer.

• The amount of data and instructions that can be stored in the memory
of a computer or secondary storage is measured in bytes.

• A byte is made up of a combination of eight bits and has the storage
power to represent one written character.
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• Hard disks, CD–R, CD–RW and DVD are secondary storage devices.

• The internal workings of a computer are very similar to the internal
workings of the brain.

• The CPU represents the brain. Both are used to store and process
information. Both carry out complex algorithms to store and combine
crucial information. Both control the external operation of the body
or in the case of the computer the peripherals and other attached
devices.

• A computer is a device that accepts data, uses a program to process
the data, and generate results.

• A computer system is a collective term that includes a computer and
all peripheral devices attached to it, such as a monitor, keyboard and
mouse.

• An embedded system is a special–purpose computer system designed
to perform a dedicated function

• The main components of a computer system include the Central
Processing Unit (CPU), primary memory, input and output devices,
and secondary storage.

• The Central Processing Unit (CPU) comprises the Arithmetic and
Logic Unit (ALU) and the Control Unit (CU).

• The ALU is the part of the CPU which performs all arithmetic and
logic operations this involves arithmetic calculations including
addition, subtraction and multiplication, as well as comparison of
numbers and text.

• The control unit is responsible for directing other parts of the
computer system in order to carry out program instructions

• Both primary memory and secondary storage are also necessary to
store instructions and data for processing, but they are not part of the
CPU

• Each new computer generation improves on its previous generation,
by reduction in size (or miniaturization) of computer circuitry

• First Computer Generation is characterized by the huge vacuum tubes
whose main purpose was to strengthen weak signals for transmission,
and used switches to start and stop the instant flow of electricity

• Second Computer Generation replaced vacuum tubes by a much
smaller transistor.

• Third Computer Generation produced and compacted millions of
transistors on to an integrated circuit.

• Fourth Computer Generation is instrumental in the invention of the
microcomputer, also known as a personal computer

• Fifth Computer Generation is developing communication between a
computer in natural spoken language and its user
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• Sixth Generation refers to the generation of computer and video
games

• Primary storage is used to temporarily hold data and instructions

• Primary memory is known by other terms which are used
interchangeably – memory, main memory, primary storage, main
storage, internal storage, and RAM (Random Access Memory).

• In order to carry out an instruction, the program instructions and data
must be moved into memory from either an input device or a
secondary storage device

• The control unit and ALU in the CPU work together to perform the
following four steps (fetch, decode, execute, and store) for each
instruction

2.9 Answers for Check Your Progress :
1. F 2. F 3. T 4. F 5. F

6. T 7. T 8. F 9. T 10. T
11. C 12. B 13. A 14. C 15. B

2.10 Glossary :
Integrated Circuit : Compacting of millions of transistors in a small

space is called an integrated circuit

Microprocessor : It is single chip with the components and processing
speeds of a Computer.

Input device : It is used to provide information to a computer, such
as typing a letter or giving instructions to a computer to perform a task.

Output device : Output devices in the computer system are the
equipment whereby the result of a computer operation can be viewed, heard
or printed.

Primary storage : Primary Storage is also called main memory or
immediate access store (IMAS).

Bit : Binary Digit – Bits have only two values by 0 and 1. A bit is
the smallest unit of storage in a computer.

Byte : A byte is made up of a combination of eight (8) bits and has
the storage power to represent one character

2.11 Assignment :

• What is the main purpose of a CPU ?

• Distinguish between RAM and ROM.

• Define input and output devices and give examples of each.

• Name one device that can function as both and input as well as an
output device.

• What does 'bits' stands for ?
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• Explain what is meant by the phrase "primary memory is deemed
volatile"

• Describe briefly the four basic operations that comprise a machine
cycle or instruction cycle.

• Explain the difference between instruction time (i–time) and execution
time (e–time).

• Explain why the control unit is regarded as an efficient manager.

• Explain in simple terms, what is understood by a memory address

2.12 Activity :
Explain, with reasons, which computer system(s) would be most

appropriate in the following examples :

1. Business executive who travels often

2. Student who needs to prepare a History project report

3. A multi–million–dollar company with six branches in the country and
three in other countries

4. Banking system with many tellers who access the same customer
database

2.13 Case Study :
Try and think of other examples of embedded systems that you

typically use in your day–to–day activities but have never thought of them
as embedded computer systems.

2.14 Further REading :
1. Introduction to Computers, Roger Powley, CD PhD, Wilhelmina

Louw, Glenda Gaye, commonwealth of learning

2. Linux for IT Managers Course Guide, commonwealth of learning

3. Business Information Systems, Derrick Thompson, Commonwealth
of Learning
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3.0 Learning Objectives :

At the end of this unit, you should be able to :

• Explain the purpose of system software.

• Distinguish among the three major categories of system software.

• Explain the interaction between the user and the computer and the
role of system software to support this interaction.

• Describe the purpose of system software.

• Explain the purpose of the different operating systems.

• Describe the various user interfaces.

• Explain the purpose of utility programs.

• Describe characteristics of language translators.

• Explain the purpose of the different operating systems.

3.1 Introduction :

This unit discusses the two categories of software that are used to
actually have the computer complete specific tasks and that communicate
with the hardware and other peripherals. The two categories of software are:
systems software and applications software.

Unit
3
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System software comprises a collection of programs with instructions
that work together with the hardware components of a computer (including
peripheral devices), to accomplish its tasks efficiently and effectively.
System software acts as a mediator between the hardware resources and
the application programs. In addition, system software monitors the
activities of the computer (like memory and file storage) so that it functions
efficiently.

Three major categories of system software are:

• Operating systems (OS),

• Utility programs, and

• Language translators.

Application software allows the computer user to create documents,
produce graphics, capture and manipulate photographs, create databases
and treat the computer as a tool for a variety of tasks.

The difference between the two can be summarized as follows:
application software is what users require to complete their tasks while
system software is the software that interfaces between the hardware to
perform what is requested by the application software.

There are three different types of software that are part of all
computer systems and that ensure that the hardware and application
programs can effectively communicate with each other. This software is
classified as operating systems, utility programs and language translators.

3.2 Operating System :

A computer cannot work without an operating system! The operating
system comprises a set of coded programs that work with the peripheral
devices and computer hardware to control and organize the general
operating functions of the computer. Some of these functions include:

• Starting the computer (also called 'booting'),

• Managing and monitoring other programs, memory management,
communications management and the management of peripheral
devices,

• Enabling interaction between the user and the computer system
through the use of external input devices, and monitoring and
security of access to data and applications.

Starting the Computer

Starting the computer, also called booting, is the process of loading
the operating system into the computer's memory so it can execute the
different operations and manage the hardware devices. When the power
button on the computer is turned on to load the operating system, this
process is called a cold boot. If the computer system is already on and the
system needs to be re–started for a number of reasons (like the hardware
stops operating or the user gets an error message), then the process of
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reloading the operating system is called a warm boot (because the computer
was already on) A warm boot in a Windows based PC is normally done
by holding down the CTL–ALT–DEL keys at once.

Managing Other Programs
The computer system needs to manage the programs that the computer

user needs to complete business or personal tasks such as a word
processing, Internet research, spreadsheet production and others. The
operating system must therefore be able to manage one or more software
application programs at the same time. This is known as multi–tasking and
the computer is considered a multi–tasking operating environment. For
example, multitasking operating systems run more than one application
program at a time.

Suppose a user has a word processing program, Internet browser and
a spreadsheet are open at the same time and the computer user currently
typing a report, using the word processing program. The word processing
program is called the active program, since it is the current program in use
while the other programs – the Internet browser and spreadsheet – are called
inactive programs since they are running in the background and are not
currently in use.

Since computers use primary memory to increase processing efficiency,
the operating system allocates memory spaces for each running program so
that the individual programs do not interfere with each other. In order to
accomplish this, the operating system uses 'virtual memory' or secondary
storage, as an extension of random–access memory (RAM). This is
illustrated in the figure 3.1. Sometimes, if there are too many applications
opened, then the operating system is unable to allocated adequate memory
to each application. When this happens, none of the applications may
appear to work and the computer system may need a warm boot.

Figure 3.1 : Memory CPU Interaction

3.3 Type of Operating System :

Now that the purpose of an operating system has been explained, let
us examine some operating systems that were developed for specific
purposes.
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The Macintosh (or Mac) and the IBM personal computer operate with
hardware and software configurations. This is known as the platform. The
platform of a computer system is the underlying hardware and software that
it allows it to function. For example, the Apple computer was developed
with a Mac platform using Motorola chips and unique operating software
called "Mac OS" The original IBM computer uses Intel chips and originally
employed an operating system called "DOS" or Disk Operating System.
Today's PCs now use a Windows based operating system that incorporates
many of the original concepts in DOS. Operating systems differ in
functionality, flexibility and ease of use. Today there are a number of
different operating systems in use. They can be classified as either personal
operating systems, network (client/servers) operating systems and handheld
operating systems. A representative list of different operating systems is
described below.

Operating
System (OS)

UNIX

Linux

Macintosh
(MAC) OS X

Microsoft
Windows 95,
98 and XP

Microsoft
Windows
NT/2000

Microsoft
Windows
Mobile 7

Microsoft
Windows 7

Type

Network

Network

Personal

Both
personal &
network

Network

Handheld
and Cell
Phone

All Types

Main Purpose or Major Development

These are network operating systems that are
powerful. Runs on many types of PCs,
mainframes and workstations; is the primary
operating system for Internet servers; first
multitasking system, widely used by large
corporations

Uses a command line interface; more stable
than Windows, but applications using Linux
are rare.

First operating system to be developed that
used a graphical user interface. Also
considered the easiest system for beginners

Capable of Internet browsing, and multimedia
support. None of these earlier versions of
Windows are supported by Microsoft

Also network operating systems that were
designed specifically for corporate and other
large businesses, and were also known as
client/server systems (one computer 'serves'
provides applications for many users 'clients').
Offered enhanced security, and remote access
to computer systems among other features

Supports handheld devices and smartphones.
Supports integration with other Microsoft
software.

The current Microsoft operating system with
a number of variants which can be used in all
types of computer environments.
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3.4 Functions of an Operating System :
Birbal and Taylor, (2004 : 39–40) summaries the functions of an

operating system as follows :

1. Managing Computer Resources : The operating system allows
application software Programmes such as word processing, spreadsheet
and database packages to communicate with the computer's hardware.
For example, if you work on a document in Excel and you want to
print the document, you just press the print button on the toolbar.
Excel will direct the operating system to select a printer to print the
document. The operating system then notifies the computer to begin
sending data and instructions to the appropriate program to get the
document printed. The operating system therefore acts as an interface
between the application Programmes and the hardware.

2. Managing Files and Memory : The operating system manages all
files on a computer. It keeps tracks of the locations where Programmes
and data are stored within the computer's memory. For example, when
you open a file that has been saved to the hard drive, you are first
instructing the computer to find the file, and then to open it. The
operating system also allows you to easily find files stored in
secondary storages devices. Other file management functions include
copying, erasing, renaming and backing–up files.

3. Maintaining Security : In networks and larger computers each user
is given a user name or ID and password to gain access to the
computer system. The operating system keeps a register of all these
names so that only persons with valid usernames and passwords can
access the system. This prevents access by hackers and unauthorized
persons. The operating system also keeps a log which records users
logged in, the length of time each user stayed on the system, and heat
they did. Administrators can check the log to look for security
breaches and abuse of resources.

4. Managing Tasks : A computer can perform many tasks simultaneously.
One way of doing this is multi–tasking – ability of the computer to
run more than one Programme at the same time. For example, a user
can listen to music on his/her computer whilst at the same time typing
a document or typing an e–mail while another e–mail is being sent.
In the case of networks, the multiuser operating system allows more
than one user to access the same data at the same time.

5. Providing a User Interface : Many operating systems functions are
never apparent on the computer's display screen. What you do see is
what is called the user interface. The interface helps the user to
interact with the computer.

3.5 User Interface :

In order to interact with the computer, a user uses a part of the
operating system called a user interface. The functions of the user interface
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are to start application programs, manage secondary storage, such as hard
disks, as well as manipulate files and folders, and finally shut down the
computer safely.

The three principal types of interfaces include:

• Graphical User Interface (GUI),

• menu–driven interface, and

• command–line interface.

The Graphical User Interface (GUI) uses graphics or icons which
represent various tasks. For example, the icon to print is a small picture
of a printer which when clicked with a mouse, will invoke the printing
dialog box. Once the printer dialogue box is opened you can pick other
commands that will be used to send your document to the printer. A GUI
is a user–friendly interface that eliminates the need to remember complex
computer commands or programming languages.

The menu–driven interface is used to show all of the options
available to the user in the form of pull–down or pop–up menus. An
illustration of a pull–down menu is shown in figure 3.2. Many menu
interfaces now include the GUI icons with text menu options.

Figure 3.2 : Graphical User Figure 3.2 : Menu Driven
Interface Example Interface Example

The command–line interface requires the user to type keywords or
commands at a prompt, in order to enter data or execute commands. You
can experience this type of command when you open the "Run" interface
to input DOS based commands to execute an operating system task. This
interface is the most difficult one for the average computer users to learn.
They are often used in programming applications or in support of systems
software.
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Figure 3.3 : Command Line Interface Example

3.6 Utility Programs :

Utility programs are tools that help the operating system manage the
computer system's secondary or non–priority jobs. These jobs are repetitive
in nature. Some examples of utility programs include antivirus software,
backup software, disk defragmentation, disk scanning; file compression
software, file management programs, and searching software. Often are
automatically loaded into member when the system is booted and they
operate in the background at the same time as the application program.
Often you do not know they are working until they send you a message like
"Virus detected, click here to eliminate". Only then does the user need to
engage some form of interface to take the appropriate action.

Table 3.1 : Examples of Utility Programs
Utility Program Description

Antivirus Protects the computer from computer viruses.
software Examples are Norton and Zone Alarm.

Backup software Used to copy data from the hard disk to another
storage medium.

Disk Re–organizes data on a storage device to improve
Defragmentation performance.

Disk Scanning Involves disk–scanning utilities to detect and fix
errors on storage devices, or disk cleanup utilities
that remove unused or unnecessary files that are no
longer needed.

File Compression Reduces the size of a file, folder or directory.
Popular utility is WinZip.

File Management Stores files in a hierarchical structure, to enable
various tasks such as creating, deleting, copying
and moving files, folders, and directories

Search programs Used to find files, folders or directories on storage
devices.
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3.7 Language Translators :
Language translators convert the data in a program (source code) into

machine language code (object code) so that the computer can then process.
The main purpose of translating source code to object code is to create a
program in machine language so that the computer can produce the desired
results. An example of different types of language translators are compilers
and interpreters. The compiler is a computer program or in some cases a
set of programs that translates another program's source code into object
code all at once, while the interpreter is a set of programs that translate
the application program's source code, one line at a time while the program
is running.

3.8 Productivity Applications :
Personal productivity applications serve the needs of various users

and have several subcategories. Generally, personal productivity software
includes word processing, spreadsheet, presentation, and database programs.
Another area, Internet applications, includes Web browsers and electronic
mail programs. Multi–media or graphics applications use desktop publishing,
as well as editing of photos and graphics, while home and educational
applications include personal finance programs, tax preparation programs,
reference software and game playing software.

These personal productivity programs are usually stand–alone
programs which do not depend on other application software to function.
However, there are some applications whose interfaces are the same, and
also share data and resources with each other. These applications together
are called software suites, and some examples are Microsoft Office ? which
is the most popular, Corel WordPerfect Office, and Lotus SmartSuite.

Table 3.2 : Some useful Application Software

Types Description

Financial Software Provides automated assistance for tax preparation
and submission. An example is Turbo Tax.

Accounting Provides assistance for personal accounting and
Software cheque writing. Examples are Quicken and

QuickBooks

Word Processing Provides assistance in formatting, printing
Software documents. Some examples are Microsoft Word,

and Corel WordPerfect

Spreadsheet Provides built–in functions to perform calculations
Software and graphics. Some examples are Microsoft Excel

and Lotus

Database Software Stores, manipulates and retrieves data. Some
examples are Microsoft Access, dBase and FoxPro
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Workgroup Applications
These applications are used by two or more users who work as a team

to achieve a common task. The programs therefore should support the
sharing of information and sections of the work or a project, scheduling
group meetings, group electronic mail services, group decision making and
conferencing. Some examples of this software are project management
software, groupware like Microsoft SharePoint and collaborative software
like WIKIs (an example of a WIKI is Wikipedia).

Enterprise Applications

These applications are used by personnel to support the company in
its interaction with customers and employees. Some of the activities include
entry of orders, billing, payroll, human resource management, and general
reporting activities. Enterprise applications are specialized or tailor made
to the specific activities of the company. Examples of enterprise software
include PeopleSoft a complete package of company operations and Banner
an enterprise system used by universities and colleges to support records
management, financial management, course management, student
management, etc.

Application Software Development

Some applications, are developed 'in–house' specifically for use in the
company. Other applications are developed via a contract by technology
companies that specialize in producing custom application software for
their customers. One example of custom software development would the
book ordering process for Amazon.com. Finally, there are off the shelf
application software packages which, as the name implies, can be purchased
and used without the ability to customize the software.

Check Your Progress :

1. __________ is the process of loading the operating system into the
computer's memory so it can execute the different operations and
manage the hardware devices

2. __________ is a person who tries to gain access to a computer system
without authorization. Hacking is illegal in most countries.

3. There are __________ principal types of interfaces.

4. The __________ interface requires the user to type keywords or
commands at a prompt, in order to enter data or execute commands.

5. __________ programs are tools that help the operating system
manage the computer system's secondary or non–priority jobs.

3.9 Let Us Sum Up :
While the CPU is the brain of the computer, it needs instructions to

work effectively. It uses electronic instructions or binary signals in bits and
bytes to communicate with other parts of the system. Software, specifically
operating software, provides specific instructions to the peripherals and the
various systems attached to the computer including network operations.
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Application software provides the creative portion of the brain. It allows
you to use the computer to create and communicate. We will now explore
application software.

System software plays an important role in the proper functioning of
a computer system. This unit explained the three main programs that
comprise system software, namely operating systems, utility programs and
language translators. Of course, different types of system software are
necessary for the different types of operating systems available. The user
interface was also discussed as a mediator between the user and the
computer system, to ensure that the computer system performs certain
complex or other mundane tasks for the user.

This unit also introduced personal productivity software or applications
software which are stand–alone programs that do not depend on other
applications to function. Some popular application software programs
discussed were for word processing, spreadsheet analysis, presentations,
and statistical analysis. Some other applications such as workgroup and
enterprise applications were also introduced, since they are also widely
used in the day–today tasks in many businesses.

This unit also introduced personal productivity software or applications
software which are stand–alone programs that do not depend on other
applications to function. Some popular application software programs
discussed were for word processing, spreadsheet analysis, presentations,
and statistical analysis. Some other applications such as workgroup and
enterprise applications were also introduced, since they are also widely
used in the day–today tasks in many businesses.

3.10 Answers for Check Your Progress :

1. 'booting' 2. Hacker 3. Three

4. command–line 5. Utility

3.11 Glossary :

System Software : System software comprises a collection of
programs with instructions that work together with the hardware components
of a computer (including peripheral devices),

Operating System : The operating system comprises a set of coded
programs that work with the peripheral devices and computer hardware to
control and organize the general operating functions of the computer.

Application Software : Application software allows the computer
user to create documents, produce graphics, capture and manipulate
photographs, create databases and treat the computer as a tool for a variety
of tasks.

User interface : In order to interact with the computer, a user uses
a part of the operating system called a user interface.

Hacker : A hacker is a person who tries to gain access to a computer
system without authorization. Hacking is illegal in most countries.
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3.12 Assignment :
• Explain the purpose of system software.

• Distinguish among the three major categories of system software.

• Explain the interaction between the user and the computer and the
role of system software to support this interaction.

• Describe the purpose of system software.

• Explain the purpose of the different operating systems.

• Describe the various user interfaces.

• Explain the purpose of utility programs.

• Describe characteristics of language translators.

• Explain the purpose of the different operating systems.

3.13 Activity :

• Identify a number of tasks that are carried out by all operating
systems.

• Describe at least one task that a multi–tasking operating system would
be able to execute.

• Describe at least one task that a multi–user operating system would
be able to execute.

3.14 Case Study :

You share a computer with four other family members. Over the last
three months, you notice an increase in files, and folders from the various
projects and assignments. There are also quite a few files which have been
downloaded from the Internet. Think about which utility programs would
be appropriate, not only to organize the many files and folders, but to
generally use on this computer.

3.15 Further Reading :

1. Introduction to Computers, Roger Powley, CD PhD, Wilhelmina
Louw, Glenda Gaye, commonwealth of learning

2. Linux for IT Managers Course Guide, commonwealth of learning

3. Business Information Systems, Derrick Thompson, Commonwealth
of Learning
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4.0 Learning Objectives :

At the end of this unit, you should be able to :

• Illustrate the movement of files, folders to organize information in
a meaningful way.

• Explain different disk and file management operations.

• Describe a computer the operation of a computer file management
system.

• Show diagrammatically basic file and data management structures.

• Carry out basic file and data management operations.

4.1 Introduction :
This unit explains how a computer file and data management system

operates and is accompanied by some practical activities which are useful
in helping understand how files can be organized on secondary storage
devices into multiple folders and sub–folders.

4.2 File Management :
In Microsoft Windows operating system, Windows Explorer is a tool

for organizing files on disk and uses several important components to
manage drives such as disks (floppy disks, CDs, DVDs, and memory
sticks), folders and files. When Explorer is started, you will see the

Unit
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directory window, which displays the contents of a specified folder on a
selected drive.

Files, folders and disks must interact to organize information in a
meaningful way. Files are a collection of information, data, or program files.
For example, an application software program such as a spreadsheet or
word processor is a program file, while the document created using the
spreadsheet or word processor is called a data file. Folders are used to
organize where the files are located, so that a particular folder may contain
all spreadsheet files, while another folder can contain all word processing
files.

A disk is a secondary storage device such as a floppy disk, CD, DVD,
or memory stick, where folders and files can be stored. Consider a disk to
be like a filing cabinet with the folders similar to physical folders or drawers
in the filing cabinet. These folders can therefore contain files or rather paper
files! So, you can have many folders in a file, and the folders can contain
many files! Also, just as your filing cabinet can become full of files, your
disk (storage device) can also become full.

4.3 Root Folders and Subfolders :

Two terms need to be explained before beginning the practical Topic.
A root folder is the main or general folder found on all disks and is identified
with the disk drive letter followed by a backslash ( \ ). A root folder is often
known as a drive or storage device. Table 4.2 illustrates some other
designated disk drive letters. So, the root directory of the floppy drive is
designated A:\

Table 4.2 : Designated Drive Letters
Disk Drive Name Designated Drive Letter

Floppy Drive A:\

Another Floppy drive B:\

Hard Disk Drive C:\

Another Hard Disk Drive Can be given another letter such as D:\ or
more depending on the number of installed
hard–drives on the computer.

Memory Stick If there are two hard drives on the computer,
(also called Flash drive) then it is designated E:\

Another Memory Stick F:\ – Assuming you have a second one.

A Network Drive H:\ or higher – Note network drives do not
physically reside on your desktop or laptop
computer. To connect to a Network Drive
your computer must be installed on a local
or wide area network.
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Once you create folders within the root folder, then these folders are
called subfolders. So, if the root folder contains another folder called
WORD, then the folder is identified by its name preceded by the name of
the root. Therefore, we have in our example, A:\WORD which indicates
that the subfolder WORD is in the root folder of the A: drive. Folders can
have more folders within them. So, if ASSIGN1, is created within the
WORD Subfolder, then A:\WORD\ASSIGN1 indicates that the ASSIGN1
subfolder is within the WORD subfolder contained in the root folder of
the floppy disk. Another way to describe the hierarchical nature of the
above example is below :

 Root Folder (e.g., C:\)

  Sub Folder (e.g., C:\WORD)

  Sub–Sub Folder (c:\WORD\ASSIGN1)

4.4 Using the Directory Window :

Launch Windows Explorer by right–clicking the Start button and
selecting Explore. Then maximize the resulting window.

Double–click on the icon located in the left panel. (you may not see
the numbers before the C: A list of folders will be displayed in the right
panel. Double–click the WINNT or WINDOWS folder depending on the
system you are using. (You may get a message telling you that these files
are hidden for security reasons. Simply click the on the Show Files option.)
You can also double–click on any folder for this activity; the Explorer title
will be updated to reflect the name of the folder that you have opened.

Double–click the Desktop folder in the left panel, or in the file list
(in the right panel), and notice the files change to reflect those in the
desktop folder.

You should now select and click the View pull–down menu, and
notice how the Explorer panels change with each option. Try the four
options in the Arrange Icon option and Details option to see the result.
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4.5 Creating and Deleting Folders :

You can also create and delete folders in Explorer. To create a new
folder, you first need to know WHERE your folder will be located, such
as the desired drive, and then the directory from the tree (left panel). Select
the disk and folder that you want to create this new subfolder within, and
select File New Folder from the menu bar.

You need to be careful when deleting or removing folders, since you
may remove a folder with important files still within it. Deleting folders
also removes files and any subfolders in that folder. Click to select the
folder, and then select File Delete from the menu bar.

• Launch Explorer and put your floppy disk in the floppy drive. Click
on the Floppy Drive icon.

• Select File New Folder. Alternatively, you can right click in the right
pane and select the New Folder Option
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• Type DISTANCE and press [ENTER]. The new folder has been
added under the A:\ root directory. Double–click the folder DISTANCE
and select File New Folder (or once again right click and select New
Folder). Type ACTIVITY. Your directory tree for the floppy disk is
shown :

• If you have other folders, then they will also be shown.

• Click on the DISTANCE folder. To delete this folder (and all its
contents), select File Delete from the menu, or press DELETE. Click
OK when the Confirm Delete dialog box appears.

4.6 Disk and File Management Operations :

Windows Explorer allows the management of files such a wide range
of file activities including copying, moving, deleting and renaming.

Copying Operation – In order to copy one or more files from one
folder to another, these file(s) should be first selected from the directory
list. Multiple files can be selected from the folder by clicking on the first
file (remember, do NOT double click as this will open the document and
not select it), then hold down the CONTROL key while clicking on each
individual file. If the files are located together, then first hold down the
SHIFT key and then click on the first and then the last file. All files between
the first and last will be selected. A file can be de–selected by clicking on
the file a second time. After selecting the file(s) use the Edit Copy
command, or hold down the CTRL key and tap the letter C on the keyboard.
Click in the destination folder on the desired drive, and select Edit Paste.
Your files should be copied to the desired folder.

Moving Operation – To move one or more files, first select the
required files, as in the copying operation above. With the files selected
or highlighted, click and hold on the selected files. Then drag the mouse
pointer onto the destination folder name in the tree and release the mouse
button. You should check to see that the files were actually moved to the
desired location. Alternatively, files can be moved by first selecting the files
and using Edit Cut, to remove the files from the first location. Then click
in the destination folder on the desired drive, and select Edit Paste to move
the files to this folder.

Renaming Operation – Renaming files is accomplished by selecting
the desired file and then choosing File Rename from the menu. Simply type
in the new filename and press Enter.

First create the following tree structure on your floppy disk, or
memory stick (removable disk)
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Use Start, Programs, Accessories, and Paint to create the four bitmap
files and save those files with a Monochrome Bitmap file format. Use
WordPad or Notepad to create and save the four text files shown. You do
not need to type anything in the file. Save these files in the root folder of
your disk. Also make sure your files are arranged by type in Explorer.

Copy all bitmap files from the root (Distance) to the Graphics folder.
To do this: Click on the first file Assign1 Graphic, hold the SHIFT key down
and click or select the Assign4 Graphic to select all of the graphic files.

Select Edit Copy from the menu, or hold down the CTRL key and
tap the C key. Click on the Graphics folder in the directory structure (left
panel). Select Edit Paste, or CTRL V to copy the files. A dialog box will
show you the files as they are copied.

Move the text files to the folder Assignments.

Click on the first file Assign1, hold the SHIFT key down and click
or select the Assign5 text file to select all of the text files.

Select Edit Cut from the menu, or hold down the CTRL key and tap
the C key. Click on the Assignments folder in the directory structure (left
panel). Select Edit Paste, or CTRL V to copy the files. A dialog box will
show you the files as they are copied.

Delete the remaining files from the root. Select all files in the root
and tap the DELETE (DEL) key. Select YES when the Confirm Multiple
File Delete dialog box appears.

Rename files. Click on the System Software folder in the Tree. Select
File Rename from the menu, and type in the new file name : Operating
Systems. Press ENTER.

Click on the Application Software folder and press DELETE. What
happens ? Since you do not actually want to delete this folder, what should
you do ?

Check Your Progress :
1. In Microsoft Windows operating system, __________ is a tool for

organizing files on disk

2. A __________ folder is the main or general folder found on all disks
and is identified with the disk drive letter followed by a backslash
( \ ).
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3. Once you create folders within the root folder, then these folders are
called __________ .

4. To select multiple files one by one we need to press __________ Key
and click

5. To select multiple files in sequence we need to select first file and
press __________ key and then click on last file

4.7 Let Us Sum Up :

In this unit we explored how to create a file and data management
system that will ensure you are able to effectively store and retrieve
information from your computer system. An effective business will treat
its data like gold. You must know how to protect, how to store it and how
to back it up.

The following concepts were explored in this unit :

1. Windows Explorer is a tool for organizing files on disk.

2. Files are a collection of information, data, or program files.

3. Folders are used to organize where the files are located.

4. A disk is a secondary storage device such as a floppy disk, CD, DVD,
or memory

5. stick, where folders and files can be stored.

6. The root folder is the main or general folder found on all disks.

7. Once you create folders within the root folder, then these folders are
called subfolders.

8. To create a new folder, you first need to know WHERE your folder
will be located.

9. You need to be careful when deleting or removing folders, since you
may remove a folder with important files still within it.

This unit explained the difference among terms such as disks, files,
folders and sub folders and root folder. It also noted the various disk drive
letter designations when performing data and file management tasks.

4.8 Answers for Check Your Progress :
1. Windows Explorer 2. Root 3. Subfolders

4. Ctrl 5. Shift

4.9 Glossary :

Windows Explorer : In Microsoft Windows operating system,
Windows Explorer is a tool for organizing files on disk and uses several
important components to manage drives such as disks (floppy disks, CDs,
DVDs, and memory sticks), folders and files.

Root folder : A root folder is the main or general folder found on
all disks and is identified with the disk drive letter followed by a backslash
( \ ).
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Sub folder : If you create folders within the root folder, then these
folders are called subfolders.

4.10 Assignment :

• Write short note on windows explorer

4.11 Activity :

• Make a list of useful short–cut key for Windows File and Directory
operations

4.12 Case study :

• Study Linux operating system file management

4.13 Further Reading :
1. Introduction to Computers, Roger Powley, CD PhD, Wilhelmina

Louw, Glenda Gaye, commonwealth of learning

2. Linux for IT Managers Course Guide, commonwealth of learning

3. Business Information Systems, Derrick Thompson, Commonwealth
of Learning



BLOCK SUMMARY

In this block we have learned about Impact and History of Computers,
Computer Hardware, Software and File and Data Management in windows
operating system.

BLOCK ASSIGNMENT

Short Answer Questions :

• Define the following terms

o Information technology.

o General computer system

o Embedded system.

o Memory addressing.

o Megabyte

• What is Operating System ?

• What is primary memory ?

• What is utility program ?

• What are Language translators ?

• What do you mean by secondary memory ?

• Describe the purpose of system software.

Long Answer Questions :

• Explain characteristics associated with computer technology.

• Discuss the contributions of computer technology to everyday living.

• Explain terms associated with computer technology.

• Explain features of computer technology.

• Explain evolution of computer systems.

• Describe the basic components of a computer system.

• Explain with example how a computer processes data.

• Describe the various user interfaces.

• Explain the difference between application software and system
software.

• Write detailed note on personal productivity applications.
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 Enrolment No. : 

1. How many hours did you need for studying the units ?

Unit No. 1 2 3 4

No. of Hrs.

2. Please give your reactions to the following items based on your reading
of the block :

3. Any other Comments

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................
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BLOCK 2 : Operating System

Block Introduction

This block covers introduction to Operating System with

definition, evolution of operating system and different types of

operating systems. It includes the services and structure of operating

systems as a whole. It focusses on terminologies used, functionalities

of an operating systems have and types of operating systems. The

very foundations of operating system can be viewed from different

perspectives.

Learner will get introduction to the Windows operating system

(Windows OS) for personal computers which dominates the personal

computer world. Block also covers introduction of Linux Operating

System.

Block Objectives

The objective of this block is to define an Operating System and

principles and objectives of the operating system with the corresponding

aims they have. To describe the evolution stages of operating systems

and general categories of OS, different software structures of operating

systems, services provided by the operating systems, objetives of Operating

System, evolution of Windows OS, features of Windows OS and discuss

new features of windows 10

Block Structure

Unit–1 : Introduction to Operating System

Unit–2 : Windows Operating System

Unit–3 : Linux Operating System
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1.0 Learning Objectives :

After studying this unit learner should be able to :

• Define an Operating System State the principles and objectives of the
operating system with the corresponding aims they have

• Describe the evolution stages of operating systems

• List general categories of OS

1.1 Introduction :

An operating system (OS) is a program that manages the computer
hardware. It also provides a basis for application programs and acts as an
intermediary between the computer user and the computer hardware. In this
unit we provide a general overview of the major components of an
operating system.

This unit introduces definition, evolution, structure and services of
operating system. The operating system is a system software. This unit
addresses the following questions:

• What are operating systems functionalities ?

• What are the activities performed by the modern operating systems ?

• What kind of software structure does it have ?

1.2 Definition of Operating System :
Let us try to define what is operating system. Our focus is about the

operating system software. What is it ?

Unit
1
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What is Operating System ?
Operating systems are system software that run on top of computer

hardware. This definition needs to be observed from different perspectives
of computer system, namely from application software and user hardware
interaction.

Operating system can be defined as, system program that monitors
works of application programs. It is responsible for the loading and
execution of application programs. It has to make sure the availability of
the required hardware and software requirements before executing the
application program.

Operating system can also be defined as system software which acts
as a bridge between the hardware and its users. The operating system,
according to this definition, has a responsibility to hide the complexities
of the underlying hardware for the end user. The end user is not supposed
to know the details of hardware components like CPU, memory, disk drives,
etc.

As we have discussed the definitions of operating system so far, we
can conclude that the operating system is found between user, application
software, and physical component of the computer system. It facilitates and
monitors running of application programs and functions as a middle man
between hardware and users.

Check Your Progress – 1
1. OS is a program that manages the computer software. (True/False)

2. An Operating system is an example of system software. (True/False)

3. OS functions as a middle man between hardware and users.
(True/False)

4. OS facilitates and monitors running of application programs.
(True/False)

1.3 Evolution of Operating Systems :

Computers gone through different generations. The generations are
classified based on varieties of criterion. One of the major criteria to classify
computer generations is the type of operating system used. Evolution of
operating systems has a close tie with the generation of computers. What
were the basic changes made on operating systems over these generations ?

Studying evolution of Operating Systems is used to understand key
requirements of an Operating System. Moreover, it helps to understand
significance of the major features of modern Operating Systems.

Operating systems and computer architecture are historically tied. The
combination of computer architecture with operating system is known as
computer platform. Architectural changes affect structure and performance
of Operating Systems. While studying the evolution of operating systems,
consideration on the architecture is required.



INTRODUCTION TO
OPERATING SYSTEM

63

Evolution of operating systems over the past decades has shown
number of progresses from several perspectives. Starting from the point
where machine does not have operating systems to a distributed processing
capability. The foundation for the modern operating system was built over
different parameters.

The following shows the major evolution of Operating Systems :

Wiring–up Plug–boards

Low level programming language called machine language was used
to write computer instructions through wiring up plug–boards Plug–boards
control the basic functions of the computer. No Operating Systems software
were introduced. No programming languages to develop applications. No
operators were required. Complex programming and machine
underutilization.

Serial Processing

The technique is to running a single Job. Following are the working
of serial processing :

• Developer creates his/her program and punches it on cards

• He/she submits the card deck to an operator in the input room

• he/she reserves machine time on a sign–up sheet

• Operator set–up the job as scheduled

• Operator caries over the returned output to the output room

• The developer will collect the output later

No Operating Systems software were introduced. No programming
languages to develop applications.

Features
• Users get access in series

• Program writing was improved Disadvantages

• Wasted time due to scheduling and setup

• Wasted time while operators walk around the machine room

• Large machine/processor idle time

Batch Processing
The users of batch operating system do not interact with the computer

directly. Each user prepares his job on an off–line device like punch cards
and submits it to the computer operator. To speed up processing, jobs with
similar needs are batched together and run as a group. Thus, the programmers
left their programs with the operator. The operator then sorts programs into
batches with similar requirements. The technique is to running a batch of
Job.

Advantages

• Once the data process is started, the computer can be left running
without supervision.
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• Batch processing allows an organization to increase efficiency because
a large amount of transactionscan be combined into a batch rather
than processing them each individually.

Disadvantages
• It is very difficult to maintain the priority between the batches.

• There is no direct interaction of user with computer. Lack of
interaction between the user and job.

• CPU is often idle, because the speeds of the mechanical I/O devices
is slower than CPU.

• Difficult to provide the desired priority.

• With batch processing there is a time delay before the work is
processed and returned.

Spooling Batch Processing

Technique
• Adds up Spooling technique to simple batch processing

• Spooling – Simultaneous Peripheral Operation Online

• It is the ability to read jobs/print job outputs while the processor
executes jobs

• Read jobs – from cards to disk

• Print job outputs – from disk to printer

• Used in input and output operations

With spooling, every time a currently executing task is completed, a
new task is shipped from storage to the now–empty panel and be executed
by the OS. Spooling is the first attempt of multiprogramming

Advantages

• Avoids CPU idle time between batches of jobs

• Improve turn–around time: Output of a job was available as soon as
the job completed, rather than only after all jobs in the current cycle
were finished.

Disadvantages
• Large turn–around time

• Large CPU idle time on heavily I/O bound jobs

Multi–programming
In a multiprogramming system there are one or more programs loaded

in main memory which are ready to execute. Only one program at a time is
able to get the CPU for executing its instructions (i.e., there is at most one
process running on the system) while all the others are waiting their turn.

The main idea of multiprogramming is to maximize the use of CPU
time. Indeed, suppose the currently running process is performing an I/O
task (which, by definition, does not need the CPU to be accomplished).
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Then, the OS may interrupt that process and give the control to one of the
other in–main–memory program that are ready to execute (i.e. process
context switching). In this way, no CPU time is wasted by the system
waiting for the I/O task to be completed, and a running process keeps
executing until either it voluntarilyreleases the CPU or when it blocks for
an I/O operation. Therefore, the ultimate goal of multi programming is to
keep the CPU busy as long as there are processes ready to execute.

Note that in order for such a system to function properly, the OS must
be able to load multiple programs into separate areas of the main memory
and provide the required protection to avoid the chance of one process
being modified by another one. Other problems that need to be addressed
when having multiple programs in memory is fragmentation as programs
enter or leave the main memory. Another issue that needs to be handled
as well is that large programs may not fit at once in memory which can
be solved by using pagination and virtual memory.

Advantages

• Increase CPU utilization and reduce CPU idle time.

• It decreases total read time needed to execute a job as the jobs are
in main memory. Disadvantages of Multi Programming Operating
System

Disadvantages
• Long response time: the elapsed time to return back a result for a

given job was often several hours

• Poor interactivity between programmer and his program

Time Sharing
Multiple jobs are executed by the CPU by switching between them,

but the switches occur so frequently. Thus, the user can receives an
immediate response. For example, in a transaction processing, processor
execute each user program in a short burst or quantum of computation. That
is if n users are present, each user can get time quantum. When the user
submits the command, the response time is in few seconds at most.

Operating system uses CPU scheduling and multiprogramming to
provide each user with a small portion of atime. Computer systems that
were designed primarily as batch systems have been modified to time–
sharing systems.

Advantages

• More than one user can execute their task simultaneously.

• Avoids duplication of software

• CPU Idle time is reduced and better utilization of resources.

• Provide advantage of quick response.
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Disadvantages
• Question of securing the security and integrity of user's data and

programs.

• Since multiple processes are managed simultaneously, so it requires
an adequate management of main memory

• Problem of reliability.

Real–time processing

Real time system is defined as a data processing system in which the
time interval required to process and respond to inputs is so small that it
controls the environment. Real time processing is always on line whereas
on line system need not be real time. The time taken by the system to
respond to an input and display of required updated information is termed
as response time. So, in this method response time is very less as compared
to the online processing.

Real–time systems are used when there are rigid time requirements
on the operation of a processor or the flow of data and real–time systems
can be used as a control device in a dedicated application. Real–timeoperating
system has well–defined, fixed time constraints otherwise system will fail.
For example, Scientific experiments, medical imaging systems, industrial
control systems, weapon systems, robots, and home–applicance controllers,
Air traffic control system etc. There are two types of real–time operating
systems.

Hard real–time systems : Hard real–time systems guarantee that
critical tasks complete on time. In hard real–time systems secondary storage
is limited or missing with data stored in ROM. In these systems virtual
memory is almost never found.

Soft real–time systems : Soft real time systems are less restrictive.
Critical real–time task gets priority over other tasks and retains the priority
until it completes. Soft real–time systems have limited utility than hard
real–time systems. For example, Multimedia, virtual reality, Advanced
Scientific Projects like undersea exploration and planetary rovers etc.

Advantages

• Better task scheduling as compared to manual process and time
deadlines achievement is guaranteed in most of the cases.

• Accelerate the process by automanaging the system resources as in
the case of Autopilot airplanes and railway e–ticket booking system.

Disadvantages
• If time dead lines are missed it may result in severe disastrous

situation.

• Complex and need additional kernel, Memory and other resources are
required.

• More vulnerable to security breaches like virus and unauthorized
access.



INTRODUCTION TO
OPERATING SYSTEM

67

Networked Processing
Comprise of several computers that are interconnected to one

another. Each of these networked devices has their own local users and
executes their own local OS not basically different from single computer
OSs. Users also know about the presence of the several computers.
Additional features needed by network operating systems are Network
interface controller, NIC, A low–level software to drive it and software for
remote login & remote file access.

Distributed Processing

A distributed system is a collection of physically separate, possibly
heterogeneous computer systems that are networked to provide the users
with access to the various resources that the system maintains. Access to
a shared resource increases computation speed, functionality, data availability,
and reliability. Some operating systems generalize network access as a form
of file access, with the details of networking contained in the network
interface's device driver. Others make users specifically invoke network
functions. Generally, systems contain a mix of the two modes–for example
FTP and NFS. The protocols that create a distributed system can greatly
affect that system's utility and popularity.

Runs on a multi–computer system : set of computers, each having
its own memory, storage devices and other I/O modules. This is useful for
distributing the task between these different computers. Existence of
multiple computers is transparent to the user: It appears as a uniprocessor
system. It differs in critical ways from uniprocessor OSs. Examples of
distributed operating systems include LOCUS, MICROS, IRIX, Solaris,
Mac/OS, and OSF/1.

Advantages
• With resource sharing facility user at one site may be able to use the

resources available at another.

• Speedup the exchange of data with one another via electronic mail.

• If one site fails in a distributed system, the remaining sites can
potentially continue operating.

• Better service to the customers.

• Reduction of the load on the host computer.

• Reduction of delays in data processing

Disadvantages
• Security problem due to sharing

• Some messages can be lost in the network system

• Bandwidth is another problem if there is large data then all network
wires to be replaced which tends to become expensive

• Overloading is another problem in distributed operating systems
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• If there is a database connected on local system and many users
accessing that database through remote or distributed way then
performance become slow

• The databases in network operating is difficult to administrate then
single user system

Check Your Progress – 2

1. Monitoring utilities were put to memory when required in simple
batch processing systems (True/False)

2. In which type of system, the output of a program is sent to the disk
and is printed only when the job completes ?

(a) Multi–programmed batch systems

(b) Batch systems with spooling

(c) Time sharing systems

(d) Multi–printing systems

3. A system that supports multiple processes per user is called a

(a) Multi–user system (b) Multi–programming system

(c) Multi–tasking system (d) None of the above

4. ________ operating system allows a computer to work independently
as well as provides a means for sharing resources (e.g. files, printers,
etc.) to other computers connected to it.

(a) Real–time operating system (b) Symmetric operating system

(c) Local area network (d) Network operating system

1.4 General Categories of Operating System :

In above sections, we have introduced the general structure of a
typical computer system. We have also seen that how the peripheral devices
are attached to the processor and I/O between external and internal storage.
There are different categories of the operating system according to the use
and utilities provided by architecture.

Desktop system : The program controls the machine itself and
provide services to the user of the machine only is called desktop or laptop
operating system. This operating system takes the control of the hardware
and run the environment to provide services like – memory management,
process management, device access and data handling. Many systems of
this category provide security and data protection. Examples are windows
10, Ubuntu 18.04 LTS, Mac OS 10.14 (Mojave) etc.

Multiprocessor system : System with two or more than two processors
is known as multiprocessor system. This system shares common bus, clock,
memory and devices. According to Flynn's classification, MISD (Multiple
Instruction stream and Single Data stream) and MIMD (Multiple Instruction
stream and Multiple Data stream) computers are of this category. Distributed
system and clustered system are also part of multiprocessor system. When
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data stream and instruction stream are increased it effect the following
parameters :

1. Throughput : Get more work done in less time. When more data
and instruction stream are there, they can do the work simultaneously
so the performance is increased. The speed–up ratio is increased for
N processor work together but theoretically we are not getting
increase according to number of processors. There are many reasons
for that.

2. Economy scale : MISD and MIMD architecture can use cluster of
the computers and processors, that sharing external devices. This can
be a cost effective solution in many cases.

3. Reliability : Failure of one processor will not affect other processing
going on in the system, albeit load of the failed processor can be
divided among other processors. This is user transparent mechanism
so user don't have to bother about failure and system will be more
reliable.

Distributed system : Distributed system is collection of physically
separate, heterogeneous, and system that are networked to provide services.
Sharable devices increase the speed of computation, data availability and
reliability.

Clustered system : Cluster is usually used to provide high–availability
services, when one of the nodes in the cluster is failed than other node takes
charge of that node and start execution from where it is failed. There are
mainly two types of clustered system– asymmetrical and symmetrical. In
asymmetrical one node is standby mode so it can take the control of the
failed node while symmetrical cluster all nodes are running simultaneously
and monitor each other.

Real time system : Real time system are special system that works
on special requirements. The unique feature of this system is to complete
the task in given deadline and instant service to the requisition generated
in the environment. If task is not finished or handled in the given timeframe
than it can cause the disaster. Major issue in the real time system is to
develop a routine for proper scheduling of processes.

Handheld system : This category of the system includes PDA
(Personal Digital Assistant) like tablets, cellular telephones etc. main issue
of this system to manage data and application in limited amount of
resources. Size of the device is small, processor rate is also slow, and
amount of the memory is small to manage data.

1.5 Let Us Sum Up :

An operating system is software that manages the computer hardware
as well as providing an environment for application programs to run.
Perhaps the most visible aspect of an operating system is the interface to
the computer system it provides to the human user.
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There are several different strategies for designing a computer system.
Uniprocessor systems have only a single processor while multiprocessor
systems contain two or more processors that share physical memory and
peripheral devices. The most common multiprocessor design is symmetric
multiprocessing (or SMP), where all processors are considered peers and
run independently of one another. Clustered systems are a specialized form
of multiprocessor systems and consist of multiple computer systems
connected by a local area network.

To best utilize the CPU, modem operating systems employ
multiprogramming, which allows several jobs to be in memory at the same
time, thus ensuring the CPU always has a job to execute. Timesharing
systems are an extension of multiprogramming whereby CPU scheduling
algorithms rapidly switch between jobs, thus providing the illusion each job
is running concurrently.

The operating system must ensure correct operation of the computer
system. To prevent user programs from interfering with the proper operation
of the system, the hardware has two modes: user mode and kernel mode.
Various instructions (such as I/0 instructions and halt instructions) are
privileged and can be executed only in kernel mode. The memory in which
the operating system resides must also be protected from modification by
the user. A timer prevents infinite loops. These facilities (dual mode,
privileged instructions, memory protection, and timer interrupt) are basic
building blocks used by operating systems to achieve correct operation.

In this unit we have lean about Definition of Operating System,
Evolution of Operating Systems, operating systems functionalities, activities
performed by the modern operating systems.

1.6 Answers for Check Your Progress :

Check Your Progress – 1
1. False 2. True 3. True 4. True

Check Your Progress – 2
1. False 2. b 3. d 4. d

1.7 Glossary :
Operating System : Operating systems are system software that run

on top of computer hardware. This definition needs to be observed from
different perspectives of computer system, namely from application software
and user hardware interaction

Real Time Processing : Real time system is defined as a data
processing system in which the time interval required to process and
respond to inputs is so small that it controls the environment.

Spooling : Simultaneous Peripheral Operation Online

Time sharing : Multiple jobs are executed by the CPU by switching
between them, but the switches occur so frequently.
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Multi Programming : In a multiprogramming system there are one
or more programs loaded in main memory which are ready to execute. Only
one program at a time is able to get the CPU for executing its instructions
(i.e., there is at most one process running on the system) while all the others
are waiting their turn.

Distributed System : Distributed system is collection of physically
separate, heterogeneous, and system that are networked to provide services.
Sharable devices increase the speed of computation, data availability and
reliability.

Multiprocessor System : System with two or more than two
processors is known as multiprocessor system.

1.8 Assignments :

• What is an operating system ?

• Write detailed note on evolution of operating system

• Write note on Simple Batch Processing

• Explain network operating system

• What is real time operating system ?

1.9 Activity :
• Write Disadvantages of multiprogramming and timesharing

• Write difference between Network OS and Distributed OS

1.10 Case study :

• Explain general categories of Operating System

1.11 Further Reading :
• Andrew S. Tanenbaum (2008). Modern Operating System. 3rd

Edition. Prentice–Hall.

• A Silberschatz, Peter B Galvin, G Gagne (2009). Operating System
Concepts. 8th Edition. Wiley.
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2.0 Learning Objectives :

Upon completion of this unit, you should be able to :

• Describe Evolution of Windows OS

• List features of Windows OS

• Understand new features of windows 10

2.1 Introduction :

The Windows operating system (Windows OS) are more formally
called Microsoft Windows and is actually a family of operating systems for
personal computers. Windows dominates the personal computer world,
running, by some estimates, more than 90 percent of all personal computers
– the remainder running Linux and Mac operating systems.

Windows provides a graphical user interface (GUI), virtual memory
management, multitasking, and support for many peripheral devices. In
addition to Windows operating systems for personal computers, Microsoft
also offers operating systems for servers and mobile devices. In this unit
we will learn about evolution of today's Windows Operating System and
features of Windows Operating System.

2.2 History of Windows OS :
The following details the history of MS–DOS and Windows operating

systems designed for personal computers (PCs). Microsoft Windows is a
family of operating systems. We look at the history of Microsoft's Windows
operating systems (Windows OS) from 1985 to present day.

Unit
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MS–DOS – Microsoft Disk Operating System (1981)
Originally developed by Microsoft for IBM, MS–DOS was the

standard operating system for IBM–compatible personal computers. The
initial versions of DOS were very simple and resembled another operating
system called CP/M. Subsequent versions have become increasingly
sophisticated as they incorporated features of minicomputer operating
systems.

Windows 1.0 – 2.0 (1985–1992)

Introduced in 1985, Microsoft Windows 1.0 was named due to the
computing boxes, or "windows" that represented a fundamental aspect of
the operating system. Instead of typing MS–DOS commands, windows 1.0
allowed users to point and click to access the windows. In 1987 Microsoft
released Windows 2.0, which was designed for the designed for the Intel
286 processor. This version added desktop icons, keyboard shortcuts and
improved graphics support.

Windows 3.0 – 3.1 (1990–1994)

Windows 3.0 was released in May, 1900 offering better icons,
performance and advanced graphics with 16 colors designed for Intel 386
processors. This version is the first release that provides the standard "look
and feel" of Microsoft Windows for many years to come. Windows 3.0
included Program Manager, File Manager and Print Manager and games
(Hearts, Minesweeper and Solitaire). Microsoft released Windows 3.1 in
1992.

Windows 95 (August 1995)

Windows 95 was released in 1995 and was a major upgrade to the
Windows operating system. This OS was a significant advancement over
its precursor, Windows 3.1. In addition to sporting a new user interface,
Windows 95 also includes a number of important internal improvements.
Perhaps most important, it supports 32–bit applications, which means that
applications written specifically for this operating system should run much
faster.

Although Windows 95 can run older Windows and DOS applications,
it has essentially removed DOS as the underlying platform. This has meant
removal of many of the old DOS limitations, such as 640K of main memory
and 8–character filenames. Other important features in this operating
system are the ability to automatically detect and configure installed
hardware (plug and play).

Windows 98 (June 1998)

\Windows 98 offers support for a number of new technologies,
including FAT32, AGP, MMX, USB, DVD, and ACPI. Its most visible
feature, though, is the Active Desktop, which integrates the Web browser
(Internet Explorer) with the operating system. From the user's point of
view, there is no difference between accessing a document residing locally
on the user's hard disk or on a Web server halfway around the world.
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Windows ME – Millennium Edition (September 2000)
The Windows Millennium Edition, called "Windows Me" was an

update to the Windows 98 core and included some features of the Windows
2000 operating system. This version also removed the "boot in DOS"
option.

Windows NT 31. – 4.0 (1993–1996)

A version of the Windows operating system. Windows NT (New
Technology) is a 32–bit operating system that supports preemptive
multitasking. There are actually two versions of Windows NT: Windows
NT Server, designed to act as a server in networks, and Windows NT
Workstation for stand–alone or client workstations.

Windows 2000 (February 2000)

Often abbreviated as "W2K," Windows 2000 is an operating system
for business desktop and laptop systems to run software applications,
connect to Internet and intranet sites, and access files, printers, and network
resources. Microsoft released four versions of Windows 2000: Professional
(for business desktop and laptop systems), Server (both a Web server and
an office server), Advanced Server (for line–of–business applications) and
Datacenter Server (for high–traffic computer networks).

Windows XP (October 2001)
Windows XP was released in 2001. Along with a redesigned look and

feel to the user interface, the new operating system is built on the Windows
2000 kernel, giving the user a more stable and reliable environment than
previous versions of Windows. Windows XP comes in two versions, Home
and Professional. Microsoft focused on mobility for both editions, including
plug and play features for connecting to wireless networks. The operating
system also utilizes the 802.11x wireless security standard. Windows XP
is one of Microsoft's best–selling products.

Windows Vista (November 2006)
Windows Vista offered an advancement in reliability, security, ease

of deployment, performance and manageability over Windows XP. New in
this version was capabilities to detect hardware problems before they occur,
security features to protect against the latest generation of threats, faster
start–up time and low power consumption of the new sleep state. In many
cases, Windows Vista is noticeably more responsive than Windows XP on
identical hardware. Windows Vista simplifies and centralizes desktop
configuration management, reducing the cost of keeping systems updated.

Windows 7 (October, 2009)
Windows 7 was released by Microsoft on October 22, 2009 as the

latest in the 25–year–old line of Windows operating systems and as the
successor to Windows Vista (which itself had followed Windows XP).
Windows 7 was released in conjunction with Windows Server 2008 R2,
Windows 7's server counterpart. Enhancements and new features in Windows
7 include multi–touch support, Internet Explorer 8, improved performance
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and start–up time, Aero Snap, Aero Shake, support for virtual hard disks,
a new and improved Windows Media Center, and improved security.

Windows 8
Windows 8 was released on August. 1, 2012 and is a completely

redesigned operating system that's been developed from the ground up with
touchscreen use in mind as well as near–instant–on capabilities that enable
a Windows 8 PC to load and start up in a matter of seconds rather than
in minutes.

Windows 8 will replace the more traditional Microsoft Windows OS
look and feel with a new "Metro" design system interface that first debuted
in the Windows Phone 7 mobile operating system. The Metro user interface
primarily consists of a "Start screen" made up of "Live Tiles," which are
links to applications and features that are dynamic and update in real time.
Windows 8 supports both x86 PCs and ARM processors.

Windows 10

Windows 10 is Microsoft's Windows successor to Windows 8.
Windows 10 debuted on July 29, 2015, following a "technical preview"
beta release of the new operating system that arrived in Fall 2014 and a
"consumer preview" beta in early 2015. Microsoft claims Windows 10
features fast start up and resume, built–in security and the return of the Start
Menu in an expanded form. This version of Windows will also feature
Microsoft Edge, Microsoft's new browser. Any qualified device (such as
tablets, PCs, smartphones and Xbox consoles) can upgrade to Windows 10,
including those with pirated copies of Windows.

2.3 Microsoft Operating Systems for Servers and Mobile Devices :

Aside from operating systems designed for use on personal computers
(PCs) and laptops, Microsoft has also developed operating systems for
services, handheld devices, and mobile phones.

Windows Server (March 2003)

Windows Server is a series of Microsoft server operating systems.
Windows servers are more powerful versions of their desktop operating
system counterparts and are designed to more efficiently handle corporate
networking, Internet/intranet hosting, databases, enterprise–scale messaging
and similar functions. The Windows Server name made its debut with the
release of Windows Server 2003 and continues with the current release,
Windows Server 2008 R2, which shares its codebase with Windows 7.
Windows Server 2008 R2 debuted in October 2009.

Windows Home Server (January 2007)

Announced in January 2007, Windows Home Server (WHS) is a
"consumer server" designed to use with multiple computers connected in
the home. Home Server allows you to share files such as digital photos and
media files, and also allows you to automatically backup your home
networked computers. Through Windows Media Connect, Windows Home
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Server lets you share any media located on your WHS with compatible
devices.

Windows CE (November 2006)
A version of the Windows operating system designed for small

devices such as personal digital assistants (PDAs) (or Handheld PCs in the
Microsoft vernacular). The Windows CE graphical user interface (GUI) is
very similar to Windows 95 so devices running Windows CE should be easy
to operate for anyone familiar with Windows 95.

Windows Mobile (April 2000)
A mobile operating system for smartphones and mobile devices from

Microsoft based on the Windows CE kernel and designed to look and
operate similar to desktop versions of Microsoft Windows. Windows
Mobile has largely been supplanted by Windows Phone 7, although
Microsoft did release, in 2011, Windows Embedded Handheld 6.5, a mobile
OS compatible with Windows Mobile 6.5 that's designed for enterprise
mobile and handheld computing devices.

Windows Phone (November 2010)
Windows OS – Windows Phone
A mobile operating system for smartphones and mobile devices that

serves as the successor to Microsoft's initial mobile OS platform system,
Windows Mobile. Unlike Windows Mobile, Windows Phone 7 (also
referred to as WinPhone7) is targeted more to the consumer market than
the enterprise market, and it replaces the more traditional Microsoft
Windows OS look and feel with a new "Metro" design system user
interface.

Windows Phone 7 features a multi–tab Internet Explorer Mobile Web
browser that uses a rendering engine based on Internet Explorer 9 as well
Microsoft Office Mobile, a version of Microsoft Office that's tailored for
mobile devices. Its successors include Windows Phone 8 and Windows 10
Mobile.

2.4 New Features of Windows 10 :

Windows 10 is the most recent version of the Microsoft Windows
operating system. While older versions of Windows mainly ran on desktop
and laptop computers, Windows 10 is also designed to run equally well on
tablets.

Start menu
Whereas Windows 8 uses the Start screen to launch applications,

Windows 10 has reintroduced a more traditional Start menu. It's also been
expanded to make it easier to find important apps.

Microsoft Edge

This new browser is designed to give Windows users a better
experience on the Web. It's faster, more secure, and includes a lot of new
features. Microsoft Edge is meant to replace Internet Explorer as your
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default web browser, but you'll still be able to use IE (or another browser)
if you prefer.

Cortana
Similar to Siri and Google Now, you can talk to this virtual assistant

with your computer's microphone. Cortana can answer questions like
What's the weather like today ?, perform simple tasks like remind you to
take out the trash, and much more.

Multiple desktops and Task view
Instead of keeping everything open on the same desktop, you can

move some of your windows to a virtual desktop to get them out of the
way. And the new Task view feature makes it easy to manage all of your
open windows.

Action Center
The new Action Center is pretty different from previous versions of

Windows. For example, it's been expanded to let you access frequently used
settings, such as Wi–Fi connectivity and tablet mode. It's also where you'll
see important notifications, so if your computer receives an update you'll
get a notification about it here.

Tablet mode

Unlike Windows 8, Windows 10 makes a clear distinction between
desktops and tablets. If you're using a keyboard and mouse with Windows
10, you'll be in desktop mode by default. If your computer also has a
touchscreen, you can go into tablet mode at any time. Tablet users can also
switch back to desktop mode if they prefer.

Check Your Progress :

1. Windows–7 launch in the year _______

(a) 2007 (b) 2008 (c) 2009 (d) 2010

2. Which of the following is a new feature in windows 10

(a) Microsoft Edge (b) Cortana

(c) Tablet Mode (d) All of these

3. Windows XP comes in two versions, Home and Professional.

4. Windows NT (New Technology) is a 64–bit operating system that
supports preemptive multitasking. (True/False)

5. Windows CE is designed to look and operate similar to desktop
versions of Microsoft Windows. (True/False)

6. Windows 10 has reintroduced a more traditional Start menu. It's also
been expanded to make it easier to find important apps.. (True/False)

7. Windows 10 makes a clear distinction between desktops and tablets..
(True/False)

8. Windows 8 is a completely redesigned operating system that's been
developed from the ground up with touchscreen and enable a
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Windows 8 PC to load and start up in a matter of seconds rather than
in minutes. (True/False)

2.5 Let Us Sum Up :

In this unit we have learn about windows operating system and
evolution of Windows Operating System, Microsoft Operating Systems for
Servers and Mobile Devices and understand new features of windows 10.

2.6 Answers for Check Your Progress :

1. a 2. b 3. True 4. False

5. True 6. True 7. True 8. True

2.7 Glossary :
Windows : It is actually a family of operating systems for personal

computers

Microsoft Edge : This new browser is designed to give Windows
users a better experience on the Web. It's faster, more secure, and includes
a lot of new features. Microsoft Edge is meant to replace Internet Explorer
as your default web browser, but you'll still be able to use IE (or another
browser) if you prefer.

Cortana : Similar to Siri and Google Now, you can talk to this virtual
assistant with your computer's microphone. Cortana can answer questions
like What's the weather like today ? perform simple tasks like remind you
to take out the trash, and much more.

Action Center : The new Action Center is pretty different from
previous versions of Windows. For example, it's been expanded to let you
access frequently used settings, such as Wi-Fi connectivity and tablet mode.
It's also where you'll see important notifications, so if your computer
receives an update you'll get a notification about it here.

Tablet mode : Unlike Windows 8, Windows 10 makes a clear
distinction between desktops and tablets. If you're using a keyboard and
mouse with Windows 10, you'll be in desktop mode by default. If your
computer also has a touchscreen, you can go into tablet mode at any time.
Tablet users can also switch back to desktop mode if they prefer.

Windows CE : A version of the Windows operating system designed
for small devices such as personal digital assistants (PDAs) (or Handheld
PCs in the Microsoft vernacular).

2.8 Assignment :

• Write detailed note on history of Windows OS

• Explain new features of Windows 10 Operatiing System

2.9 Activities :
• Explore new features of windows 10 operating system
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2.10 Case Study :
• Study Microsoft Operating Systems for Servers and Mobile Devices

2.11 Further Reading :
• https://www.webopedia.com/DidYouKnow/Hardware_Software/

history_of_microsoft_windows_operating_system.html

• https://www.microsoft.com/en–in/windows/features–activetab=
feature–pivot%3aprimaryr2
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3.0 Learning Objectives :

Upon completion of this unit, you should be able to :

• Describe Evolution of Windows OS

• List features of Windows OS

• Understand new features of windows 10

3.1 Introduction :

Free and Open–Source Software (FOSS) can be available commercially
or as non–commercial software. The "free" in open–source software refers
to the Free Software Foundation's (www.fsf.org) definition of 'What is Free
Software'. The freedoms at the core of free software are defined as :

1. The freedom to run the software for any purpose;

2. The freedom to study how the software works and adapt it to your
needs;

3. The freedom to redistribute copies so you can help others; and

4. The freedom to improve the software and release your improvements
to the public, so that everyone benefits.

The Free Software Foundation's philosophy behind software
development provided great motivation for the Free Software community.
In the early 1990s, along with the increasing use of the Internet and the
success of the World Wide Web, many new Open–Source projects emerged.
The most prominent example is Linux. Linux is a Unix–like operating
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system targeted to run on a personal computer. It was developed by the
Finnish computer science student Linus Torvalds who used the GNU
(named for Gnu'sNot Unix) software tools. In 1991, he released the code
of an experimental version under the GPL (General Public License) to a
newsgroup and asked for comments and improvements.

Linux is a powerful, free and Open–Source operating system. Linux
has a modular structure, so individuals or groups of developers can focus
on one part of the program. Linux was used increasingly in combination
with the GNU tools. Because the operating system is central to IT
infrastructure, it eventually became relevant for business use.

3.2 What Is Linux ?

From smartphones to cars, supercomputers and home appliances,
home desktops to enterprise servers, the Linux operating system is
everywhere.

Linux has been around since the mid–1990s and has since reached
a user–base that spans the globe. Linux is actually everywhere : It's in your
phones, your thermostats, in your cars, refrigerators, Roku devices, and
televisions. It also runs most of the Internet, all of the world's top 500
supercomputers, and the world's stock exchanges.

But besides being the platform of choice to run desktops, servers, and
embedded systems across the globe, Linux is one of the most reliable,
secure and worry–free operating systems available.

Just like Windows, iOS, and Mac OS, Linux is an operating system.
In fact, one of the most popular platforms on the planet, Android, is
powered by the Linux operating system. An operating system is software
that manages all of the hardware resources associated with your desktop
or laptop. To put it simply, the operating system manages the communication
between your software and your hardware. Without the operating system
(OS), the software wouldn– t function.

The Linux operating system comprises several different pieces :

Bootloader The software that manages the boot process of your
computer. For most users, this will simply be a splash
screen that pops up and eventually goes away to boot
into the operating system.

Kernel This is the one piece of the whole that is actually
called ? Linux ? The kernel is the core of the system and
manages the CPU, memory, and peripheral devices. The
kernel is the lowest level of the OS.

Init system This is a sub–system that bootstraps the user space and
is charged with controlling daemons.

Daemons These are background services (printing, sound,
scheduling, etc.) that either start up during boot or after
you log into the desktop.
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Graphical This is the sub–system that displays the graphics on your
server monitor. It is commonly referred to as the X server or

just X.

Desktop This is the piece that the users actually interact with.
environment There are many desktop environments to choose from

(GNOME, Cinnamon, Mate, Pantheon, Enlightenment,
KDE, Xfce, etc.). Each desktop environment includes
built–in applications (such as file managers, configuration
tools, web browsers, and games).

Applications Desktop environments do not offer the full array of apps.
Just like Windows and macOS, Linux offers thousands
upon thousands of high–quality software titles that can
be easily found and installed. Most modern Linux
distributions include App Store–like tools that centralize
and simplify application installation. For example, Ubuntu
Linux has the Ubuntu Software Center which allows you
to quickly search among the thousands of apps and
install them from one centralized location.

3.3 Linux Distribution and Installation :

Because of the Open–Source nature of the Linux Kernel, which
allows anyone to modify or enhance the base kernel (Operating System)
with other software, Linux is available in a wide variety of distributions.
A linux distribution is a collection of software packages, utilities, and
tools and is based on the version of a Linux kernel. Some distributions
can be created with a specific purpose in mind e.g to set–up a firewall or
for educational purposes etc. but there are also general–purpose distributions,
meaning that they come with a variety of software packages, tools and
applications that can be installed by the end user resulting in flexibility.

Each distribution comes with its own characteristics and special tools,
created by the distribution company to increase the value of their version
of Linux. Most of these distributions are obtained for free but many
companies also sell commercial distributions.

Often mention will be made for distinct changes with other key Linux
distributions. It is also important to note that this manual does not seek to
promote any particular distribution but will seek to expound on
implementations that cut across any Linux distribution. This implies that
the concepts described in this manual cut across majority of the Linux
distributions out there. For a comprehensive listing of Linux distributions
see http://www.distrowatch.com/

Popular Linux distributions include

• Linux mint

• Manjaro

• Debian
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• Ubuntu

• Antergos

• Solus

• Fedora

• Elementary os

• Opensuse

There are many Linux distributions out there, most of them with very
elaborate installation instructions. The following are some of the key linux
distributions and where you can find their download and installation
instructions.

Distribution Name Download and Installation Instructions Site

SuSE Linux Enterprise https://www.suse.com/download/
Server

Ubuntu https://ubuntu.com/download/desktop

Fedora https://getfedora.org/en/workstation/download/

CentOS https://www.centos.org/download/

Linux offers one of the easiest installations of all operating systems.
In fact, most versions of Linux offer what is called a Live distribution ?
which means you run the operating system from either a CD/DVD or USB
flash drive without making any changes to your hard drive. You get the
full functionality without having to commit to the installation. Once you've
tried it out, and decided you wanted to use it, you simply double–click the
"Install" icon and walk through the simple installation wizard.

Typically, the installation wizards walk you through the process with
the following steps (We'll illustrate the installation of Ubuntu Linux):

Preparation : Make sure your machine meets the requirements for
installation. This also may ask you if you want to install third–party
software (such as plugins for MP3 playback, video codecs, and more).

Wireless setup (if necessary) : If you are using a laptop (or machine
with wireless), you'll need to connect to the network, in order to download
third–party software and updates.

Hard drive allocation : This step allows you to select how you want
the operating system to be installed. Are you going to install Linux
alongside another operating system (called "dual booting"), use the entire
hard drive, upgrade an existing Linux installation, or install over an
existing version of Linux.

Location : Select your location from the map.

Keyboard layout : Select the keyboard for your system.

User setup : Set up your username and password.
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That's it. Once the system has completed the installation, reboot and
you're ready to go. For a more in–depth guide to installing Linux, take a
look at "How to Install and Try Linux the Absolutely Easiest and Safest
Way" or download the Linux Foundation's PDF guide for Linux installation.

3.4 The Linux Command line Structure :

A Unix shell is a command–line interpreter and script host that
provides a traditional user interface for the Unix operating system and for
Unixlike systems. Users direct the operation of the computer by entering
command input as text for a command line interpreter to execute or by
creating text scripts of one or more such commands.

A basic way to interact with a computer system is to use the command
line. The shell interprets the instructions typed in at the keyboard. That is
the shell is the interface between a human user and the Linux Operating
System. The shell prompt (ending with $ or # for user root) indicates that
it is ready for user input.

You can access the Linux Shell by Pressing Ctrl+Alt+F1 or F2 or F3
or F4 or F5 or F6. These commands open up a shell terminal where you
can be able to enter any Linux command. You may also access the terminal
on the windows interface. This terminal runs a shell which is a programming
environment which can be used to perform automated tasks. Shell programs
are called scripts. The most common shells are summarized in the table
below:

Most Common shells
The Bourne shell /bin/sh

The Bourne again shell /bin/bash

The Korn shell /bin/ksh

The C shell /bin/csh

Tom's C shell /bin/tcsh

Since the bash shell is one of the most widely used shells we shall
concentrate on the use of this shell. This Module shall focus on the use of
various Linux commands to perform basic file management commands in
the Linux System. In this Module you will be :

Introduced to the Linux Command Structure (Variables and command
options), the Interactive Shell, metacharacters and quotes plus perform the
following :

• Carry out Basic File Management Operations including creating,
Deleting, Editing, Renaming, Copying etc file contents and folders

• Moving around the file system;

• Find files and directories; and.

• Work with hard and soft links.
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Shell commands are often of the form

command [options] {arguments}.
To print text to the screen the bash shell will use the echo

$echo "this is a short line"

The shell interprets the first "word" of any string given on the
command line as a command. If the string is a full or relative path to an
executable then the executable is started. If the first word has no "/"
characters, then the shell will scan directories defined in the PATH variable
and attempt to run the first command matching the string.

For example if the PATH variable only contains the directories /bin
and /usr/bin then a command stored in /etc will not be found therefore, the
full path needs to be specifies.

An alternative to typing the full path to an executable is to use a
relative path. For example, if the user is in the directory where a particular
program is stored then one can type:

$ ./<Program Name>

3.5 Linux File Management :

Moving around the File System
A directory or a file can be accessed by giving its full pathname,

starting at the root (/) or its relative path, starting from the current directory.

Absolute path : independent of the user's current directory starts
with /

Relative path : depends on where the user is doesn't start with /

As in any structured file system there are a number of utilities that
can help you navigate through the system. The next two commands are
built–in commands.

pwd : Gives your actual position as an absolute path.

cd : The 'change directory' command

Finding Files and Directories
We will describe the find, which, whereis and locate utilities.

Find

Syntax: find <DIRECTORY> <CRITERIA> [-exec <COMMAND>
{} \;]

The DIRECTORY argument tells find where to start searching and
CRITERIA can be the name of a file or directory we are looking for.

Examples : find /usr/X11R6/bin–name ¨x*¨.

find /–user 502

Matching lines are listed to standard out. This output can be acted
upon. For example, delete the file, or change the permission. The find tool
has the build–in option –exec which allows you to do that. For example,
remove all files belonging to user 502 :
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locate
Syntax : locate <STRING>

Example : locate X11R

When using locate all files and directories that match the expression
are listed.

which

Syntax : which string

This tool will return the full path to the file called string by scanning
the directories defined in the user's PATH variable only. As a result which
is only used to find commands.

Whereis

Syntax : whereis string

This tool will return the full path to source or binaries as well as
documentation files matching string by scanning the PATH variable as well
as a number of well known locations

ls
Syntax : ls <option>

Most common options for ls

-I show inode

-h print human readable sizes

-n list UIDs and GIDs

-p append descriptor (/=@) to list

-R recursively display content of directories

-S sort by file size

-t sort by modification time (similar to–c)

Handling Directories
Making a directory with mkdir :

When making a directory you can set the permission mode with the
–m option. Another useful option is–p which creates all subdirectories
automatically as needed.

Example : mkdir –p docs/programs/versions

Removing directories :
To remove a directory, use either rmdir or rm–r. If you are root you

may have to specify–f to force the deletion of all files.

Notice : rm –rf /dir1/* removes all files and subdirectories leaving
dir1 empty

rm –rf /dir1/ removes all files and subdirectories including
dir1
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Using cp and mv
cp
Syntax : cp [options] file1 file2

cp [options] files directory

It is important to notice that cp file1 file2 makes a new copy of file1
and leaves file1 unchanged.

You can also copy several files to a directory, using a list or wildcards.
The following table lists the most used options.

Most common options for cp

-d do not follow symbolic link (when used with ?R)

-f Force

-I interactive, prompt before overwrite

-p preserve file attributes

-R recursively copy directories

Note : cp –r /dir/* /dir2/ will copy all files and subdirectories
omitting mydir

cp –r /mydir/ /dir2/ will copy all files and subdirectories
including mydir

mv

Syntax : mv [options] oldname newname

mv [options] source destination

mv [options] source directory

The mv command can both move and rename files and directories.
If oldname is a file and newname is a directory then the file oldname is
moved to that directory.

If the source and destination are on the same filesystem, then the file
isn't copied but the inode information is updated to specify the new
location. Most common options are–f forces overwrite and–i query
interactively.

Touch
Another way of creating or modifying a file is to use touch.

Syntax : touch {options} file(s)

If file doesn't exist it is created. You can also change the access time
of a file using the–a option,–m changes the modification time and–r is used
to apply the time attributes of another file.

Example :
touch file1.txt file2.txt creates new files

touch myfile–r /etc/lilo.conf myfile gets the time attributes of
lilo.conf
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To create a file called –errors use the – option:

touch -- -errors
dd

This command copies a file with a changeable I/O block size. It can
also be used to perform conversions (similar to tr).

Main options are if= (input file) of= (output file) conv= (conversion)

The conversion switch can be : lcase ucase ascii

Example :
dd if=/mnt/cdrom/images/boot.img of=/dev

Check Your Progress :
1. Which option of ls command used to view file inode number

(a) –l (b) –o (c) –a (d) –i

2. Find / –name '*' will

(a) List all files and directories recursively starting from /

(b) List a file named * in /

(c) List all files in / directory

(d) List all files and directories in / directory

3. Core of Linux operating system is __________.

(a) Shell (b) Kernel (c) Terminal (d) Command

4. Which command is used to remove files ?

(a) rm (b) dm (c) erase (d) delete

5.  __________ command is used to remove the directory.

(a) rdir (b) rd

(c) rmdir (d) None of the above

6. FSF stand for –

(a) Free Software File (b) Free Software Foundation

(c) First Serve First (d) None of the above

3.6 Let Us Sum Up :
In this unit you learned about the historical evolution of Free and

Open–Source Software. You also learned that Free and Open–Source
Software can be available as commercial software and learned about the
various Linux File types. You have also looked at the Linux File System
Standard and learned how to install the Linux, how to work with the
command shell and noted the structure of any Linux command, how to
navigate your way on the command line. The commands you have learned
in this module are critical for your effective operations within the Linux
system. You notice that you were able to change the operations of a linux
command by using appropriate switches/options. This is common across all
the Linux commands as this is a design principle common in all linux
applications.
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3.7 Answers for Check Your Progress :
1. d 2. a 3. b 4. a

5. c 6. b

3.8 Glossary :

Linux : Linux is an operating system. In fact, one of the most popular
platforms on the planet, Android, is powered by the Linux operating
system.

Kernel : This is the one piece of the whole that is actually called ?
Linux ? The kernel is the core of the system and manages the CPU,
memory, and peripheral devices. The kernel is the lowest level of the OS.

Daemons : These are background services (printing, sound,
scheduling, etc.) that either start up during boot or after you log into the
desktop.

3.9 Assignment  :

• 'What is Free Software' ?

• What is Linux ?

• What do you mean by distribution ?

• Write short note on Linux Distribution

• What is Shell ?

• Explain any five file and directory commands in linux

3.10 Activity :

• Attempt to access and download two different distributions above
and attempt to install them on your computer. Note the differences
between the distrubtion's installation processes.

3.11 Case Study :
• Having Installed Microsoft Windows Operating Systems before.

Compare and contrast the installation process between your selected
Linux Distribution and your Windows Installation Process.

3.12 Further Reading :
• https://www.linux.com/

• https://www.howtoforge.com/

• http://www.tldp.org/

• http://www.linux–tutorial.info/

• https://lwn.net/
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BLOCK SUMMARY

• An operating system is software that manages the computer hardware

as well as providing an environment for application programs to run.

• To best utilize the CPU, modem operating systems employ

multiprograming, which allows several jobs to be in memory at the

same time, thus ensuring the CPU always has a job to execute.

• Timesharing systems are an extension of multiprogramming whereby

CPU scheduling algorithms rapidly switch between jobs, thus providing

the illusion each job is running concurrently.

• The operating system must ensure correct operation of the computer

system. To prevent user programs from interfering with the proper

operation of the system, the hardware has two modes: user mode and

kernel mode. Various instructions (such as I/0 instructions and halt

instructions) are privileged and can be executed only in kernel mode.

The memory in which the operating system resides must also be

protected from modification by the user. A timer prevents infinite

loops. These facilities (dual mode, privileged instructions, memory

protection, and timer interrupt) are basic building blocks used by

operating systems to achieve correct operation.

• We have leaned about Definition of Operating System, Evolution of

Operating Systems, operating systems functionalities, activities

performed by the modern operating systems.

• We have learned about windows operating system and evolution of

Windows Operating System, Microsoft Operating Systems for Servers

and Mobile Devices and understand new features of windows 10.



BLOCK ASSIGNMENT

Short Answer Questions :

• What is operating system ?

• What is kernel mode ?

• What is Multi–programming ?

• What is time sharing OS ?

• What is network operating system ?

• What is windows operating system ?

• What is Exokernels architecture ?

Long Answer Questions :

• Write detailed note on General Categories of Operating System

• Explain in details about Services of Operating System

• Describe objectives of operating system

• Write detailed note on windows operating system with its features

91
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 Enrolment No. : 

1. How many hours did you need for studying the units ?

Unit No. 1 2 3

No. of Hrs.

2. Please give your reactions to the following items based on your reading
of the block :

3. Any other Comments

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................
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UNIT 1
MICROSOFT WORD BASIC FEATURES

UNIT 2
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UNIT 4
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BLOCK 3 : Word Processing and Spreadsheet

Block Introduction

This block covers introduction and advanced features of word

processing and spreadsheet software Microsoft Word and Microsoft

Excel

Block Objectives

The objective of this block is to introduce learner about basic and

advanced features of word processing software Microsoft Word and

spreadsheet software Microsoft Excel.

Block Structure

Unit–1 : Microsoft Word Basic Features

Unit–2 : Microsoft Word Advanced Fearures

Unit–3 : Microsoft Excel Spreadsheet Basics

Unit–4 : Microsoft Excel Advanced Features



: UNIT STRUCTURE :

1.0 Learning Objectives
1.1 Introduction to Word Processing

1.2 The Microsoft Word Interface
1.3 Entering and Editing Text
1.4 Spelling and Grammar

1.5 Selecting Text
1.6 Cut, Copy & Paste

1.7 Saving Files
1.8 Finding and Replacing Text

1.9 Creating Bulleted and Numbered Lists
1.10 Inserting Symbols
1.11 Inserting and Modifying Graphics

1.12 Utilizing WordArt and SmartArt
1.13 Inserting and Modifying Hyperlinks

1.14 Borders and Shading
1.15 Let Us Sum Up

1.16 Answers for Check Your Progress
1.17 Glossary
1.18 Assignment

1.19 Activity
1.20 Case Study
1.21 Further Readings

1.0 Learning Objectives :
After studying this unit learner should be able to :

• Create a file in Microsott Word and format it.

• Understand the functions of different Microsoft Microsoft Word
Interface.

• Perform Spelling and grammar checking

• Selecting text, Cut, copy and paste

• Find and replace text

• Create bulleted and numbered lists

Unit
1
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• Insert symbols, graphics and Hyperlink

• Utilize WordArt and SmartArt

1.1 Introduction to Word Processing :

Word processing describes creating or editing a document using a
word processor, such as Microsoft Word, Google Docs, or OpenOffice
Writer. For example, a student could create a book report in a Word
Processor application. Then, the student could print it, save it to a disk,
display it on the screen, or send it over e–mail. Also, a person looking for
a job could create a resume using a word processor, then e–mail or print
and mail it to job recruiters.

Some benefits of the document created using Word Processing instead
of handwritten or typewritten documentsare as under:

o Simplicity : The word processor provides a user with simple
Graphical User Interface to create a document. It is very easy to create
attractive and informative documents by giving just a few clicks and
commands. In addition, many word processors provide templates of
different type of documents. WE can easily replace the sample details
given in the templates with the appropriate information.

o Editing : Editing the text and other details is as simple as adding the
details. It is possible to add details in–between the existing details.
Also, details can be removed from the document and It is also easy
to update the details by using various keys available on the keyboard.

o Replication : Sometimes we need to create a new document by
changing a small portion of an existing document. Word processor
can be very useful in such situations. A word processor is equipped
with features using which we can produce multiple copies of the same
document.

o Storage of document : Word Processor stores document in digital
form. Normally the information is stored on magnetic disk medium
like hard disk or optical medium like CD/DVD. These mediums
guarantee long storage duration of the information. It is possible to
store many GBs of data in an extremely small–sized data card.
Thousands or millions of pages of documents can be stored on few
DVDs; this also resolves the storage problem.

o Rearranging Sections : Once the documents have been prepared, a
word processor provides the facility to rearrange sections within it.
Word Processor provides features of 'Cut' and 'Copy', using which a
section can be removed (cut) from its original place and put (paste)
into another place very easily. Sometimes it is required to put a section
as it is or with minimal changes in a new place, and in such cases
the 'Copy' and 'Paste' feature of the word processor can be used. Using
this feature, a user may replicate a sentence, a paragraph or a section
many times, and thus can be spared out from the task of repeated
typing.
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o Formating : After adding details in the word document, it is possible
to set Font type, Style, Color, Alignment, Border, Background or
other such formation quickly and easily. Such formation increases the
attractiveness and legibility of the document considerably.

o Spelling and Grammar Check : Word processor provides a feature
to find and correct the spellings and grammar of the text keyed into
the documents. With the help of this feature, a document can be made
error–free very easily.

1.2 The Microsoft Word Interface :

When Microsoft Word is started, the components as shown in the
figure are presented on the screen. Let us get the introduction of different
components used to create a document.

o The Quick Access toolbar contains one–click buttons for saving,
undoing, redoing, and print previewing a document. You can easily
modify this toolbar to add your most frequently used commands. Just
click the down–arrow on the right edge to customize this toolbar!

o The title bar displays the name of current document, and the
program. A new document will default with a temporary file name,
such as Document1 until you save the file with a different name. The
Minimize, Maximize and Exit buttons appear on the right edge of
the title bar.

o The Tell Me tool is a new way to get assistance with specific tasks
in Word. When the user starts typing, Word suggests commands that
are related to your keyword(s). The tool is context sensitive, and
integrated into your current document versus opening a separate
window. Therefore, if you type insert picture into the field, and click
the resulting command, Word will open the Insert Picture dialog
window without explaining the navigation instructions.
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o The Ribbon interface is a set of toolbars at the top of the window
in Office programs designed to help you quickly find the commands
that you need to complete a task. The ribbon displays a combination
of icons and tabs. Commands are grouped under multiple tabs. Some
commands are so extensive that they need additional windows to
display their entire functionality. The dialog box launcher icon will
open these windows. Contextual tabs will appear only when the user
needs them, such as when a picture is selected, or a table is inserted.

Check Your Progress – 1
1. __________ contains one–click buttons for saving, undoing, redoing,

and print previewing a document

2. The __________ displays the name of current document, and the
program.

3. The __________ interface is designed to help you quickly find the
commands that you need to complete a task.

4. The __________ is a new way to get assistance with specific tasks
in Word.

5 __________ will appear only when the user needs them, such as when
a picture is selected, or a table is inserted

1.3 Entering and Editing Text :
Microsoft Word is a word processor software application used to

create, modify, and share documents. When Word is started, the user has
the option of modifying a pre–developed template or creating a blank
document. Users begin by entering data at the existing insertion point
identified by the I–beam pointer (cursor). As the user types text into the
document, Word will word–wrap the data when encountering the right
margin, and continue the text on the following line. The user only needs
to press [Enter] when it is desired to start a new paragraph or insert a blank
line.

Line spacing is the space between each line in a paragraph. By default,
the line spacing within a paragraph in Word is 1.15 lines, and the end of
a paragraph is followed by a blank line. While the default spacing may be
appropriate for some documents, other situations might require different
settings. For example, this paragraph is using 1.5 line spacing, which can
be adjusted by clicking the option encircled below in the Paragraph group
from the Home tab. Other popular line spacing options include double and
triple–spacing.

Line Spacing

Line spacing is a popular option to adjust for various documents.
However, paragraph spacing is less well–known. Adjusting the spacing
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before and after paragraphs creates necessary white space to the document
more readable. Go to Page Layout and under Spacing, click the up or
down arrows to adjust the distance before or after the paragraph. Spacing
is measured in points. You can also type a number directly. This document
is currently using 8pt of paragraph spacing After each paragraph.

Paragraph spacing
While entering text, users encounter many automatic features as they

type, which include :

       Feature               How to Use

AutoComplete A ScreenTip appears you type. Pressing [Enter]
inserts the suggested text. Continue typing to reject
the suggestion.

AutoCorrect Commonly misspelled words and capitalization
mistakes are fixed based from Word’s dictionary.

Word Count Continually recalculates the total count in the Status
bar.

Spelling and Right-click red- or green-underlined text to reveal a
Grammar shortcut menu of correction options. Click an option

to accept and fix the text.

1.4 Spelling and Grammar :
In addition to the automatic spelling and grammar functionality, a

user can manually check their document, and utilize extra functionality. To
manually check the document for spelling and grammatical errors, the user
can use the commands found under the Review tab. The keyboard shortcut
to invoke this command is the [F7] key. In addition to the Spelling &
Grammar check, the user can also utilize the Thesaurus and Word Count
features to improve readability and accuracy. The thesaurus offers a
collection of synonyms that can replace words that are used too often. It
is a great tool for solving crossword puzzles! The Word Count is also
automatically updated on the status bar.

Spelling & Grammar
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Status bar

1.5 Selecting Text :

       Feature               How to Use
[Ctrl] + A Select all text in the document or all files

in File Explorer.

Click & Drag A very common, yet easily error-prone
way, by holding down the left mouse key
and dragging to select multiple characters,
words, or rows of text.

[Shift] + Arrow Position the cursor, and then click the
[Shift] key and use the arrows to select
one character at a time.

[Shift] + [Home] or [End] Position the cursor, and then click the
[Shift] key and the [Home] key to
select everything from the cursor to the
left margin. Conversely, the [End] instead
of the [Home] key will select everything
from the cursor to the right margin.

Double-click Selects the current word.

Triple-click Selects the entire paragraph.

Margin + click Selects an entire line of text.

Margin + click & drag Selects multiple lines of text.

Margin + double-click Selects an entire paragraph.

Margin + triple-click Selects the entire document.

Selection + [Ctrl]+Selection Selects two non-contiguous blocks of text.
Select the first range of text, then hold
down the [Ctrl] key, and select another
range of text.

Selecting Text
Aside from entering text, selecting text is probably the most common

task for most Word users. Almost every task begins by selecting something.
Perhaps that's why there are so many ways to select text ? The following
list is not comprehensive.

1.6 Cut, Copy & Paste :

Editing a document often requires moving and duplicating text from
one location to another. The process of moving text is commonly referred
to as cut and paste. When data (text, files, graphics, etc.) is cut, it is removed
from the document and placed into
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Paste Options

temporary memory in the Clipboard. The Cut process can be
performed via the scissor's icon on the ribbon, using the right–click shortcut
menu or using the keyboard equivalent [Ctrl] + X. To paste the recently
cut data, position the cursor in the desired location, and then choose Paste
from the ribbon, shortcut menu, Paste Options screen tip, or the [Ctrl] +
V keyboard shortcut.

The Copy process can be performed to create duplicate data via the
Copy icon on the ribbon, using the right–click shortcut menu or using the
keyboard equivalent [Ctrl] + C. The paste process is the same regardless
if the prior process is the Cut or Copy option. The paste process offers the
paste options menu to allow the user to Keep the Source formatting, Merge
the formatting from the source into current document, Keep the Text Only,
or paste a picture of the selected data, instead of text. Data can be copied
or moved within a document, between multiple documents or between
multiple programs. This is a great example of how Microsoft Office is a
suite of software applications that use common features to integrate data
from one software application to another.

1.7 Saving Files :
Once a document has been created, it should be saved as a file for

future retrieval. The process of saving a Word document requires two
essential elements: giving the document a filename, and defining the
location where the file will be stored. The save process can be initiated by
clicking the Save icon on the Quick Access toolbar, choosing Save or Save
As from the File menu or using the keyboard equivalents, [Ctrl + S] for
Save or [F12] for Save As. The filename should be a unique, yet identifiable
description of the file's contents. The filename extension (.docx) is
automatically added to filenames in Word. Once saved, the title bar will
update with the new file name. The location of the file should also be given
careful consideration. The user will likely choose between saving the file
to the hard drive of the computer they are using, or using cloud–storage
to make the file more easily accessible from multiple devices. The Save
command < will overwrite the existing file, while the Save As command
will allow the user to change the filename or file location.

1.8 Finding and Replacing Text :
A document can be automatically searched for a specific character,

word or phrase. Choosing the Find command on the Home tab will open
the Navigation pane where search text can be entered. Matches will be
displayed in the pane and highlighted in the document.
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Similarly, the Find and Replace feature allows users to make mass
edits to a document. For example, a user might want to substitute the words
teacher with trainer throughout a long document. Using the Replace
command found in the Editing group of the Home tab, a user can choose
to find and review or replace each occurrence individually or replace all
occurrences in one step.

The Advanced Find features are similar to the Find and Replace
Search Options. To make the search more specific, Word allows users to
define criteria, such as Match case or Find whole words only. These options
will narrow the scope of returned results. For example, with the Match case
check box selected, the text Mark will not be found if the word mark is
entered as the search criteria. Conversely, the use of Wildcard characters
will increase the search results. An asterisk character will allow any
characters to be substituted. Therefore, check* will find checks, checked
or checking.

1.9 Creating Bulleted and Numbered Lists :

Formatting a list with bullets or numbers can help to organize the
logic of a document. In a bulleted list, each item is a separate paragraph
formatted with a hanging indent, a bullet (•), and a tab. The bullet character
can be formatted to represent other symbols, such as check marks, squares
or other symbols from the bullet library or custom–defined new bullets.
Formatting a list with bullets adds emphasis, but not priority. Each bulleted
item is considered of equal importance, such as a grocery list. Conversely,
a numbered list shows a priority or sequence. A typical recipe helps
illustrate this difference :

Bullets and Numbered Lists
The ingredients and supplies are listed using bullets, because there

is no distinction in their priority. However, the instructions utilize a
numbered list, because the sequence is crucial to the process.
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Bullets & Numbering Ribbon
To create a bulleted or numbered list, first select the paragraphs of

text, and the select the appropriate option from the Home tab on the ribbon.
Click the Increase Indent or Decrease Indent commands from the Home
tab to format the list appropriately. To remove the bullets or numbering,
place your cursor in the list and re–click the Bullets or Numbering
command.

1.10 Inserting Symbols :

Unique characters that don't exist on your computer keyboard can be
inserted into your document by selecting the  Symbol option from the
Insert ribbon. Special characters such as the degree (º) or trademark (™)
symbols can easily be inserted from the Symbol dialog window. Other
popular symbols include graphics, shapes, and foreign language characters,
such as the (é) used in the word résumé, which is a different word than
résumé.

Symbol dialog

In the Symbol dialog window, different sets of symbols will appear
when different Fonts or Subsets are selected from their respective list
arrows. The Webdings or Wingdings fonts offer a variety of graphics that
can be inserted into paragraphs or as bullet shapes.

1.11 Inserting and Modifying Graphics :

It is said that a picture is worth a thousand words. This could be
because graphic images make a document more interesting. You can insert
photos from your computer or the web, edit them, compress them, resize
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and re–position them. Word offers a variety of graphics (from the Illustrations
group of the Insert ribbon) that can be inserted into documents to add
pizzazz to an otherwise dry document.

Illustrations group
A word–processing application differs from a text editor in part due

to its ability to perform basic graphic design functionality. As shown in this
textbook, the author has inserted graphic screenshots via the Pictures button
on the Insert tab. Pictures and Online Pictures only differ by where the
source files reside. The Pictures option will allow you to insert local
pictures that reside on your local device. Conversely, Online Pictures allows

Online Pictures

the user to insert images from the Internet using Microsoft's Bing search
engine or OneDrive, provided you have a OneDrive account set up. When
inserting graphics obtained from the Internet, keep in mind that using
someone else's work without their permission is not only wrong but also
may be illegal. US Copyright laws control how a copyrighted work can be
used. Consider either using public domain images, which are free to use,
or images distributed under a Creative Common license, which generally
are free, as long as you provide attribution to the owner.

Most of the images inserted via the Pictures and Online Pictures
features are likely to be photos. Nonetheless, other common graphics
include clip art, scanned artwork, and shapes. Clip art differs from photos
when the images consist of simple illustrations. This results in flexible file
formats and small file sizes, which explained the appeal to early desktop
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publishers. However, increased computing resources have marginalized the

Clip art example

benefits of clip art, and the rich quality of photos have diminished their
demand. The once popular clip art option is hidden behind the Online
Pictures feature. The keyword that is entered into the search box will, by
default, retrieve photos, clip art, and other images. However, the filter

option, which appears once the original results appear, can further restrict
the results to only clip art images, or other image types, specific sizes.
layouts or colors.

A complete array of built–in shapes can be inserted to complement
existing graphics. Popular shapes include lines, rectangles and flow chart
symbols. Once a shape is selected, the user needs to draw it on a blank
area of the document. Once inserted, the shape, like any other graphic
object, can be resized and re–positioned. To move the image, hover the
mouse over the image until the pointer is the four arrows, then click

Graphic Editor
and drag to your desired position. To resize a graphic, select the image and
drag a corner sizing handle to resize it proportionately. The top/bottom or
side handles allow the user to resize the graphic disproportionately. The
rotate icon allows the user to rotate the object up to ± 360º.

Once the graphic is selected, a new contextual tab called the Picture
Tools tab will appear on the ribbon. This tab will allow the user to make
a plethora of corrections and adjustments to the graphic. Picture styles,
effects, layouts, and the image size are common edits to the defaulting
graphic. To resize an image disproportionately, click the launcher icon in
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the bottom right corner of the Size group to open the Layout dialog window.
Now unmark the Lock Aspect Ratio checkbox.

Text Wrap

Perhaps the most common feature used in document layout
considerations is the Wrap Text feature. By default, when pictures are
inserted into a document, their layout is set to In Line with Text. This leaves
a lot of unnecessary white space to the right of the image. To wrap text
around a picture, select the picture, and then select a wrapping option (as
shown in the image to the right of this paragraph). Popular options include
Tight or Square.

1.12 Utilizing WordArt and SmartArt :

Another desktop publishing tool that adds pizzazz to a drab document

is the use of WordArt or SmartArt. WordArt is a drawing object with
special effects that change the appearance of text by formatting special
shapes, patterns and orientations. WordArt can be used to add color, outlines
and 3–D effects to regular text. Common usage is titles for papers, posters
or other marketing materials. Click the WordArt button in the Text group
of the Insert tab. After selecting an initial WordArt style, a placeholder box
will appear and await your input of text.
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Once inserted, a contextual tab offers numerous to change the effects
of the WordArt object. Additional formatting options available include
change the text fill, outline or text effects of the WordArt object. The Text
Effects offer some exciting ways to rotate and transform the text. The best
way to learn about these features is to experiment with them!

SmartArt are diagrams that illustrate concepts and show relationships
between elements. Think of SmartArt as pre–made drawing canvases that
you can insert into your document and then customize as you see fit. There
are a variety of styles to choose from, which you can use to illustrate many
different types of ideas. Simply pick an arrangement, such as a list, process,
cycle, etc. Insert the SmartArt via the Illustrations group on the Insert tab,
which opens the SmartArt dialog window.

After choosing a layout, a SmartArt placeholder will appear. In a
SmartArt graphic, elements are represented by shapes. Each shape can have
text applied, be resized and re–positioned. You can even add, delete,
promote and demote shapes via the text pane or the contextual tab.

SmartArt dialog
A SmartArt graphic can be formatted and edited using options on the

contextual SmartArt Tools Design and Format tabs. The Design tab allows
the user to pick from numerous layouts, styles and colors. The Format tab
provides choices for shape styles and WordArt options. SmartArt can be
utilized throughout the Microsoft Office suite of applications. Again, the
best way to learn about these options is to experiment!
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SmartArt pyramid

1.13 Inserting and Modifying Hyperlinks :

A hyperlink, often referred to simply as a link, is text or a graphic
that, once clicked, "jumps" to a different location in the file or to a different
software program. Software programs include e–mail applications, web
pages or an external file, often created in Microsoft Office programs like
Excel or PowerPoint. There are a few ways to insert a link into your
document. Depending on how you want the link to appear, you can use
Word's automatic link formatting or convert the text or graphic into a link.
The fastest way to create a link in a document is to press ENTER or the
SPACEBAR after you type the address of an existing webpage, such as
www.baou.edu.in Word automatically converts the address into a link. The
same result occurs if the user were to enter an e–mail address, such as
student@baou.edu.in Hyperlinks have two parts: the address (URL) of the
web page and the display text. In the two previous examples, the URL
matches the display text, however it is possible to create a link to any word,
combination of words, or an object, such as a picture or shape.

Insert Hyperlink
To create a link on a specific word or object to a web page, start by

selecting the word(s) or object, and then click the Link button in the Links
group of the Insert tab to open the Insert Hyperlink window. In the
illustration below, a link is being defined to go to Microsoft's website for
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the Word program. The text "Word" appears as the Text to display so that
once the link is created, this text will appear with the hyperlink attributes,
which are typically blue and underlined. The Address field contains the
URL to the specific web page destination that will open in the current
device's default browser application. The Insert Hyperlink window fields
will change significantly if the Link to: open on the left side is changed
from Existing File or Web Page to another option. To follow a hyperlink
in Word, hold the Ctrl key and click the linked text or object.

1.14 Borders and Shading :

Borders add interest and emphasis to your document. Borders make
attractive frames for text, pictures, tables, or entire pages. You can
customize borders to complement your document by experimenting with
Word's built–in styles. To add a border to text, select the text. On the Home
tab, click the small down arrow next to the Borders button, and choose
an option OR choose the Borders and Shading option to open the Borders
and Shading dialog window.

Make sure the Apply to box is set to Text, which adds a border around
lines of text, or Paragraph, which creates a border that outlines the
paragraph. Also make sure that a choice, like Box, is selected under the
Setting option.

Shading is the color or artistic design you use as background for a
paragraph. By shading words or paragraphs in Word, you can create visual
interest in a document. The Highlight command offers a more limited color
selection, which you can use when you review or edit a document to
highlight specific text. The shading fill, style, and color can be defined from
the Shading tab of the Borders and Shading window. To apply shading to
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a part of a document, select the data, then click the arrow next to Shading,
and under Theme Colors, click the color you want to shade your selection.

Shading palette
Borders can also be added to pictures. Just select the picture, then

choose a pre–formatted border from the Picture Styles gallery off of the
Picture Tools Format tab.

To remove the paragraph borders and/or shading, choose the None
option in the Borders and Shading window. In the Shading tab choose the
No Color item in the Fill section, and choose the Clear style in the Patterns
section.

Check Your Progress – 2
1. __________ is short cut key for copy.

2. __________ is short cut key for paste.

3. __________ is short cut key for Cut.

4. __________ is short cut key for selecting all text.

5. __________ is short cut key for Spelling and Grammar Checking
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1.5 Let Us Sum Up :
In this unit we have learn about how to Create a file in Microsott

Word and format it. We understand the functions of different Microsoft
Microsoft Word Interface, Perform Spelling and grammar checking, Selecti
text, Cut, copy and paste, Find and replace text, Create bulleted and
numbered lists, Insert symbols, graphics and Hyperlink and how to utilize
WordArt and SmartArt

1.16 Answers for Check Your Progress :
Check Your Progress – 1

1. Quick Access toolbar 2. Title bar 3. Ribbon

4. Tell Me tool 5. Contextual tabs

Check Your Progress – 2
1. Ctrl+C 2. Ctril+V 3. Ctrl+X 4. Ctrl+A 5. F7

1.17 Glossary :
Word processing : Word processing describes creating or editing a

document using a word processor, such as Microsoft Word, Google Docs,
or OpenOffice Writer.

Ribbon : The Ribbon interface is a set of toolbars at the top of the
window in Office programs designed to help you quickly find the
commands that you need to complete a task.

Symbol : Unique characters that don't exist on your computer
keyboard can be inserted into your document by selecting the ? Symbol
option from the Insert ribbon.

WordArt : WordArt is a drawing object with special effects that
change the appearance of text by formatting special shapes, patterns and
orientations.

SmartArt : SmartArt are diagrams that illustrate concepts and show
relationships between elements.

Hyperlink : A hyperlink, often referred to simply as a link, is text
or a graphic that, once clicked, "jumps" to a different location in the file
or to a different software program.

Shading : Shading is the color or artistic design you use as
background for a paragraph.

1.18 Assignments :

• What is a word processing ?

• Explain basic components of Microsoft Word Interface

• Write note on features of word processing

1.19 Activity :

• Discuss Advantages of Word Processing
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1.20 Case Study :
• Find and Study some Free and Open Source Word Processing

Software

1.21 Further Reading :
• https://open.umn.edu/opentextbooks/textbooks/business–computers–

365–lacher

• Information Systems for Business and Beyond, David T. Bourgeois
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2.0 Learning Objectives :
After studying this unit learner should be able to :

• Define font and text attributes

• Set paragraph alignment and hyphenation

• Utilize the Format Painter

• Indent paragraphs

• Set tabs and tab stops

• Create and format tables

• Insert headers and footers

• Set page orientation and margins

• Create and insert citations and bibliographies

• Print and save files in alternative file formats

2.1 Introduction to Defining to Font and Text Attributes :

The way text appears on the screen or a page is referred to its format.
Formatting text can enhance the appearance of a document, create visual
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impact, and help illustrate a document's structure. Font, size, and style
define a character's format. A font is a complete set of characters with the
same typeface or design. Dozens of fonts are available in the Font drop
down list. Users can easily format text with fonts, colors, styles, and other
formats by selecting the text and clicking various commands in the Font

or Paragraph group on the Home tab. The Mini toolbar, appears faintly
above text when you first select it, and includes the most commonly used
formatting commands. The table below describes the functions of each
button on the mini toolbar.

Formatting Buttons

Here are a couple of best practices when utilizing fonts. First, avoid
using too many fonts in the same document. More than two or three fonts
in the same document becomes distracting. Secondly, legibility and readability
should be primary considerations. This should factor in the reader's
characteristics, and the purpose of the document. For example, while the
default size for a font is 11pt, a larger size font (i.e. 14pt) might be more
appropriate for an older aged reader. A pt (or point) is the equal to 1/72
of an inch. Headings and titles deserve larger font sizes. However, it is also
good practice to limit the quantity of font sizes used in a single document.
Lastly, consider using common fonts for professional and business documents.
Calibri, Arial, Verdana and Times New Roman are ranked highly by
Monster.com as preferable fonts for résumés, whereas Comic Sans is not
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recommended. Note that Calibri is only available on Windows operating
systems, whereas Arial, Verdana and Times New Roman are some of the
cross–platform available fonts.

2.2 Setting Paragraph Alignment and Hyphenation :

Paragraph alignment determines how the edges of each paragraph
aligns with the left and right margins. Alignment settings apply to all text
within a paragraph. Remember that a paragraph is created each time the
user presses the Enter key. To display the hidden characters, including
paragraph marks, press the  symbol in the Paragraph group of the Home
tab. Press the button again to hide the formatting marks.

Paragraph Alignments
• Left–aligned text is the default paragraph format. The left edge of the

paragraph is flush, and the right edge is jagged. This option is typical
for letters and reports.

• Centered text is equally distant from the left and right margins.
Common uses are titles and headings.

• Right–aligned text is flush with the right edge, and the left edge is
jagged. Typical uses are dates or headers and footers.

• Justified–aligned text spreads the text evenly between the left and
right margins, leaving both edges flush, unless the final line has
limited characters. This option is common for newspaper columns
and textbooks.
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Hyphenation can improve the overall readability of certain documents.
Hyphenation is the process of adding hyphens to words at the beginning
of lines so the hyphenated part will fit at the end of the previous line. The
hyphens are inserted between syllables in a word. Word can automatically
hyphenate your document for you, or you can use the hyphenation tool to
manually hyphenate your document. Users can customize their hyphenation
settings via the Hyphenation Options dialog window. Use caution when
manually inserting hyphens, because the hyphen will always remain even
if editing moves the word to the middle of a line, and results in the word
no longer needing hyphenating.

2.3 Utilizing the Format Painter :
The Format Painter tool allows the user to copy a format from

selected text and apply the format to other selections. For example, if you
have inserted text in Word, and have it formatted using a specific font type,
color, and font size, you could copy that formatting to another section of
text by using the Format Painter tool. Select the text or place your cursor
in the paragraph that contains your source formatting, then click the Format
Painter tool  from the Home tab's Clipboard group. The cursor will

change to include a paintbrush , which indicates that the user can now
select the destination text that should receive the source formatting. If
multiple areas of text need the same formatting, the user should double–
click the Format Painter tool to be able to apply the formatting to multiple
selections, until the user presses the Esc key. The Format Painter tool works
similarly in Excel and PowerPoint too.

2.4 Indenting Paragraphs :
Indenting a paragraph results in moving the editable insertion point

from the left or right margins. Users can indent the left or right edge of a
paragraph, just the first line, or all lines except the first line. Paragraphs
are indented relative to the page's margins, and indenting a paragraph
doesn't affect the paragraph's alignment. The default indents are 0 inches,
meaning that lines of text extend from the left margin to the right margin.
Indenting paragraphs can be performed by pressing the Decrease Indent or
Increase Indent buttons on the Paragraph tab of the Home tab. Alternatively,
to make precise changes to the Left and/or Right Indents or Paragraph
Before/After Spacing, utilize the Paragraph group of the Layout tab. Indents
are measured in inches and Spacing is measured in point, much like font
sizes.
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A semi–block letter style requires the first line of each paragraph to
be indented from the left margin, which is known as a first–line indent.
Precise indent definitions can be specified in the Paragraph dialog window
which can be opened by clicking the Launcher button in the Paragraph
group. Alternatively, indents can also be set by dragging the markers on
the ruler :

Indent Ruler Markers
A first–line indent requires the user to drag the marker on the ruler

to the position where the first line of the paragraph should begin. Typically,
this is the .5" mark, which can also be accomplished by pressing the Tab
key to indent the first line to the default .5" tab stop. A hanging indent
occurs when the subsequent lines of a paragraph are indented more than
the first. Hanging indents are often used when manually creating citations
in a bibliography. To create a hanging indent, drag the marker on the ruler
to the right. When citing long quotations in a research paper, users typically
use both a left and right indent to offset the quotation, as shown below.
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2.5 Setting Tabs and Tab Stops :
Tabs allow users to align text vertically at a specific location in a

document. A tab stop is a point on the horizontal ruler that indicates the
location at which to align text. A tab stop is a location where the insertion

point will stop when the user presses the  key. Tab stops can be

used to help align text to create columns of data. Custom defined tab stops
are displayed on the ruler above the document. A set of default tab stops
are located every half inch, but they do not appear on the ruler. When a
new tab stop is defined, Word automatically removes the default tab stops
to the left. Using tabs, users can align text to the left, right, or center of
a tab stop, or text can be aligned at a decimal point. Word stores paragraph
formatting, such as tab stops, in the paragraph marks at the end of a
paragraph. Therefore, when the user pressing the ENTER key, tab stops are
copied to the next paragraph. The same tab stops can then be used in
sequential paragraphs to create columns of text. Tabs can be set by clicking
on the horizontal ruler, or by using the Tabs dialog window. The following
icons represent different tab stops on the horizontal ruler :

Each type of tab stop is used in the example shown below. Note the
markers on the ruler :

Inserted Tab Stops
The default tab stop is Left, but tab stops can easily be switched by

multi–clicking the tab selector  on the horizontal ruler. Existing tab stops
on the ruler can be dragged to a new position if needed. To remove a tab
stop, drag the tab stop off the ruler and release the mouse. The text will
realign itself to the existing tab stops. Once the tab stops are in set, newly
inserted text will align to the stops when the tab key is pressed. Alternatively,
some users prefer to enter text with tabs, but without tab stops, and then
apply the tab stops to the existing text.
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The Tabs dialog window is useful for adding new, and editing
existing tab stops. The window can be opened by double–clicking an
existing tab stop or by clicking the Tabs… button in the Paragraph Dialog
window, which is opened from the Paragraph Launcher button. The Tabs
window is useful for precise position definitions, and it is the only option
for adding Leaders to tab stops. A tab leader is a character that is repeated
to fill the space spanned by a tab. The dotted leader is very commonly used
on menus to make it easier to associate the menu description with its
correlating price. The Tabs window is also a convenient way to clear one
or all tab stops in a document.

Tabs Dialog

2.6 Creating and Formatting Table :

A table is a great way to organize information within a document.
A table is a grid of cells arranged in rows and columns. Tables can be used
to organize any type of content, whether you're working with text, graphics
or numerical data. Unlike tabs, table cells can have headers (in bold), as
well as borders or boundaries, which make the information easier to read.
A table typically includes headings that identify each column or row that
contains data. The following is a 5×3 table, which means it has five
columns and three rows.

Sample Table
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To create an empty table, click Table from the Insert tab, and move
the cursor over the grid to select the number of cells for the table. Click
the grid to create the table and then type text into the individual cells. Word
automatically adjusts the column widths to be equal so that the table fills
the space between the left and right margins. To manually adjust the width
or height of a cell, drag the border. Press the Tab key to move from cell
to cell. If the insertion point is in the last cell, pressing the Tab key will
automatically add a new row.

If the number of rows and columns you create turns out to be different
than what is needed, you can easily add or delete rows and columns via
the Table Tools Contextual tab. The Layout side of this contextual tab will
also allow the user to change cell size, merge & split cells, sort table data,
change text alignment, and modify table properties.

The Table Tools Design tab offers additional functionality to modify
Word tables. Design elements include defining Table Style Options, like
Header and/or Total Rows, selecting from a gallery of Table Styles, as well
as adding shading and borders. You can easily insert and delete table rows
and columns via this tab as well.
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It is possible to create a table from text that already exists. However,
the data must be consistently separated, field–by–field, using a delimiter.
A delimiter can be tabs, paragraphs, commas or some other user–defined
character which is used to separate each field. With the cursor residing
inside the existing source data, select the Convert Text to Table… option
from the Table tab of the Insert ribbon.

Clicking an option from a menu that ends with the ellipsis notation
(…) indicates that a dialog window will appear. The Convert Text to Table
dialog window allows the user to define the table size, AutoFit behavior,
and the delimiter.

The contents of the rows in a table can be sorted based on a column.
Users can sort in alphabetic (text), numerical (numbers), or chronological
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(dates) order using either Ascending (A  Z) or Descending (Z  A)
manner. Clicking the Sort button on the Table Tools Layout tab will open
the Sort dialog window.

The Sort by options will be the column headers, or Column 1, Column
2, etc. if there is No header row. The first sort selection is known as the
primary sort, followed by the secondary, and tertiary sort options. The Type
drop–down list will offer the choices of Text, Number or Date, depending
on the existing table data. Make sure to choose either Ascending or
Descending for each sort level.

2.7 Inserting Headers and Footers :

A header is the area at the top of a page, and a footer is the area at
the bottom of a page. Headers and footers consist of one or more lines of
text, page numbers, graphics, and other fields, such as the file name,
document title, current date and/or time, or author's name. To create a
header or footer, click either the Header or Footer drop down list from the
Insert ribbon.

Header Gallery
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A gallery of built–in designs is displayed. Clicking a built–in design
makes the header or footer the active area of the document, while the body
of the document fades to the background. A header or footer has three
sections: left, center, and right. The user can either type text into existing
placeholders, or insert fields from the Header & Footer Tools Design
contextual tab, which only appears when the cursor is placed in either the
header or footer.

To return to the body of the document, double–click in the document
body, or click the Close Header and Footer button on the Header & Footer
Tools Design tab. Double–click in the header or footer area to make it
active and allow for editing.

The header or footer is printed on each page of the document. To
specify a different header and footers for the first page, select the Different
First Page checkbox on the Options group of the Header & Footer Tools

Header Footer Tools Tab

Design tab. Any existing header or footer will automatically be
removed. A different first page is common in long documents to prevent
the cover page from including the headers and footers contained in the rest
of the document. A cover page usually does not include any header or footer
data.

One of the most common purposes of headers and footers is to
include page numbers. Page numbers are helpful in documents that have
more than one page. To add a page number at the current location in an
existing header or footer, click Page Number > Current Position, and then
choose a style from the gallery of choices. Scroll through the list of style
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options in the gallery to find one you like. You can select a plain number
style, or a Page X of Y style to get a more defined starting and ending
number (Page 1 of 7) format. Experiment to find the style that best meets
your needs.

An inserted page number can be further formatted as needed. Number
formatting and different starting page numbers can be defined in the Page
Number Format dialog window, which is opened when the user selects
Format Page Numbers…. from the Page Number drop down list. Number
formats include Arabic, alphabet, and roman numeral formats.

The Page numbering options allow a user to restarting the page
numbers at a user–defined number. This can be useful to recognize
unnumbered pages that precede the main part of the document.

In the Position group, you can control the amount of space allotted
to the header and footer. By default, each is 1/2–inch tall. Users can change
these values in the Header from Top and Footer from Bottom list boxes.
Manipulating these selections will affect the printable area of the document's
margins.

It is a "best practice" to add page numbers before adding other header
and footer fields, because any existing text will be replaced by adding page
numbers using the Insert > Page Number process. Alternatively, users can
add page numbering to existing header and footer text through the Quick
Parts feature, which is not explained in this text. Other than page numbers,
headers and footers often contain the document's author, date and/or title.
Each of these fields help identify the document, particularly when the
document is printed and compared with other similar documents.

2.8 Setting Page Orientation and Margins :

The page setup of a document includes settings such as margins,
orientation, and other pagination settings. These settings can be applied to
the entire document, or specific sections, which can be created by inserting
section breaks (not explained in this text). The Page Setup group found
under the Layout tab contains these selections.
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Page orientation refers to how a rectangular page is arranged for
viewing.

The orientation of a Word document can be either portrait or
landscape. Portrait orientation is taller than it is wide (vertically), and
landscape orientation is wider than it is tall (horizontally). The default
orientation is portrait.

Choosing a page orientation needs to consider the paper size selected
for the document. The standard paper size in North America is called Letter,
which has the dimensions of 8.5" x 11". Legal documents are 14" instead
of 11", which means when printed in portrait orientation, legal documents
are three inches longer (and a pain to fit in a standard folder!). The standard
paper size in Europe is known as A4. Its dimensions are 210mm x 297mm,
which is closer to the Legal size, than the Letter size. Many posters and
tables are often printed on Tabloid sized paper, which is 11" x 17".
However, since a lot of home printers cannot accommodate this size of
paper, many users choose to change their orientation to landscape, which
changes the printable width to 11", and the printable height to 8.5". If
adjusting the orientation doesn't solve the layout challenges of the document,
consider adjusting the margins!

Margins are the white space surrounding the text on a page. Margins
can be specified for the top, bottom, left and right edges of a document.
The default margins are 1" each, but margins can easily be adjusted from
the pre–set choices in the Margins drop–down list, or by manually
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adjustments in the Page Setup window, which can be opened by clicking
the launcher button in the Page Setup group in the Layout tab. Narrow
margins leave more room for more data, while wider margins decrease the
amount of printable space. Similarly, larger top and bottom margins
decrease the available space. If adjusting orientation and margins aren't
enough to resolve page formatting, consider using page breaks.

Pagination is how a document is divided into pages. Word automatically
determines how much text will fit on a page based on the amount of text
and the document formatting. As new data is added to a page, Word creates
automatic page breaks, also known as soft page breaks. To force data to
a new page, a user can insert a manual (hard) page break. Inserting a page
break moves the text after the insertion point to the next page. To insert
a page break, press Ctrl + Enter or click Page Break from the Insert tab.
To remove manual page breaks, utilize the Show/Hide button to display
formatting marks, such as the Page Break mark :

To remove a hard page break, place the insertion point to the left of
the page break and press the Delete key. Word will re–paginate itself, and
move data to the previous page.

2.9 Printing and Saving Files in Alternative File Formats :

Before printing a document, it is a good idea to preview the document
and specify which pages should print. The preview might help the user
discover some layout issues that can be addressed before wasting ink/toner
and paper. The Print Preview window can be accessed in Backstage view
by clicking File > Print. It is also a popular idea to add the Print Preview
command to the Quick Access toolbar if it doesn't already exist.

Print Preview
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Numerous options can be defined in Backstage view, such as which
printer, how many copies, which pages, etc. Once these decisions are made,
pressing the big Print button in the top left of the window, will send the

data to the selected printer. The back button  will exit Print Preview..

If printing a hard copy is not desired, saving the file is the obvious
alternative. The way that the user saves a document and the format that
they save it in depends on how they plan to use the document. While
choosing Save from the File menu will resave the file in its existing format,
choosing the Save As command (F12) provides numerous alternatives.

The first option available by using the Save As dialog window, is the
ability to choose an alternative storage destination versus the existing
location. Alternate storage destinations include a different file folder on the
user's hard drive, a portable file storage location, such a USB drive device,
or a cloud–based storage location. OneDrive is Microsoft's cloud–based
storage option, but other cloud–based solutions, such as Dropbox, exist as
well. Cloud computing requires Internet–connectivity to access the current
versions of the files. An alternative file format is another option to consider
from the Save As window. Choosing the drop–down list to the left of the
Save button displays a list of alternative file formats.

One of the most common alternative file formats is a PDF (Portable
Document Format) file. PDFs are popular formats to share with non–
Microsoft Office users, commercial printers, and users for whom the
document is not to be edited. The PDF format looks the same on most
computers, has a smaller file size, and preserves most formatting
characteristics of the source document. The only software that is required
to read or print a PDF file is Adobe Reader, which is available as a free
download from Adobe's web site. While prevention of editing was a key
feature of PDF files, the current version of Word can actually edit PDF files,
however, the edits are traceable.

The other common file format is saving a file to be viewed on a web
site or simply in a web browser. Saving a file as a Single File Web Page
is the optimal approach to allow users to open the document using a web
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browser. The file extension of a single file web page is .MHT. Other
occasionally used file formats include: .XPS, .ODT, and RTF.

Check Your Progress :
1. A _________ once clicked, "jumps" to a different location in the file

or to a different software program.

2. A _________ is a complete set of characters with the same typeface
or design.

3. A pt (or point) is the equal to _________ of an inch.

4. _________ tool allows the user to copy a format from selected text
and apply the format to other selections.

5. _________ occurs when the subsequent lines of a paragraph are
indented more than the first.

6. _________ allow users to align text vertically at a specific location
in a document.

7. _________ is a grid of cells arranged in rows and columns.

8. _________ can be tabs, paragraphs, commas or some other user–
defined character which is used to separate each field.

9. _________ refers to how a rectangular page is arranged for viewing.

10. _________ are the white space surrounding the text on a page.

11. Inserting a _________ moves the text after the insertion point to the
next page.

12. The _________ format looks the same on most computers, has a
smaller file size, and preserves most formatting characteristics of the
source document.

2.10 Let Us Sum Up :
In this we have leaned about how to define font and text attributes

and set paragraph alignment and hyphenation, how to utilize the Format
Painter and Indent paragraphs. We have also learned about setting tabs and
tab stops, create and format tables, insert headers and footers and set page
orientation and margins and how to print and save files in alternative file
formats.

2.11 Answers for Check Your Progress :
1. Hyperlink 2. Font 3. 1/72

4. Format Painter 5. Hanging indent 6. Tabs

7. Table 8. Delimiter 9. Page orientation

10. Margins 11. page break 12. PDF

2.12 Glossary :

Format : The way text appears on the screen or a page is referred
to its format.

Header : A header is the area at the top of a page.
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Footer : A footer is the area at the bottom of a page.

Format painter : The Format Painter tool allows the user to copy
a format from selected text and apply the format to other selections.

Tab : Tabs allow users to align text vertically at a specific location
in a document.

Hyphenation : Hyphenation is the process of adding hyphens to
words at the beginning of lines so the hyphenated part will fit at the end
of the previous line.

Table : A table is a grid of cells arranged in rows and columns.

Indenting : Indenting a paragraph results in moving the editable
insertion point from the left or right margins.

2.13 Assignment :

• Write short note on Table in Microsoft Word

• Explain options available for page setup

2.14 Activity :
1. Create a 2 x 9 table

2. Add and format data to table as shown below

3. Add a new column to the table to the left of the Name column. The
header should be Proximity to the Sun. The data should be 1, 2, 3
…. 8.

4. Sort the table in descending order by Number of Moons.

5. Apply the table style to the table.

6. Add the file name field to the left side of the footer, and the Accent
Bar 2 page number to the center section of the footer.

7. Change the paper size to Legal.

8. Insert a page break before the paragraph beginning with The Dwarf
Planets.

9. Change the margins to the Office 2003 defaults.

10. Save the file with a new name.

11. Save another version of the file in PDF format.
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2.14 Case Study :
• Study the review tab of Microsoft Word

2.15 Further Reading :
• https://open.umn.edu/opentextbooks/textbooks/business–computers–

365–lacher

• Information Systems for Business and Beyond, David T. Bourgeois
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• Copy and Paste Formulas

• Add Basic Functions to Formulas

• Insert Headers and Footers
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3.1 What is a Spreadsheet ?

A spreadsheet is a collection of data that is organized into rows and
columns. Microsoft® Excel is a spreadsheet application used to store and
analyze quantitative data. An Excel file is called a workbook, and it is saved
with an .xlsx extension. A workbook file consists of one or more worksheets
which consists of many columns and rows. Columns are the vertical part
of a worksheet grid identified by letters. Rows are the horizontal part of
a worksheet grid identified by numbers. The intersection of a row and
column is called a cell. Each cell can store a single item of data. The data
can contain text, numbers, formulas, and/or functions. Clicking a cell with
the mouse pointer will make the selected cell the active cell. The active
cell's contents are displayed in the formula bar.

Typical uses for Excel include :
• Accounting reports (Balance Sheets, Income Statements, etc)

• Budgets

• Calendars

• Checklists and task lists

• Contact/Address lists

• Expense tracking

• Inventory control

• Invoices

• Mortgage and other financial calculations

• Operational statistics

• Sales price lists, forecasts and analysis

3.2 Entering Data :

Excel is great tool for generating useful information from data.
However, the data has to be entered before it can be analyzed and
manipulated. There are numerous types of data, and numerous ways to
streamline data entry. As data is typed, it appears in the active cell and in



MICROSOFT EXCEL
BASIC FEATURES

131

the formula bar. Pressing the Enter key will complete data entry and make
the next cell in the column the active cell. If moving to the next cell after
completing data entry is not the desired outcome, try clicking the Enter
check mark in the formula bar. The data will be entered, but the active cell
remains the current cell.

Pressing the Esc key before completing data entry will cancel data
entry and restore the original cell contents.

Streamlining data entry in Excel can be accomplished using several
different features including keyboard shortcuts and Automatic Completion.
Keyboard shortcuts allow rapid navigation in a worksheet without having
to use the mouse. There are hundreds of keyboard shortcuts available in
Excel and many are also available in other Microsoft Office applications.
A few keyboard equivalents are illustrated at right, but for more examples,
use the shortcut F1 to open the Help pane, and type keyboard shortcuts in
the Excel Help field.

When entering data into a sheet that contains a lot of duplicates,
Excel uses the Automatic Completion feature to speed up data entry. After
typing a couple of characters, Excel guesses how to fill the rest of the cell
based on data previously entered in the cells above. To accept the
suggestion (in highlighted text), press Enter, or alternatively, continue
typing to replace the automatic entry.
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3.3 Selecting Data :
After entering data, a common practice is to begin formatting the data.

However, before a user can format the data, they must first select the data.
Selecting data has multiple techniques based on user intent. Clicking on a
single cell makes that cell the active cell. The cell reference appears in the
Name box to the left of the formula bar. To select an entire column of data,
just click the column letter heading. To select an entire row, click the row
number heading. If a user wants to select several cells adjacent to each
other, this would be considered selecting contiguous cells. Clicking the
middle of the cell and dragging horizontally or vertically will select a
contiguous range of cells. Another way to select a contiguous range of
sequential cells is to click the first cell, hold down the Shift key, and click
the last cell in the range. For example, clicking cell A3, and then holding
down the Shift key and selecting F7 would select all of the cells from A3
through F7. The range reference would be written as A3:F7.

Selecting a non–contiguous range of cells requires the use of the Ctrl
key. To select non–contiguous cells, click the first cell, hold down the Ctrl
key, and click each additional cell. This practice is sometimes referred to
as "cherry–picking" cells. In the example below, the selected range of cells
are A4,A6,A7,F4,F6,F7. This practice can be used for selecting non–
adjacent rows or columns as well.

To select the entire worksheet, click the triangle box located to the
left of column A and above row 1, or by pressing the keyboard shortcut:
Ctrl+A.
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3.4 Inserting Data :
It is usually easy to add data to an existing worksheet, because Excel

has seemingly unlimited columns and rows of cells. (There are limits, but
this is not Jeopardy!) Nonetheless, sometimes it is necessary to insert a

column or row into the middle of an existing range of cells. To insert a
new column, select the column heading to the right of where you want the
new column to appear, and click the top–half of the Insert button from the
Home tab. Alternatively, just right–click the column heading to the right
of the destination, and choose Insert from the Context Menu. Deleting
columns is very similar. Whichever column(s) that are selected will be
deleted if using the Delete button instead of the Insert button. Inserting and
deleting rows is also very similar. Selecting the row below the intended
new row and either choosing Insert from the ribbon or from the Context
Menu will create a new row above the selection. For example, right–
clicking row 10, and choosing Insert from the Context Menu will create
a new, blank row 10, and all existing data will move down one row.

Using the right–click method is a little faster than clicking the
worksheet and then clicking the ribbon, as the shortcut menu avoids the
need to move the mouse to the ribbon. The Context Menu, also known as
Shortcut Menu, provides added functionality by offering actions that can
be taken with the selected item. In addition to inserting and deleting,
formatting column widths and row heights, as well as hiding and unhiding
columns and rows are options from the Context Menu. Adjusting the
column width is a common action since excessively wide columns prohibit
efficient worksheet printing. Therefore, it is often preferable to widen a
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column width by double–clicking the boundary bar that separates the
column heading letters. This is known as auto–fitting the column width
since the column will resize its width to be just wide enough to display the
longest data contained in that column. Clicking and dragging the double–
arrow pointer to the left or right allows users to manually adjust the column
width.

3.5 Manipulating Sheets :

An Excel workbook consists of one or more worksheets. Much like
a binder can have multiple sections of sheets divided by colorful tabs, an
Excel workbook can multiple sheets that can be re–arranged, colored and
renamed to fit individual organization plans. Inserting and deleting worksheets
is similar to the inserting of columns and rows. In addition to using the
Insert or Delete buttons from the ribbon, right–clicking an existing sheet
tab will produce a Context Menu with a plethora of options.

Just as inserting a new column will add the column to the left of the
selected column, the newly inserted worksheet will appear to the left of the
selected sheet tab. Options exist to insert a blank worksheet or a new sheet
based off of an existing template. Clicking and dragging sheet tabs are easy
method to rearrange the order of sheets. However, the Move or Copy…
command offers the opportunity to move or place a duplicate sheet within
an existing, open workbook. Adding tab colors and the Rename option can
help organize sheets to user–specific criteria. Sheets can also be hidden and
unhidden. If it is necessary to prevent others from unhiding sheets, the
workbook can be protected with a password to be able to modify the sheets.
The tab scrolling buttons to the left of the sheet tabs are enabled when too
many sheets exist to be displayed above the status bar. To quickly add a
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new, blank sheet to the workbook, click the plus button  to the right of
the sheet tabs.

3.6 Formatting Worksheets :
Formatting data generally makes it easier to comprehend, and more

attractive. The goal of formatting a business spreadsheet should be to make
it look professional, accurate, and understandable. Options to format
worksheet data depends a lot on the type of data. Formatting text in Excel
is very similar to formatting text in Word. Using the Font and Alignment
group icons on the Home tab of the ribbon, users can manually format all
of the data in a cell or in a range of cells. Changing default formats includes
things like changing the font color, style, size, text alignment in a cell, or
apply formatting effects – all in an effort to make the data appear more
visible.

Excel's tabular layout (organized into labeled columns and numbered
rows) sometimes limits the amount of data that can be efficiently displayed.
Using the Alignment group options can help format data to make it appear
as much like a word–processed report as possible. In the screenshot above,
two Excel–unique formatting features help make the data more readable.
In row 1, the text has been merged and centered across cells A1:F1. This
required the cell range A1:F1 be selected before clicking the Merge &
Center button from the Alignment group. This is very popular for
worksheet titles. If the wrong cell range was selected and the Merge &
Center is not effective, the user must re–select the Merge & Center button
to unmerge the data, so the correct range can be selected before again
clicking the Merge & Center button.

Another popular Excel text–formatting feature illustrated above is
the Wrap Text tool, which will prevent text from being truncated by
wrapping the text into multiple rows within the same cell. If a cell has a
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lot of text, the data will overlap into the next cell to the right of the active
cell. However, if the adjacent cell already has data, the text will be truncated
(cut–off) without applying this feature. Cells C3:E3 in the above screenshot
each have the Wrap Text feature applied.

While Excel has some pretty useful text–formatting functionality, the
majority of data entered into Excel is usually numerical data. Therefore,
utilizing Excel's number formats effectively is crucial to make the worksheet
as professional as possible. Professional formatting relies a lot on consistent
formatting. Therefore, using the Format Painter tool (introduced in the
Word chapters) and workbook themes are very helpful to maintain that
consistency. Changing the existing theme will dynamically update the
appearance of all worksheets in a workbook by modifying the fonts, styles,
colors and/or effects.

Applying the correct cell format to numerical data is more than just
style – it is substance too, because applying the wrong format can impact
how other, related cell results are interpreted. The following graphic
describes some of the more popular number formats. In addition to the
examples provided, there are also other formats, including date & time
values, which can be accessed by clicking the Number Format drop–down
list.

Changing the number of decimals displayed can be manipulated by
the Increase Decimal and Decrease Decimal buttons in the Number group.
The displayed value could change to a rounded value, however, the actual
value stored in the cell has not changed unless a ROUND function has been
applied. Formatting only affects how the value is displayed. Applying
formats can result in number signs (#####) being displayed in a cell. This
is not an error, but an indication that the cell width is not wide enough to
display the formatted number.

Excel data can also be formatted as a table. A table is a collection
of related data, organized into a tabular layout of rows and columns, that
can be manipulated via sorting, filtering and formulas. To create a table,
select the data and click Insert > Table from the ribbon to open the Create
Table dialog window.
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Table style Blue, Table Style Medium 16 with banded rows, a
header row, and filter buttons.

Applying a table style will format the table with a predefined set of
special table properties that includes options to define a header row or total
row, and to band the row and/or columns to make the data easier to read.
The filter buttons can also be removed. If the table functionality is no longer
desired, click the Convert to Range option in the Tools group of the Design
tab to convert the table to a normal range.

There are many additional formatting tools available within Excel,
but it is important to consider that sometimes, less is more! Too much
formatting can be overkill and reduce the readability of a worksheet. Try
to limit the use of multiple colors, fonts, and background colors/graphics.
Format with a design purpose, not to entertain, and don't forget to use the
Spell Check tool (F7) to proof your workbook before printing or sharing!

3.7 Creating Formulas to Perform Calculations :

Perhaps the biggest benefit of using Excel is its ability to create
formulas that, when written correctly, can dynamically update when
predecessor data is updated. Formulas are mathematical calculations using
data in the existing workbook to calculate new values. All formulas in
Excel must begin with an equal sign (=), and can contain cell references,
ranges of cell references, arithmetic operators, and constants as part of the
formula's syntax. Calculations in Excel follow normal math rules as it
pertains to the order of operations rule. There are mnemonics available in
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various dialects to help decipher the order. The following graphics illustrate
the order of operations rules and different formula syntax examples :

Formulas typically reference values stored in other cells. For example,
in the Accounting equation: Assets = Liabilities + Owner's Equity, one could
calculate the Owner's Equity using a formula. Assume that the value for
Total Assets resides in cell D30, and the value for Total Liabilities resides
in D60. The formula for Owner's Equity in D65 using cell references would
be =D30–D60. Using cell references is advantageous because if any of the
cells that generate either the Total Assets or Total Liabilities is changed,
the formulas in D30, D60 and D65 will also get updated. Another advantage
is when a cell containing a formula is copied to another location, the
formula will dynamically update to the new location's reference information.
This is called Relative Cell Referencing. If the formulas in column D are
copied to column E, the new formula for Owner's Equity in column E will
be =E30–E60. Additionally, if rows are added or deleted in the range that
the Total formulas reference, the formula will automatically update to the
new formula range.

Entering the syntax for a formula can be accomplished through typing
the formula components, using a pointing technique or a combination of
both. The pointing method can help avoid typing errors. In the Owner's
Equity example, the user would start by typing the equal sign, and then
instead of typing D30, just click on D30. Continue by pressing the minus
sign, and then click on cell D60, and the click the Enter check mark on
the formula bar. Using the point method is even more practical when
defining large cell ranges in formulas. Just make sure not to reference the
active cell in the formula. This will likely create a circular reference error,
which is a formula in a cell that directly or indirectly refers to its own cell.

3.8 Copying and Pasting Formulas :

Data in Excel can be cut, copied and pasted using similar shortcut
menu options, keyboard equivalents, and ribbon icon commands as seen in
Microsoft Word. Following operating system file management principles,
moving data is synonymous with using the "Cut" and "Paste" commands,
while duplicating data is the same as using the "Copy" and "Paste"
commands. Other terminology that should be recognized is "source", which
is the cell or range to be moved or duplicated, and "destination", which is
the upper–left cell in a worksheet where the data is to be pasted.

Copying and pasting formulas contain cell references is a very
powerful feature, and to expedite this process, Excel has a nifty feature
called AutoFill. The AutoFill procedure utilizes the fill handle, which is the
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solid, green square in the lower–right corner of the active cell or cell range.
Clicking and dragging the fill handle to adjacent cells (horizontally or
vertically) will copy and paste the contents and update the destination cells
with relative cell references or sequential data aligned with built–in Custom
Lists. This should save significant time, and likely improve accuracy, and
AutoFill has many uses. Not only can AutoFill copy formulas, but it also
be used to complete lists that have a recognizable pattern. It is helpful to
select the source cells that demonstrate a pattern, then hover the mouse
pointer over fill handle. The mouse pointer will change from the default

pointer icon to a thin, black plus sign. The patterns can be numbers, dates,
months, days of the week, etc. If AutoFill incorrectly guesses the series
pattern, the AutoFill Options icon is available to change the paste actions.
In the screenshots below, the fill handle in cell D5 will by copied to cells
D6:D13. The results shown in the second screenshot will update the
formula from D5 with relative cell references to rows 6:13. What is
happening in cells D7:D8 ?
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3.9 Adding Basic Functions to Formulas :
Excel contains over 400 built–in functions that can be included in a

formula to perform common calculations. A function performs a calculation
on data called arguments to compute a result. Arguments are variables or

values the function requires and are contained within parenthesis, and
usually consist of cell references, but can also contain constants, text, cell
ranges, and even other functions! The syntax of a formula using a function
is: function name (argument1, argument2, etc.) Functions can be typed with
the help of a ScreenTip, or added from the Insert Function window, which
can be opened by clicking the symbol found at the left of the formula bar,
or at the left side of the Function Library found in the Formulas tab of the
ribbon.

The most popular functions are also the easiest to comprehend, which
might be correlated! Some of these most popular functions are easily
accessible from the AutoSum button in the Editing group on the Home tab
of the ribbon. Look for the Greek sigma symbol. This feature is invaluable
when it comes to entering functions, especially for common calculations
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computed via the SUM, COUNT, AVERAGE, MAX or MIN functions.
There are multiple ways to utilize AutoSum, but the following procedure
is probably the simplest. In the screenshot below, assume the desire is to
total the number of boxes of Thin Mints cookies were sold the first 15 days
of February. Make B19 the active cell (the destination cell), then click the
AutoSum button. The defaulting SUM option will be inserted into the
formula bar with a defaulting cell range (the source cells) inside parenthesis.
The cell range that defaults appears on screen with a scrolling marquee
surrounding the cell range. This range is usually correct, but not always.
If Excel chooses the wrong range, simply type in the cell range, or use the
mouse to re–select the correct range (pointing method), and then click the
Enter check mark.

The formula that defaults should be =SUM(B4:B18). Once this
formula is submitted, the result, 97 will display. The intent of the SUM
function is pretty self–explanatory. The AVERAGE function takes the
SUM function one step further by dividing the sum of the values by the
number of cells in the range. The MIN and MAX functions are used to
find the smallest and largest values in a range of cells. These can be useful
to identify outlier data that might skew the results. Each of these functions
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ignore cells that contain text or are empty. Alternatively, the COUNT
function totals the number of cells that contain values. If a cell contains
the value 0 (zero), it will be counted. However, if the cell is blank or
contains the text zero, the cell will not be counted. This function is useful
for determining the number of people who mark a checkbox in an Employee
roster. For example, how many employees identify as a Veteran ? Those
who don't, wouldn't have a value, and therefore, would not be counted. If
the desire if to count all cells that contain any data – use the COUNTA
function.

3.10 Inserting Headers and Footers :

In Excel, headers and footers are lines of data that print at the top
(header) and bottom (footer) of each page in a worksheet to help identify
printouts. Headers and footers can contain descriptive text, graphics, and/
or fields, such as titles, dates, or page numbers. Header and footer
information does not display in Normal view, so to edit a header or footer,
click Insert > Header & Footer to open the sheet in Page Layout view, and
activate the Header & Footer Tools contextual tab on the ribbon. There are
left, center and right sections for both the header and footer areas.

Users have the option to use one or more of the many built–in headers
and footers, or they can click any of the buttons in the Header & Footer
Elements group on the Header & Footer Tools Design toolbar to create
custom fields.

Command buttons in the Header & Footer Elements group include :

• Page Number : Click this button to insert the &[Page] code that puts
in the current page number.

• Number of Pages : Click this button to insert the &[Pages] code that
puts in the total number of pages.

• Current Date : Click this button to insert the &[Date] code that puts
in the current date.

• Current Time : Click this button to insert the &[Time] code that puts
in the current time.

• File Path : Click this button to insert the &[Path]&[File] codes that
put in the directory path along with the name of the workbook file.

• File Name : Click this button to insert the &[File] code that puts in
the name of the workbook file.

• Sheet Name : Click this button to insert the &[Tab] code that puts
in the name of the worksheet as shown on the sheet tab.

• Picture : Click this button to insert the &[Picture] code that inserts
the image that you select from the Insert Picture dialog box that
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enables you to select a local image (using the From File option) or
download one from an online source using a Bing Image Search.

• Format Picture : Click this button to apply the formatting that you
choose from the Format Picture dialog box to the &[Picture] code
that you enter with the Insert Picture button without adding any code
of its own.

The following screenshot illustrates fields in each section of the
header. The Page Number and Number of Pages fields are in the left
section. Manually entered text is in the center section, and finally, the
Current Time and Current Date fields are being inserted into the right
section.

To create a custom header or custom footer, click the Launcher icon
in the Page Setup group of the Page Layout ribbon to open the Page Setup
window. Next, click the Header/Footer tab, and then choose to open either
the Custom Header… or Custom Footer… buttons.

Four checkboxes appear at the bottom of the "Header/Footer" tab,
and in the Options group of the Design tab of the ribbon. To remove headers
and footers from the first printed page, select the Different First Page
check box. To specify that the headers and footers on odd–numbered pages
should differ from those on even–numbered pages, select the Different
Odd & Even Pages check box. These options are similar to those in
Microsoft Word. The other two options are unique to Excel. To specify
whether the headers and footers should use the same font size and scaling
as the worksheet, select the Scale with Document check box. To make sure
the header or footer margin is aligned with the left and right margins of
the worksheet, select the Align with Page Margins check box.
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3.11 Adjusting the Page Layout and Preparing to Print :
The size of Excel workbooks tend to grow the more each worksheet

is manipulated, typically by adding more columns and rows, and sometimes,
more sheets. This added complexity makes physical output of Excel data
somewhat challenging. Too many columns will result in the sheet not being
able to be printed on one sheet of paper, and too many rows make make
it difficult to interpret data on pages beyond the first page. Fortunately, the
Page Layout tab can help fit the data on fewer sheets of paper and make
each page easier to understand.

While themes can help modify the appearance of a spreadsheet's
colors and fonts, the other groups in the Page Layout tab can impact the
arrangement of data, and streamline the readability of the output. Starting
with the Page Setup group, Excel allows tremendous flexibility with the
margins of each worksheet. For example, Narrow margins allow more data
to fit on one page by reducing the amount of white space on the edges of
the sheet. A quick and easy way to allow more columns to print on one
sheet, is to change the orientation from the default Portrait, to Landscape,
which allows more columns and fewer rows to print on one sheet. The
effects of these Setup decisions can be more easily illustrated by switching
from the default Normal workbook view to the Page Layout. The View tab
also allows users to to enable/disable the Ruler, Formula Bar, and on–screen
gridlines and headings.

If changing the margins and/or orientation is not resolving the issue
of getting extra columns to print on the same page, an alternative could be
changing the paper size. The default printer determines the paper sizes
available from the Size drop–down list. To check the range of paper sizes
that a printer can print on, consult the printer manual, or view the paper
sizes that are currently set for the printer in the Print Setup dialog box.
Some users have the option of printing to Legal (8.5” x 14”) or even
11” x 17” (tabloid) printers, especially if commonly printing large worksheets.

A final, more drastic option to keep data from overlapping into
multiple sheets, is to utilize the scaling feature. Using the Scale to Fit group
from the Layout tab, a printed worksheet can be scaled by to modify the
font size of printed output by either shrinking or enlarging the output. The
options exist to scale the output to fit to 1 page wide (width) by 1 page
tall (height). It might make sense to only modify the width, or by choosing
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a Scale percentage, which adjusts the overall sheet height and width
proportionately. Keep in mind the needs of your audience. Too small of
font might make the spreadsheet unreadable, and for certain audiences, the
output might need to be scaled to a larger font than the editing view.

The Sheet Options group of the Layout tab provides two significant
print features for basic Excel printing. These include the options to have
gridlines and/or headings appear in printed output. By default, the options
appear in the Viewing screen, but do not appear when printed. Without
Headings, the output would be very difficult to explain to others, and
gridlines, much like banded rows, make it easier for the eye to line up the
intersections of rows and columns.

More advanced options exist for enhancing page layout and printing
options by clicking the launcher button in each group. Additionally, several
print settings can be adjusted in the Print Preview window. The sheet in
the screenshot below is modified to print in landscape orientation with
Narrow Margins and it is scaled to Fit on One Page. It also has headings
included in the print output.

Check Your Progress :
State whether the following statements are true or false

1. Excel contains over 400 built–in functions that can be included in
a formula to perform common calculations.

2. An Excel worksheet consists of one or more workbook.

3. In Excel, headers and footers are lines of data that print at the top
and bottom of each page in a worksheet to help identify printouts.

4. A function performs a calculation on data called arguments to
compute a result.

5. Formulas typically reference values stored in other cells
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3.12 Let Us Sum Up :
In this unit we have learn about Spreadsheet and Enter, select and

insert Data into a spreadsheet. We have also learn to Manipulate Sheets and
Formatting Worksheets. We learn to write Formulas to Perform Calculations
and Copying and Pasting Formulas. We have learn to add basic functions
to formulas and insert headers and footers and finally learn to adjust the
page layout and prepare to print.

3.13 Answers for Check Your Progress :
1. True 2. False 3. True 4. True 5. True.

3.14 Glossary :

Spreadsheet : A spreadsheet is a collection of data that is organized
into rows and columns.

Function : A function performs a calculation on data called arguments
to compute a result.

Formula : Formulas are mathematical calculations using data in the
existing workbook to calculate new values.

Workbook : A workbook file consists of one or more worksheets
which consists of many columns and rows.

Rows : Rows are the horizontal part of a worksheet grid identified
by numbers.

Columns : Columns are the vertical part of a worksheet grid
identified by letters.

Cell : The intersection of a row and column is called a cell.

3.15 Assignment :
• Write short note on formula and functions

• Explain with example absolute and relative refrencing with example

3.16 Activity :

• Create student marksheet in Excel

3.17 Case Study :

• Learn Google Sheets and compare it with Microsoft Excel

3.18 Further Reading :
• https://open.umn.edu/opentextbooks/textbooks/business–computers–

365–lacher

• Information Systems for Business and Beyond, David T. Bourgeois
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4.0 Learning Objectives :

After learn this unit, student will be able to :

• Define Absolute versus Static References

• Understanding Complex Formulas

• Write and use Date & Time Functions

• Write and use Logical Functions

• Write and use advanced Math Functions

• Sorting and Filtering data

• Do Conditional Formatting

• Create Pie Charts, Bar & Column Charts and Line Charts

4.1 Absolute versus Static References :
One of the first things that new Excel users need to realize is that

Excel is so much more powerful than a calculator. Some users insist in
setting up a worksheet as if it is merely a calculator. These people fail to
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realize the power of cell references. Instead they use static references to
constant values. A static reference is a reference to a value that does not
change. In the example to the right, instead of using static references
(= 9000–3952.96) for the formula in D5, the user should employ cell
references. (= B5–C5). The main benefit of use cell references is that the
user can manipulate the input values in columns B and C, and the formulas
in column D will remain accurate. If the user changes either input values
in columns B or C with static references, the formulas in column D will
need to be manually updated.

Cell referencing is an extremely useful feature when formulas need
to be copied across ranges in a worksheet. When creating formulas that
contain references to cells or cell ranges, the default cell reference is
considered to be a relative cell reference. When formulas with these type
of cell references are copied to other cells the formulas will automatically
change relative to the cells that they are copied to. However, there may be
instances where it is necessary for Excel to keep the exact cell referenced
in a formula when copying to other cells. A cell reference that does not
change when copied is called an absolute cell reference (sometimes called
a fixed cell reference). The indicator that a cell reference is absolute is the
presence of a dollar sign symbol in front of both the column letter and row
number, such as $A$3. To create an absolute cell reference, either type the
dollar sign manually, or press the F4 after entering the cell reference.
Repeatedly pressing the F4 key cycles the reference through the four
different combinations of relative, absolute, and mixed cell references.

Mixed cell references are a combination of relative and absolute:
either the column is relative and the row fixed (absolute), for example D$2,
or the column is fixed and the row relative: $D2. Mixed cell references are
rarely used, but they play a significant role when it is necessary to keep
a single row or column unchanged while copying the formula. Mixed cell
references are commonly used when creating a table of values, like a
multiplication table or a mortgage rate table.

Whenever possible, utilize relative and/or absolute references instead
of static cell references.
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In the worksheet at the right, the formula in C6 is using relative cell
references to both the Sales amount (B6), and the Commission Rate (B3).
Unfortunately, if this formula is copied (perhaps by using the fill handle)
to rows 7:16, the resulting formulas will be wrong. Some cells will display
zeros or a #VALUE! error, while others will display inflated amounts
because the Rate percentage is being replaced by higher sales values.
Therefore, the reference to B3 in the formula should be an absolute cell
reference, i.e. =B6*$B$3. It may be tempting to construct the formula using
a static reference to the constant value of .075 (i.e. =B6*.075). However,
if the rate needs to be changed to 7.25%, the formulas with the static
references would each need to be changed manually. Conversely, if the
formulas in column C are using absolute cell references to $B$3, a single
edit to B3 is all that is needed to update all of the cells in column C.
Knowing the differences between the various type of cell reference will
make the worksheet more scalable and flexible for future expansion.

4.2 Understanding Complex Formulas :
Formulas can be simple mathematical formulas or complicated

formulas involving multiple mathematical operations, multiple cell ranges
and nested functions. While it is a good idea to remember the order of
operations rules, complex formulas can use parentheses to identify the
arguments of functions and to override the order of operations. In
mathematical operation formulas, operations within parentheses are
performed before those outside of it. For example, in =A3+B3*C3, B3 is
multiplied by C3 before A3 is added to the result, but in =(A3+B3)*C3,
A3 and B3 are added together first, then the result is multiplied by C3.
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Parentheses in operations may be nested inside each other. The
operation in the innermost set of parentheses will be performed first.
Whether nesting parentheses in mathematical operations or in nested
functions, always be sure to have as many closed parentheses in the formula
as there are open parentheses, or Excel will return an error message. In the
illustrated worksheet below, cell D30 contains a complex formula that
calculates the differences between rooms available and rooms rented to
determine the total number of unrented rooms in the Balcony and Penthouse
categories. The formula in D30 is: =(SUM(C5:C8)–SUM(D5:D8))+(SUM
(C25:C28)–SUM(D25:D28)). Notice the number of open and closed
parenthesis!

4.3 Date & Time Functions :

Excel can produce the current date and/or time, based on the
computer's regional settings. Excel can also add and subtract dates and
times.
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For example, it may be necessary to keep track of how many hours
an employee worked each week, and calculate their pay and overtime.
There are numerous Date and Time functions in Excel to help calculate the
addition or difference between dates or times. Excel stores all date and time
values as sequential serial numbers. For example, January 1, 1900 is
represented by the serial number 1, and January 1, 2020 is represented by
serial number 43831 because it is 43,831 days after January 1, 1900. To
view the serial number of an existing date, format the date using the
General Number format. The conversion of dates and times to serial
numbers simplifies the process of using dates and times in calculations.
The key to displaying the results of these calculations it using the
appropriate Number format, which may require diving into the world of
creating custom number formats to display only days, hour and/or minutes.
For example, if only the number of years is desired to be displayed when
calculating the difference between two dates, the Custom Number format
should be yy.

The TODAY and NOW functions are very similar since both return
the current system date. However, the NOW function also returns the
current system time. Many users format the results of the NOW function
to only display the current system time. One characteristic of these
functions versus the DATE function is that TODAY and NOW are volatile
functions, so if the workbook is opened tomorrow, these functions will
update automatically, whereas the DATE function will not change. These
functions are for use within the grid of the worksheet, typically to calculate
durations. There are separate Date and Time fields for use in worksheet
headers and footers.

4.4 Logical Functions :
Many employers and educators are placing increasing emphasis on

the value of critical thinking.

Condition Operator
Formula
Example Description

Equal to

Not equal to

Greater than

Less than

=

<>

>

<

=A1=B1

=A1<>B1

=A1>B1

=A1<B1

The formula returns TRUE if a value in
cell A1 is equal to the values in cell B1:
FALSE otherwise.

The formula returns TRUE if a value in
cell A1 is not equal to the value in cell B1:
FALSE otherwise.

The formula returns TRUE if a value in
cell A1 is greater than a value in cell B1:
otherwise it returns FALSE.

The formula returns TRUE if a value in
cell A1 is less than in cell B1: FALSE
otherwise.
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Critical thinking skills are often associated with problem solving
skills, empathy, and thinking and acting in purposeful ways by making fact–
based decisions. Excel is a practical tool for collecting and analyzing data
critically. Excel's logical functions are especially useful for enabling critical
thinking. However, before exploring the utilization of Excel's logical
functions, it is necessary to review the logical operators that are used to
compare data between cells. The operators are often referred to as
comparison operators. The six main logical operators are explained in the
following graphic:

These comparison operators can be used in Excel functions to
compare all types of data, including dates, numbers, Boolean values (True
or False, Yes or No), or text. All arguments must evaluate to the Boolean
values of either True or False, or contain another, nested logical function.

The IF function is one of the most popular and useful functions in
Excel. It can be used to make a decision based on a comparison. If the
comparison is true, one value is displayed in the cell; if the comparison is
false, a second value is displayed. The syntax of the IF function is:
IF(logical_test, [value_if_true], [value_if_false]).

• logical_test – a value or logical expression that can be either TRUE
or FALSE. Required.In this argument, you can specify a text value,
date, number, or any comparison operator.

• value_if_true – the value to return when the logical test evaluates to
TRUE, i.e. if the condition is met. Optional.

• value_if_false – the value to be returned if the logical test evaluates
to FALSE. Optional.

Simple IF functions test to see if a cell contains a certain text string,
and returns different values depending on if the logical test returns a True
or False logic. A sample formula is illustrated in the screenshot at right.
That's some logical critical thinking!

Instead of returning text strings, the IF formula can test the specified
condition, perform a corresponding math operation and return a value based

Greater than
or equal to

Less than or
equal to

>=

<=

=A1>=B1

=A1<=B1

The formula returns TRUE if a value in
cell A1 is greater than or equal to the
values in cell B1: FALSE otherwise.

The formula returns TRUE if a value in
cell A1 is less than or equal to the values
in cell B1: FALSE otherwise.
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on the result. This is done by using arithmetic operators or other Excel
functions in the value_if_true and /or value_if_false arguments. For
example, =IF(C4>=D4, E4*.25, E4*10%). This formula is determining if
the value in column C is greater than or equal to the value in column D.
If the result of the comparison is true, then the value to be displayed should
be the value in column E multiplied by .25 (25%). If the result of the
comparison is false, then the value to be displayed should be the value in
column E multiplied by 10% (.10).

Other popular Excel Logical functions include the AND, as well as
the OR functions. These functions allow users to create multiple logical
tests within a single IF function. These functions return either TRUE or
FALSE results when their arguments are evaluated. The AND function only
returns TRUE if every condition is met. However, the OR function returns
TRUE if any condition is met. The syntax of both functions are the same:
=AND(logical1, logical2, etc.) Examples of each function are illustrated
in the screenshots below. The first illustration uses the AND function to
determine if any of the people are eligible for the Inner Circle. They need
to have a Customer Satisfaction Score of at least 4.0, and be a Vikings fan.
The second example uses the OR function. The more lenient comparison
operator yields more eligible people for the Inner Circle.

AND function example

OR function example
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4.5 More Math Functions :
The most popular Excel function in the Math category is undoubtedly

the SUM function. The Excel Math Functions perform many of the common
mathematical calculations, including basic arithmetic, conditional sums &
products, quotients, and rounding calculations. There are many more
examples, but some of the more popular Math functions are identified in
the table below. There are many variations of some of these functions to
be found in the Insert Function window.

The first two functions from the table above are considered basic
mathematical operations. Instead of multiplying two cells using the *
operator, Excel users can opt to use the PRODUCT function. i.e.
=PRODUCT(B2,B3) versus =B2*B3. The PRODUCT function is most
useful when multiplying a series of cells. Ensure that the cells referenced
contain numbers or dates. If the data referenced includes text, the PRODUCT
function will return the #VALUE! error result. The QUOTIENT function
is similar to the PRODUCT function, except instead of multiplying cells,
it divides cell(s) by other cell(s) and returns a result in Integer format. An
integer is a whole number, therefore it will not display the remainder
typically generated in division calculations. The graphic at right illustrates
the differences between using the divide operator and the QUOTIENT
function. The numerator is the dividend and is the value before the forward
slash (/). The denominator is the divisor, and is the value after the forward
slash (/). In this example, A1 (or 13) is the dividend, and B1 (or 5) is the
divisor.

An alternative to using the QUOTIENT function is to utilize the
ROUND function or any of its related functions (ROUNDDOWN,
ROUNDUP,MROUND). In the graphic above, a user could rewrite the
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formula in A4 as =ROUND(A1/B1,0) by using the ROUND function to
get the similar results as the QUOTIENT functions. The difference is that
the QUOTIENT result does not store any remainder amounts.

As shown in the graphic at the right, using the ROUND function can
yield significantly different results than using the QUOTIENT function,
however, the user can control the level of detail desired in the calculation.
Some users simply opt for the first scenario without using either functions.
Instead, they utilize Excel's formatting functionality to remove the displaying
of decimals. Using the Decrease Decimal button from the ribbon on cell
B4 can change the display to various results. However, the un–truncated/
un–rounded result is still stored in the cell.

4.6 Sorting and Filtering :

Worksheets can have large amounts of data, and it can be overwhelming
if it is not sorted correctly. Arranging data in a specified order is called
sorting. Rows can be sorted in either ascending (low to high) or descending
(high to low) order. Ascending order can also be considered alphabetic
order if the data is text or chronological order if the data is dates or times.

Before data can be sorted, Excel needs to know the exact range of
cells that is to be sorted. Excel will select areas of related data as long as
there are no blank rows or columns in the data range. Blank rows and
columns define the outer limits of the data range. To ensure that the correct
data is selected, highlight the range before starting the sort.

As Excel determines the defined range of data to be sorted, Excel
also determines if field names exist. Users should format the first row of
the data range with unique formatting Often, just making the labels bold
will help Excel identify the field names. Identifying the field names will
prevent Excel from including these fields in the records to be sorted. The
field names become the sort keys needed for multiple column sorts. In the
image below, the possible sort keys are: Cruise Date, Accommodation
Category, Rooms Available, Rooms Rented, Rate, Revenue and Shortfall.
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The data range above is already sorted in ascending order by the
Accommodation Category key field. A single column sort is quite easy.
Simply click any cell in the column that represents the key sort. In the above
example, any cell from B4 to B28 would be acceptable. Then, click the the
A–Z option in the Sort & Filter group of the Data tab. The entire row is
sorted because each row is a record that should stay grouped together. Be
careful NOT to select a single column of data or the records may not be
kept together. Excel will warn the user with a warning message. If the user
chooses to Continue with the current selection, only the data in the column
with change their order, while the data in the other columns remain
unchanged. This will most likely destroy the integrity of the data.

Advanced sorting involves multiple key fields from multiple columns.
A multi–level sort can be set up by clicking the Sort button from Sort &
Filter group from the Data tab (or the Sort & Filter button from the Editing
group of the Home tab and choose Custom Sort) to open the Sort dialog
window. The first sort criteria, also known as the primary sort, was
previously defined to sort by Accommodation Category in ascending order.
To add a second level, also known as a secondary sort, click the Add Level
button. After entering additional sort criteria, additional levels can be added.
As shown in the graphic to the right, secondary criteria has been added to
sort in descending order by Revenue. The data in column B will not appear
to change, but the records will reorder. Compare the results below with the
table above.
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An Excel filter, also known as an AutoFilter, is used to display only
the data that meet specific criteria. Data that does not meet the criteria is
hidden from view. Excel's basic filter functionality allows users to filter
rows by value, by format and by criteria. Filters can reduce a large, complex
worksheet of data into meaningful information. With filtering, you can
control not only what you want to see, but what you want to exclude. Users
can filter based on choices they make from a list, or they can create specific
filters to focus on exactly the data that they want to see. Clicking the filter
button from the Data tab will add drop–down arrows to the column headers
in a range of data.
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Clicking a drop–down arrow provides sorting and filtering options,
like filter by color or text filters. A simple AutoFilter will be signified by
the clearing of check boxes of the data that should be hidden. After applying
a filter, a user can copy, edit, chart or print only visible rows without
rearranging the entire list. Like sorting, filters can be applied to multiple
columns to further reduce the results that are displayed.

A column that has been filtered will have its drop– down arrow icon
switch from an upside–down triangle to a filter icon, as shown highlighted
in yellow below. Only the cruises from the Penthouse accommodation
category will be displayed after clearing all check boxes except the
Penthouse category.

To remove a single filter, click the filter icon in the row header and
choose Clear Filter from…. To clear all filters quickly, choose the Clear
button from the Data tab on the ribbon or to remove filtering functionality,
re–click the Filter icon from the Sort & Filter group. For more advanced
users there are many more ways to utilize filters in Excel, such as Custom
Filters and Advanced Filters. Nonetheless, a lot can be accomplished with
the basic AutoFilter feature.

4.7 Conditional Formatting :
Using spreadsheet functionality to enhance critical thinking is a

primary reason that Excel is so popular among business professionals.
Decision–making is made easier when users can quickly spot trends,
identify variances, and be alerted when certain criteria is met. Excel's
conditional formatting feature is a really powerful tool when it comes to
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applying different formats to data that meets certain conditions. Conditional
formatting is one of the most simple yet powerful features in Excel by
applying user–specific formats to a cell/cells when user–specific conditions
(rules) are met. Not only does it make a spreadsheet look awesome, but
it also helps make sense of the data.

Clicking the Conditional Formatting button on the Home tab of the
ribbon offers several options to define the condition criteria (rules), and
several formatting options to display the data in meaningful ways. To
choose formats that are applied to a cell(s) when a condition is met, select
a range of cells, then click the Conditional Formatting button to display
a menu of rules. Clicking a rule will expand an additional menu. For
example to identify which cruise accommodation categories provide the
most significant revenue shortfall, utilizing a highlighting rule that formats
cells that are greater than $100,000 would be a very practical conditional
formatting rule that could provide some strategic information. Selecting the
range of G5:G28 and applying the Greater Than rule, will create eye–
catching formatting. The data in the first field can either be a cell reference
or a static value, as shown below.
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Numerous rule types exist beyond the preset comparison operator
menu choices. Rules can identify cells that contain certain text or before/
after a certain date, or even highlight duplicate data. Top/Bottom Rules can
reveal the top or bottom 10 records in a certain column. The quantity can
be modified from the top/bottom 10 to a user–specific number.

Custom rules can be defined by choosing More Rules… from the
Highlight Cells Rules menu, which opens the New Formatting Rule
window. Choosing alternative Rule Types will modify the functionality
available in this window.

After defining the rule criterion, custom formats can be selected by
clicking the Format button.
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The Format Cells window opens to allow custom Number, Font,
Border or Fill formatting. To enforce more complex rules, multiple
conditional formatting rules can be applied to the same data. However too
many colors can sometimes be distracting, and should be used sparingly.
Therefore, Excel offers more formatting choices than just color fills. Data
bars, color scales and icon sets can also be used to emphasize data that
meets certain conditions.

The icon sets work great when color is not effective, such as when
printing to black & white laser printers. Icons are even more noticeable than
colors because of their unique look and sparing use. Icon sets will help
visually represent the data with directional arrows, shapes, indicators,
ratings, and other objects. For icons in sets of three, Excel will assign icons
by dividing values into thirds – the first icon is assigned to the top one
third of values, the second icon is assigned to the second third of values,
and the third icon is assigned to the lowest one third of values. The values
are adjusted for four and five–icon sets. Conditional formatting's flexibility
is extensive, but perhaps even more impressive is that, like formulas,
conditional formatting rules are volatile. As the data changes, the conditional
formatting dynamically adjusts to evaluate the new data against the existing
conditional rules.

4.8 Pie Charts :

With Excel, users can organize data so that it has context and
meaning. The output of Excel manipulation can take the shape of either
a table or chart. When deciding to use a chart or a table to communicate
the data–driven message, it is wise to always ask how the information will
be used, and who is the audience ? People interact very differently with
these two types of visuals. Tables, which display data in a columnar layout,
are meant to be read. Therefore tables are ideal when the data requires more
specific analysis. Tables offer preciseness, letting users dive deeper to
crunch the numbers and examine exact values, instead of focusing on
approximations or visualizations.

A chart is a visual representation of a range of related worksheet data.
A chart can illustrate a large amount of numerical data quickly and in an
easy–to–understand fashion. Charts are particularly useful for simplifying
complex sets of data to expose the shape of the data – numerical patterns,
trends, and other significant activity. What charts lack in terms of precision
they overcome with broader insight and quicker comprehension.

Learning how to work with charts means not only knowing how to
create them but also realizing that different types of chart and layouts can
reveal and emphasize different knowledge. Like a picture, a chart can be
worth a thousand words. It all depends on how well the chart is designed
and developed. A well constructed chart will provide context and clarity
for data analysis and story telling. The first step to creating useful charts
it to organize and precisely select the data that should be charted. This
includes the cells that contain both the data and the label headings.
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Each chart type conveys information in different ways. Pie charts, for
example, are best for charting data that is a percentage of a whole. For
example, what percentage of your monthly income is spent on transportation ?
Charts contain different objects for each chart type. Objects in a pie chart
include :

• Chart title – describes what is charted. The label heading of the data
series is used by default, but this can be edited.

• Legend – an index of information that corresponds to the category
labels.

• Data labels – identify each value in the data series.

• Plot area – the part of the chart that displays data graphically.

• Chart area – the entire chart and all of its elements.

A pie chart can only include a single series of data, whether it is a
single column or a single row of data. A data series is the sequence of values
that Excel uses to plot in a chart. Each value from the data series is
represented by a slice (or wedge) of the pie. The size of each slice varies
with its percentage of the total of the entire data series. To create a pie chart,
first carefully select the appropriate data range before selecting the chart
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type from the Insert tab. In the above chart, the selected data range is
$B$3:$F$3, $B$19:$F$19, since the only data series being charted is the
total sales (quantity) of each cookie flavor. Every date (row) represents an
additional data series, but since pie charts only plot a single data series,
these series' should not be selected. Pie charts should be avoided when
there are many categories, or when categories do not total 100%. Typically,
2–D charts are easier to read than 3–D charts.

When a chart is created as an object on a worksheet, sizing handles
will appear on the outer borders. The chart, or any object within the chart,
can be moved and/or resized similarly to a picture or other objects in
Microsoft Office. When a pie chart is first created, Excel will use the
default colors and design. Users can customize the chart look easily by
utilizing chart styles. In the Design contextual tab of the Ribbon, a number
of different styles will be displayed in a row. Mouse over them to see a
preview :

An additional option for quickly changing the look of a chart is to
utilize the Quick Layout menu to select one of several preset to add
elements like percentage labels, value labels, and differently located
legends to the chart.
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Users can also add and remove individual elements, such as chart
titles, data labels, data tables, and more by using the Add Chart Element
menu. Some elements are not available for certain chart types. One of the
most useful chart elements that get added manually to a chart are data labels.
Data labels are linked to values on the worksheet, and they update
automatically when changes are made to these values. Data labels make a
chart easier to understand because they show details about a data series or
its individual data points. Users can add data labels to all data points or
a specific data slice by ensuring that only the specific slice is selected. In
addition to the Add Chart Element menu and quick layout options, users
can add data labels by right–clicking the chart and choosing Add Data
Labels from the shortcut menu. Once added, the data labels can be further
modified by right–clicking the chart and choosing Format Data Labels to
open the Format Data Labels task pane. One or more types of labels can
be added and positioned. Adding Category Name labels make the legend
redundant. Be careful not to add so many labels that the chart becomes too
crowded to read!

After adding labels, it may become necessary to resize or move the
chart. After adding a title, data labels, and removing the legend, the chart
looks different, but is still the same size, even though certain elements have
resized.

Which pie chart looks better ? Generally, removing the legend
through use of data labels is considered a preferable design strategy. Alas,
there are even more ways to customize a pie chart that is beyond the scope
of this text! Additional functionality includes creating 3–D pie charts,
exploding slices, rotating, sorting, adding different fill designs, and much
more!

4.9 Bar & Column Charts :
Bar charts are practical for comparing the differences between values

with horizontal bars. The lengths of the bars are proportional to the size
of the data category they represent. A vertical bar chart is referred to as a
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column chart, and they are basically the same – just 90° apart. Unlike a
pie chart, a bar chart can include several series of data. Bar charts are
simple, easy and flexible, and thanks to the horizontal layout, bar charts
can accommodate longer category names. Bar (and column) charts contain
the following objects :

• Chart title – describes what is charted.

• Chart area – the entire chart and all of its elements.

• Plot area – the region within the horizontal and vertical axes.

• Axes titles (horizontal, vertical)– describe the data.

• Legend – an index of information that corresponds to the series
names.

• Data labels – identify each value in a data series.

• Value axis (y–axis) – contains values. Horizontal axis on bar charts
and vertical axis on column charts.

• Category axis (x–axis) – contains the category labels. Horizontal axis
on column charts and vertical axis on bar charts.

• Gridlines – mark the intervals on an axis.

While the data and chart above only displays one data series, most
bar and column charts tend to display multiple data series to compare and
contrast one set of data against another. The chart below adds a second data
series in column C, and changes the chart type to a column chart. The two
different data series are illustrated with different color data points. Also,
note how the axes change directions! The value axis maximum, major and
minor units were also modified to different numerical values.
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Charts can easily get crowded with details. Therefore, keeping the
chart on the same worksheet as the data is not always feasible. Users can
move a chart to any location on a worksheet or to a new or existing
worksheet. By default, a chart is created as an object within a sheet. The
chart can be resized, but sometimes the chart needs to be as large as
possible. To move the chart to a new worksheet, click the Move Chart
button on the Chart Tools Design tab. Next, click the New sheet radio
button, and then in the New sheet box, type a name for the new worksheet.
After clicking OK, the new sheet will be to the left of the existing sheet.
A new, standalone chart will occupy the entire page to maximize the
visibility of the data. The Move Chart window also provides the option of
moving the chart as an embedded object into an existing sheet.

4.10 Line Charts :

A line chart displays a series of data points connected by a straight
line. Line charts are a good way to show change or trends over time. Line
charts are simple to create and easy to read. In contrast to column or bar
charts, line charts can handle more categories and more data points without
becoming too cluttered. Each line displays as a different color. Line charts
help people examine why data is changing and make decisions about how
to proceed. The Line Chart is especially effective in displaying data trends.
Stock market investors utilize line charts to track historical stock
performances, and help determine if a trend can be forecasted in the future.

In a Line Chart, the vertical axis (Y–axis) always displays numeric
values and the horizontal axis (X–axis) displays time or other categories.
Time intervals can be measured in years, months, days, or hours.

To create a line chart, start by selecting the data range, then choosing
the Line Chart button Microsoft Excel in the Charts group from the Insert
tab.

In the 2–D line chart illustrated above, two sets of data series are
plotted for fifteen days. The Skinny Mints cookies are identified by the red
line, and the orange line plots the Chocolate/Peanut Butter cookies. Each
date is a data point. Additional data series can be added by expanding the
data source range. Line charts provide an easy way to track historical data.
In many cases, the way the data is trending makes it easy to predict the
results of data in future periods.
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Excel offers numerous other charts that might better help illustrate
the story behind the data, however all charts must address the challenge
of sharing or outputting the graphic(s) to their target audience(s). Here are
a few printing issues to consider:

• Printing only the chart. If the active cell is not selecting the chart,
both the chart and worksheet data will print. However, if the chart
is currently selected, only the chart will print by default (as a chart
sheet). If the intent is to print both the chart and the data, make sure
to move and/or resize the chart to ensure everything fits appropriately
within the sheet margins. This will embed the chart within the sheet.
Utilizing the Print Preview window to verify what will print by
default will allow the user to make numerous changes, such as the
orientation, margins and scaling. A different installed printer can also
be selected. The graphic below illustrates from the Print Preview
window, an embedded line chart in landscape orientation with
headings enabled for print. The sheet has also been scaled to fit to
one page.
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• Chart colors that are not compatible with black and white printers.
A lot of office printers are black and white laser printers due to their
low–cost to operate at high volumes. A color laser printer may be a
worthy investment for common chart printing. If a black and white
printer is all that is available, it may be necessary to change the colors
to patterns or contrasting shades of grey.

• Not enough or too much information. Reads of the chart must be able
to comprehend the message the chart is attempting to convey. This
might require adding context, such as titles, data labels, and text–box
callouts. Conversely, a chart can have too much information that the
chart is cluttered and unreadable. In this case, summarizing the data
my be prudent, or even re–selecting a different source data range. A
chart can also be unreadable due to poor design considerations like
wrong fonts and font sizes, as well as distracting colors and object
sizes.

• Excel charts are volatile and will change as often as the source data
is changed. If a static copy of a chart is needed, consider saving the
chart as a picture. This can be accomplished through using the copy
and paste special commands. Using Paste Special will allow a chart
to pasted in either PNG, JPEG, GIF or other formats. Alternatively,
Excel files can be saved as PDF files for inserting in other electronic
documents/files.

Check Your Progress :
State whether the following statements are true or false

1. Cell referencing is an extremely useful feature when formulas need
to be copied across ranges in a worksheet.

2. Mixed cell references are a combination of relative and absolute

3. Relative reference are sometimes called a fixed cell reference
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4. Parentheses in operations can't be nested inside each other.

5. Excel charts are volatile and will change as often as the source data
is changed.

4.11 Let Us Sum Up :

Int this unit we have learn many advanced features of Microsoft
Excel such as Absolute versus Static References, Understanding Complex
Formulas, Date & Time Functions, Logical Functions, advanced Math
Functions, Sorting and Filtering Data, Conditional Formatting of data,
creating Pie, Bar, Column and Line Charts.

4.12 Answers for Check Your Progress :
1. True 2. True 3. False 4. False 5. True

4.13 Glossary :
Static Reference : A static reference is a reference to a value that

does not change.

Absolute cell reference : A cell reference that does not change when
copied is called an absolute cell reference (sometimes called a fixed cell
reference).

Mixed cell references : Mixed cell references are a combination of
relative and absolute: either the column is relative and the row fixed
(absolute)

Sorting : Arranging data in a specified order is called sorting.

Filter : An Excel filter, also known as an AutoFilter, is used to display
only the data that meet specific criteria.

4.14 Assignment :
• Write short note on date and time functions

• Explain logical function

• Explain different types of charts.

4.15 Activity :
• Create chart for student marksheet in Microsoft Excel

4.16 Case Study :

• Write formula to calculate result and grade obtained by the student
in seven subjects.

4.17 Further Reading :

•  https://open.umn.edu/opentextbooks/textbooks/business–computers–
365–lacher

• Information Systems for Business and Beyond, David T. Bourgeois
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BLOCK SUMMARY

In this block we have learn about word processing and spreadsheet
fundaments and we have also discuss advanced features of word processing
and spreadsheet.



BLOCK ASSIGNMENT

Short Questions :

• What is cell reference ?

• What is absolute cell reference ?

• What is Mixed Cell Reference ?

• What is logical function ?

• What is chart ?

• Lits components of chart.

• What is use of pie chart ?

• What is sorting ?

• What is filtering ?

Long Questions :

• Write detailed note on chart

• Explain in details about cell referencing

• Explain different types of functions available in Microsoft Excel

• Write detailed note conditional formatting

• Explain sorting and filtering with suitable example

171



172

COMPUTER
APPLICATION

 Enrolment No. : 

1. How many hours did you need for studying the units ?

Unit No. 1 2 3 4

No. of Hrs.

2. Please give your reactions to the following items based on your reading
of the block :

3. Any other Comments

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................
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BLOCK 4 : Presentation and Database

Block Introduction

This block introduces presentation software Microsoft Powerpoint

and Google Slides for creating effective presentation using text, image,

ClipArt and video. This block introduce Microsoft Access Database

and discuss basic features of Microsoft Access.

Block Objectives

The objective of this block is to  create and save a new presentation,

Add, delete, and move slides, Insert text boxes, Change theme on a

presentation, Add images and clip art, Add videos and Arrange objects

in Microsoft Powerpoint and Google Slides. It also gives essential

overview of Microsoft Access database tool.

Block Structure

Unit–1 : Microsoft Powerpoint Basics

Unit–2 : Introduction to Google Slides

Unit–3 : Introduction to Microsoft Access Database



: UNIT STRUCTURE :

1.0 Learning Objectives
1.1 Introduction to Using Microsoft PowerPoint

1.2 Create New Presentations and Save Presentation
1.3 Editing and Enhancing a PowerPoint Presentation
1.4 Adding Slides

1.5 Deleting a Slide
1.6 Organizing Slides

1.7 Inserting Text Boxes
1.8 Changing the Theme on a Presentation

1.9 Adding Images and Clip Art
1.10 Adding Videos
1.11 Arrange Objects

1.12 Let Us Sum Up
1.13 Answers for Check Your Progress

1.14 Glossary
1.15 Assignment

1.16 Activity
1.17 Case Study
1.18 Further Readings

1.0 Learning Objectives :

After studying this unit learner should be able to :

• Create and save a new presentation

• Add, delete, and move slides

• Insert text boxes

• Change theme on a presentation

• Add images and clip art

• Add videos

• Arrange objects

1.1 Introduction to Using Microsoft PowerPoint :
PowerPoint is one of several applications in Microsoft's Office

product line, including enterprise staples Outlook (email and calendar),
Excel (spreadsheet) and Word (word processing).

Unit
1

MICROSOFT POWERPOINT
BASICS
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PowerPoint has a 95 percent market saturation. PowerPoint is
available in over one hundred languages. PowerPoint has been installed one
billion times. 30 million presentations are created every day in PowerPoint.

With a market share of approximately 95 percent, PowerPoint is
considered the industry standard for both business and education. PowerPoint
supports over 100 languages and can be used on both Android and Mac
devices. There are over 1 billion installations of PowerPoint worldwide,
with 30 million presentations created daily. Similar to Kleenex for tissue,
the PowerPoint brand name has become a generic reference for all
presentation software and the generally poor use of this technology has
given rise to the phrase "death by PowerPoint," a scenario you will learn
to avoid in subsequent sections. In this section, we will focus on the basics
of creating a presentation, including how to create and save a presentation,
how to change layouts and templates, how to add text, images and video
and how to manage slides and objects within a slide.

1.2 Create New Presentations and Save Presentation :

At the Microsoft Office 365 home page, you will see a selection of
apps as well as any recently–viewed documents. To open PowerPoint, click
on the PowerPoint icon. The PowerPoint icon style varies depending on
your operating system (PC or Mac) and the version of your software, but
it's always a red–orange P, sometimes accompanied by a chart graphic, as
you can see circled in Figure 1.

Figure 1 : Accessing PowerPoint in Office 365
When you open PowerPoint, the application will take you to a

presentation gallery (see Figure 2), where you can choose to either open
a new blank presentation or start a presentation using a template. To start
with the proverbial blank page–no pre–set graphics, backgrounds or text–
click (or double–click, depending on your version) New blank presentation.
You'll be presented with a new blank presentation title slide containing two
text boxes for a title and subtitle. These are placeholders that can be used,
deleted, or simply ignored.
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Figure 2 : Template Gallery
If you want to use the default layout, click where it says Click to add

title and type in your text. Note that when you click in the text box, the
prompt text disappears and is replaced with a flashing cursor. To finish your
entry, simply click outside the box. Pressing the enter or return key after
typing your text will act as a return and advance the cursor to the next line.
If you pressed return and don't want a two–line title, simply press the Undo
arrow under the File tab at the top left of your screen (or if you're using
Windows, press Ctrl + Z on your keyboard; if you're using a Mac, press
Cmnd + Z). To continue adding or editing text, click the text or within
another text box and continue.

Figure 3 : Your New Presentation

Placeholder boxes and prompts don't show up in Slide Show or
presentation mode, so you don't necessarily need to delete those you don't
use. If, however, you find them distracting, click on the border of the
placeholder and press either the delete or backspace keys on your keyboard.

As mentioned above, the web–based version of PowerPoint will save
your file automatically, assigning a default title of Presentation. If you have
multiple presentations in progress, it will save subsequent files as
Presentation1, Presentation2, etc. To (re)name your presentation, click the
default title, type your desired title and press enter.
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Figure 4

Saving Documents When Working Offline
If you're not working with PowerPoint Online, you will need to save

your presentation manually: click on the File tab.

Figure 5
You'll then click Save or Save As in the menu along the left side of

the screen. Note: you can also use the common keyboard shortcuts Ctrl +
S (Windows) or Cmnd + S (Mac).

Figure 6

To save your presentation on your desktop, choose This PC, select
my Desktop and tile your presentation–for example, "To–the–Bank Retail
Trends." At this point, you will also choose the format you want to save
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your presentation in Save as type. If you will be sharing your presentation
with other students or colleagues who are using an older version of
PowerPoint, select PowerPoint 97–2003 as the type from the drop–down
list. Otherwise, go with the default option.

1.3 Editing and Enhancing a PowerPoint Presentation :

Now that you've created a presentation, let's start adding to it! If you
closed your presentation after saving, you can reopen it by starting
PowerPoint and selecting your presentation (i.e., To–the–Bank Retail
Trends) listed under Recents.

1.4 Adding Slides :

You can add a slide from either the Home tab, Insert tab or Thumbnail
pane.

From the Home Tab

Figure 7 : Home Tab

1. Click on New Slide (or Duplicate Slide, to copy the current slide
layout)

2. If you clicked New Slide, select a layout that best fits your content

3. Press enter

From the Insert Tab
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1. Click on New Slide

2. Select a layout

3. Press enter

From the Thumbnail Pane

You can also add slides from the thumbnail pane, the lefthand column
of your screen when you're in the default or Slide view.

1. Select (highlight) the slide you want the new slide to follow

2. Right–click on the slide

3. Select New Slide for the default content slide layout or Duplicate
Slide to copy the slide layout and content

OR, to use a shortcut to duplicate the slide layout (not content)

1. Select (highlight) the slide you want the new slide to follow

2. Press Ctrl + M (PC) or Cmnd + M (Mac)

Note that your layout choice isn't final, so don't overthink the
decision. If you're just trying to get your thoughts down on slides, select
Duplicate Slide and fine–tune later.

1.5 Deleting a Slide :

As with most operations, there are multiple ways to delete a slide :

• Highlight the slide in the thumbnail pane and press delete

• Highlight the slide in the thumbnail pane and press the delete icon
(Home tab)

• Highlight the slide in the thumbnail pane, right click and select Delete
Slide

1.6 Organizing Slides :

To move a slide, simply drag and drop in the thumbnail frame.

1.7 Inserting Text Boxes :

There are multiple ways to insert text into your slides. One of the ways
to enter text, as discussed earlier, is to click inside a placeholder box and
enter your text. However, you may want to add text to a blank slide or in
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a place where there is no placeholder. To do so, select the Insert tab on
the ribbon, and choose Text Box.

A text box will be inserted in your slide with a Click to insert text
message similar to the placeholder Title and Subtitle boxes discussed
earlier. The text box will expand to fit your text. If you decide you want
to reposition the text box, you can click and move the text box/text around
the slide. If you want to modify the width of the text box, click on a corner
and drag it out as desired. The circular icon at the top of the text box
activates the drawing and formatting options and allows you to rotate the
text box.

1.8 Changing the Theme on a Presentation :

Themes are one of the formatting options within PowerPoint. A
theme is a slide design that contains pre–set colors, fonts, formatting and/
or images. To view formatting options, click on the design tab and scroll
through the available themes.

Clicking on a theme's thumbnail applies the formatting to your slides,
so you can evaluate potential fit. A second group of options in the ribbon
provides color variations on that design. A third option, exclusive to the
online version of PowerPoint, is Design Ideas, providing additional
variations; this feature is still being built out. To revert to your original
format, click Undo.

One caveat: given the limited number of templates and the number
of people using PowerPoint, using a standard template doesn't do anything
to distinguish you or your message. Instead of selecting a standard
template, use thoughtful images and complementary fonts to add design
impact.
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Check Your Progress – 1
1. To save a new Microsoft PowerPoint presentation online:

(a) Select File > Save and tile your presentation

(b) Select Ctrl+S (PC) or Command+S (Mac)

(c) Click to edit presentation and rename

(d) None of these

2. Your meeting organizer sends you an email asking you to edit your
presentation down to 15 minutes to accommodate a "drop in" visit
from your President. To delete one or more slides:

(a) Click on Slide Thumbnail and select Ctrl+D

(b) From Review Tab, Click on Slide Thumbnail and select Delete

(c) From Home Tab, Click on Slide Thumbnail and select Delete

(d) Any of the above

3. You have vowed to create a custom presentation using none of the
default slide layouts. To add text in an area where there is no
preformatted text box:

(a) Double Click and Type Text

(b) From the Insert Tab, Select TextBox

(c) From the Design Tab, slect insert text

4. You want to experiment with different color, layout, and font options,
but the number of possible combinations is overwhelming. You
decide to scroll through the theme options to see how they work with
your material. To do that:

(a) Select Format > Theme and select a theme

(b) Select File > Open and select a theme

(c) From the designer tab, select a t heme and click to apply

1.9 Adding Images and Clip Art :
Adding art, images and photographs is a way to both personalize your

slides and reinforce your message.

Adding visual elements to your slides is done from the Insert tab.
Images can also be inserted directly from a new slide using the Add
Pictures, Online Pictures or Online Video icons embedded in new slide
layouts.
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To add pictures from your computer

1. Select the Insert tab

2. Click on Picture

3. Select your desired image

4. Press Open to insert

The Add Pictures From the Internet option allows for two possibilities:
searching via Bing and uploading images from OneDrive (Microsoft's
cloud storage product). Of course, you can also do an image search using
Google Images or your preferred search engine, download images to your
desktop and upload them to your presentation using the steps above. Don't
be put off by the initial Bing images served up. Bing's filters allow you
to search by size (small, medium, large, extra large), type (all, photograph,
clip art, line drawing and transparent), color (all, color, B&W and by 12
basic colors) and license (all or Creative Commons only).

To add pictures from the Internet

1. Select the Insert tab

2. Click on Online Pictures

3. Type in your search term(s)

4. Refine your image search using Bing's size, type, color and license
filters

5. Select an image

6. Press Insert to insert into slide

7. Use the corner image "handles" (small boxes) to size

1.10 Adding Videos :
Adding video allows you to incorporate both motion and sound into

your presentation and this can translate into audience energy! As with other
visual elements, video is an Insert tab command.
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The add video command launches a YouTube video search. To see
video details, hover over the video. To view the video once embedded, click
on the View tab, select Current Slide and press Play.

To add video

1. Select the Insert tab

2. Click on Online Video

3. Enter your search terms

4. Select your desired video

5. Press Open to insert

1.11 Arrange Objects :

There may be times when default line spacing doesn't work or you're
trying to build a slide that involves multiple blocks of text and/or imagery.
That's where PowerPoint's Arrange function comes into play. Arrange
allows you to order (layer) objects, bringing individual elements forward
or sending them backwards. It also allows you to flip objects. Refer to
Figure 4 for a screen shot.
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Check Your Progress – 2
1. You want to incorporate a powerful image to balance the text and

data in your presentation. You recently took a photo that would be
perfect. To insert your photo:

(a) Select Insert > Picture > Click to select and Click open to insert

(b) Search for the image on your computer and drag it into your slide

(c) Select View > Photos > Click to select and click insert

2. You're creating a class presentation on note–taking strategies and
want to include the YouTube video that taught you how–and why–
to use Cornell notes. To add it to your presentation:

(a) Select Insert > Online Video > Search YouTube > Select a Vide
> Insert

(b) From YouTube, Select Share, Copy and Paste the URL into your
slide

(c) From YouTube, Select Share and select the Microsoft PowerPoint
icon

(d) None of these

3. You're building a layered slide, with a full–size image and a text box.
You created the text first and it's now obscured by the image. To bring
your text forward, you would use the following commands:

(a) From Design Tab, select Format background > Set background

(b) From the Transition tab, select Arrange > Send backward

(c) From Home tab, select Arrange > Send back

1.12 Let Us Sum Up :
In this unit we have discussed about Microsoft PowerPoint and it's

features. We have lean how to create New Presentations and Save
Presentation, Editing and Enhancing a PowerPoint Presentation, Add
Delete and Organize Slides, Insert Text Boxes, Change the Theme on a
Presentation, Add Images, Clip Art Video and Arrange Objects.

1.13 Answers for Check Your Progress :
Check Your Progress – 1

1. b 2. b 3. c 4. c

Check Your Progress – 2

1. b 2. c 3. a

1.14 Glossary :

Presentation Software : Presentation software is defined as computer
programs designed to allow the user to present information in an engaging
way such as with text, pictures, sound and video. PowerPoint is an example
of a presentation software.
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Slide : The slides contain the information you want to communicate
with your audience.

Slide layout : Slide layouts contain formatting, positioning, and
placeholder boxes for all of the content that appears on a slide.

Theme : A theme is a slide design that contains pre-set colors, fonts,
formatting and/or images.

Template : A PowerPoint template is a pattern or blueprint of a slide
or group of slides that you save as a . potx file. Templates can contain
layouts, colors, fonts, effects, background styles, and even content.

1.15 Assignments :

• What is a PowerPoint ?

• Explain features of Microsoft PowerPoint

1.16 Activity :

• Discuss different types of presentation software available in

1.17 Case Study :

• Compare Microsoft PowerPoint with Google Slide

1.18 Further Reading :

• https://courses.lumenlearning.com/wm–businesscommunicationmgrs/
chapter/introduction–to–using–microsoft–powerpoint/ ?
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2.0 Learning Objectives :

After studying this unit learner should be able to :

• Create a presentation using Google Slides

• Create and save a new presentation

• Organizing Slides

• Text Boxes

• Themes

• Images

• ClipArt

• Video

2.1 Introduction :
Google Slides is a free program that's part of Google's suite of web–

based applications, including Google Docs (word processing), Sheets
(spreadsheets), Slides (presentations) and Forms (collecting & organizing
information). What's particularly powerful about Google Slides is that you
can create, edit, collaborate and present seamlessly across operating
systems and without potential file compatibility or corruption issues,
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managing flash drives or figuring out connector cables. Using a web–based
program also eliminates the risk of transferring a virus.

It is also fairly easy to move a presentation from PowerPoint to
Google Slides and back again, though you may lose some formatting in the
process. If you do move a presentation, page through to make sure the slides
still look the way you want them to. However, all the content should convert
just fine. If you are used to PowerPoint and find yourself needing to use
Google Slides (or vice versa), fear not! The commands and procedures are
pretty similar between the two of them, and if you get stuck, there are lots
of good online resources to answer your questions.

Figure 1

For an overview of Google Slides capabilities, scroll down through
the front pages on the Google Slides website.

To highlight a few key features and benefits :

• Universal access, from your phone, tablet or computer

• Support for both Android and iPhone/iPad (Google Slides apps)

• Share your presentation with options for to restrict/enable viewing,
commenting and editing

• Auto–save

Embedded in Google Slides are a variety of presentation themes and
templates, hundreds of fonts and support for text, images and video. You
can search Google Slides template gallery for perspective or a jump start
to creating your presentation. Let's jump right in!

Googles Slides is free to use, but to do so requires a Google account.
If you don't already have a Google account (i.e., a gmail address, Google
Drive or Google Calendar), you will need to create one in order to use
Google Slides. To establish a Google account, search for "Google account"
or go directly to the Google Account sign up page.
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Figure 1

2.2 New Presentations :

To start a new presentation, search for "Google slides" or go to
https://www.google.com/slides/about/. See Figure 2 for a visual of the
application's opening view. You can start a new blank presentation or
choose from a number of existing, editable presentations or templates. If
you recently viewed a shared presentation or created a presentation, you
would see it listed under Recent Presentations. To start a new presentation,
click on the plus (+) sign in the Blank Presentation box.

Figure 2
Within Google Slides, as in all Google applications, your work is

saved automatically. Until you name your presentation, it will save as
Untitled presentation.

To title your presentation, click in the [Untitled Presentation] box and
type your desired title. By default, Google slides will insert the text from
the title box as the title; you can accept that or delete and enter an alternate
title (see Figure 3).
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Figure 3

2.3 Organizing Slides :

There are multiple options for adding slides:

• Select "+" (New slide) from the second menu line. To select a specific
slide layout, use the dropdown menu to the right of the slide to add
a slide that best matches the content for that slide

• Use the New slide shortcut: Ctrl+M

• From the Insert dropdown, select New slide (Ctrl+M) Select Insert
> new slide

• Select Slide > Duplicate slide, which will copy the slide that's
currently highlighted in the thumbnail section in the left column of
the screen

• Right click in a slide in the thumbnail sidebar and select New slide
or Duplicate slide

To delete a slide, right click on the thumbnail image and press delete
OR delete from the Slide dropdown: Slide > Delete slide. If you delete a
slide in error, don't panic! Click on the Undo arrow or use the Ctrl+Z
shortcut.

To move a slide, click on the slide in the sidebar–this will highlight
the thumbnail–and drag it to where you want it to appear. A second sorting
option is to shift from the default ("Filmstrip") view to Grid view–View
> Grid view–and use a select, drag and drop method. You can toggle
between the default and Grid view by selecting the icons at the bottom of
the thumbnail window.
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Figure 4

2.4 Textboxes :
As with most actions in Google slides, there are multiple ways to add

a text box:

• Select the Text box icon from the main menu (see Figure 1).

• Select Insert > Text Box.

Using either method, your cursor will become a crosshair; position
your cursor where you want the text box to start and click to anchor. Drag
the cursor the approximate width and length of your anticipated text entry
and release the cursor. If you want to change the location of the text box,
click within the text box to highlight it and use the arrow keys on your
keyboard to reposition. To change the box dimensions, click within the text
box (if it's not already highlighted) and hover over one of the anchor points
(tiny boxes). A directional arrow will appear; click to stretch or reduce the
size; release when complete.

Figure 1
To delete a text box, select to highlight and press delete. If you change

your mind, click on the Undo (Ctrl+Z) arrow.
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2.5 Themes :
Themes are one of the formatting options within Google Slides. To

view theme options, click on Slide > Change theme. A column will appear
on the right of the screen, showing various color, layout and font options.
To see how a particular combination would work with your content, click
on your chosen theme. You can continue test–driving themes; clicking on
a new theme will replace the prior choice. There's no risk of losing your
original formatting; Undo (or Ctrl+Z) will return you to your original theme.
You can also import a theme from outside Google Slides. Click on the
Import theme button at the bottom of the themes column. Sites such as
Slides Carnival allow you to copy slide formats directly into Google Slides.

2.6 Images and ClipArt :

Using art and images adds impact and provides welcome relief to the
challenge of processing information–intensive slides. To insert an image,
select Insert > image or the image icon, to the right of the Text box icon.
As shown in Figure 1, there are multiple options for accessing images; you
can also access these options using the drop–down menu to the right of the
Image icon. You can upload images from your computer, use the camera
on your device to take a photo, link to an image using a URL, or Search
Google Images. Selecting Search the Web will link you to Google Images,
where you can use a keyword or keywords to search for images, including
quote images based on your keyword(s).

When your results appear, you'll see a small magnifying lens in the
bottom right corner of the images. Clicking on the magnifying lens allows
you to preview the image prior to selection/inserting. To exit preview (if
you don't want to choose this image), press the left (return) arrow to return
to the search options.
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To select an image, click on it and click on the INSERT button at
the bottom of the window. The image will be inserted into your current
(highlighted in the thumbnail) slide. If you change your mind, press the
escape key (ESC), Undo, or Ctrl+Z to reverse the Insert operation.

To incorporate clip art, select Insert > Image to open the Google
Image browser. In the Search area "Search for Google Images," enter your
keyword or desired image and clip art as your search terms. For example,
"brain clip art" or "brain + clip art." For more professional images, include
"stock" – stock image or stock photo – in your search. For example, "brain
stock image."

Images shown are generally in the public domain or labeled for
commercial use with modification, but as the disclaimer on the Google
Image window notes, you are responsible for ensuring that your intended
use is in accordance with the image creator's license.

2.7 Videos :
Adding video to your Google slides adds yet another level of visual

interest and engagement. To incorporate video:

1. Select Insert > Video from the main menu. A window will appear
where you can search for a YouTube video, or you can select URL
at the top of the window, and paste a URL for a specific YouTube
video.

2. Click on a video to select it and press the Select button to embed
it in your current slide. Your video is now embedded in your slide.
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2.8 Arranging Objects :

When you're creating a slide with multiple elements–for example,
layering text, imagery, lines, shapes or other objects–you may find a need
to arrange the elements or objects.

To manage objects on a slide :

1. Click Arrange from the main menu.

2. Choose from the following options :

• Order : Put the object behind or in front of text, other objects,
or images.

• Align horizontally or Align vertically : When you select
multiple objects, you can align the edges of the objects.

• Center on page : Center objects vertically or horizontally on
a slide.

• Rotate : Change the orientation of an object, by flipping or
rotating it.

• Distribute : When you select three or more objects, you can
evenly distribute the space between them.

• Group : Lock multiple objects together to make them easier to
move around and format.

The Google Slides grid line feature, enabled by default, also provides
a visual to help with alignment. When you click and drag an object, you
will see colored lines appear that will help you align the object with other
objects on the page. This setting (View > Snap to > Guides) is selected by
default.
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Figure 4

Check Your Progress :
1. To save a new Google Slides presentation:

(a) Select Ctrl+S

(b) Click to edit Untitled presentation and rename

(c) Select File > Save and title your presentation

2. Your meeting organizer sends you an email asking you to edit your
presentation down to 15 minutes to accommodate a "drop in" visit
from your President. You think it would be easier to delete and move
slides in grid view. To shift from the default to grid view :

(a) Select View and then Grid View

(b) Select Ctrl+G

(c) Select Format and then Grid View

3. You are ready to venture outside the box (slide layout templates). To
add a text in an area where there is no preformatted text box :

(a) Double click and type your text

(b) Select Insert and then Textbox

(c) Select Format and then Text

4. You want to experiment with different color, layout, and font options,
but the number of possible combinations is overwhelming. You
decide to scroll through the theme options to see how they work with
your material. To do that :

(a) Select Format > Theme and select a theme

(b) Select File > Open and select a theme

(c) Select Theme and click on a thumbnail to apply
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5. You want to add emotion to your presentation and decide to look for
a compelling image. To do that :

(a) Select View > Google Images > Enter search term > Select insert

(b) Open a browser window, search for and download an image &
drag it into your slide

(c) Select Insert > Image > Search the web > Enter search term >
Select insert

6. You're doing a lunch & learn for your team, and you want to add
something that will be engaging as well as informative. You saw a
YouTube clip recently that would be a perfect addition. To add it to
your presentation:

(a) Select Insert > Vieo > Search YouTube > Select Insert

(b) From YouTube, select Share and select the Google Slide icon

(c) From YouTube, select Share, Copy and Paste the URL into your
slide

7. One of the slides in your presentation is an introduction of three new
team members, with a row of three headshots and three text boxes
with brief profiles below. You built it on the fly, and the rows of boxes
are not even. To format the two rows horizontally, you would use
which of the following functions:

(a) Edit > Align (b) Format > Align

(c) Arrange > Centre on Page

2.9 Let Us Sum Up :

In this unit we have learn about Google Slides, a free program that's
part of Google's suite of web–based applications, including Google Docs
(word processing), we got overview of Google Slides capabilities and learn
to create effective presentation in google slide. We have learn how to create
and save a new presentation, Add, delete, and move slides, use Text Boxe,
Themes, Images and ClipArt, Videos and arranging Objects.

2.10 Answers for Check Your Progress :

1. c 2. b 3. c 4. c

5. b 6. b 7. c

2.11 Glossary :

Google Slide : Google Slides is an online presentation app that lets
you create and format presentations and work with other people.

Slide : The slides contain the information you want to communicate
with your audience.

Slide layout : Slide layouts contain formatting, positioning, and
placeholder boxes for all of the content that appears on a slide.
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Theme : A theme is a slide design that contains pre-set colors, fonts,
formatting and/or images.

Template : A PowerPoint template is a pattern or blueprint of a slide
or group of slides that you save as a . potx file. Templates can contain
layouts, colors, fonts, effects, background styles, and even content.

2.12 Assignment :

• What is google slide ?

• Write features of Google Slide

2.13 Activity :

• Create attractive presentation for business meeting

2.14 Case study :

• Learn Google sheets and Google docs

2.15 Further Reading :

• https://courses.lumenlearning.com/wm–businesscommunicationmgrs/
chapter/introduction–to–using–google–slides/
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3.0 Learning Objectives :

After studying this unit learner should be able to :

• Identify the terminology and functions common to most database
management systems.

• Identify the qualities of valuable information.

• Identify the elements of good database design.

• Create and use tables.

• Create and use queries.

• Create simple reports and forms.

• Use the Access online Help feature.

• Discuss ethical issues connected to the use of databases.

3.1 Introduction :
In this unit we will consider Microsoft Access as a proprietary

relational database structure. Proprietary as it is written using a combination
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of Visual Basic (VB) and Structured Query Language (SQL) from Microsoft.
The Microsoft Access application is available as one of the productivity
tools in the suite of Microsoft Office products. In Unit 3 and 4 of Block–
3, we saw where Excel allowed us to store and manipulate various data
sets and generated reports. Excel however has certain limitations due to
the "flat file" nature of its data structure. Access on the other hand, supports
a relational data structures

3.2 Database Overview :

A database is a collection of information centrally organized so that
various programs can have access to the same information set. Some people
refer to the database as an electronic filing system. A special program called
a Database Management System (DBMS) is used to access and manipulate
information from the database. The terms database is often used as
shorthand for DBMS.

A database may be on paper, or held in computer files such as
spreadsheets or more formally in a software system known as a computerized
database management system (for example: DB2, db4o, IMS, MS Access,
MS SQL Server, mySQL, Oracle, Sybase, Total, Versant).

A database is a critical tool for any business. It has the capability of
storing huge sums data. The data can be organised separately in various
tables and linking them together. Eg you can have a list or database of
customers. Each customer is called a record and the information relating
to a particular customer (name, sex, address) is known as attributes.
Databases can be searched or queried to produce meaningful reports for
your business. Databases can be organized as either a "flat file" (e.g. a
grocery list) such as Microsoft Excel or as a relational database with two
dimensional tables linking together.

3.3 Relational Database :

Relational Databases were introduced by E. F. Codd in 1969. We
begin with a very small example: a database with one relation, the list of
employees shown below.

Figure 1.1 : List of Employee
You should notice this looks just like a two dimensional table of rows

and columns. The name of the table is Employees, each column of the table
has its own title, and each row has the same structure. Each row has a value
for employee number, first name, last name, and gender. As tables of data
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appear in so many places (newspaper articles, text books, web pages, etc.)
it is very likely you have seen and used this representation for data
previously.

Let us assume the Employees table in figure 1.1 has one row for each
employee who works for some hypothetical company. Data kept for each
employee comprises their employee identification number, their first and
last names, and their gender. Information structured in tables is very
concise; at a glance we can obtain useful information Commercial relational
database systems are systems where data is organized into relations. Figure
1.2 shows the general structure of a relation. We say a relation comprises
a set of tuples where each tuple has the same number of attribute values,
where each attribute value is taken from some corresponding domain, and
where a domain represents a set of valid values for an attribute.

Figure 1.3 : General structure of a relation
The Employees table in figure 1.1 can be considered a relation of 5

tuples where each tuple has 4 values drawn from each of the employee
identifier, first name, last name, and gender domains.

Relations are typically implemented in commercial databases as
tabular structures comprising rows and a fixed number of columns.
Everybody is familiar with tables as they are commonplace in textbooks,
papers, magazines, etc. This simplicity of representation is one reason why
relational databases have been very successful as repositories for important
data.

3.4 Microsoft Access :

Access is a relational database that allows you to create and maintain
databases for small to medium size corporations and other organizations.
Unlike a "flat file" database, a relational database allows you divide your
data into logical pieces and place each piece in a table. This logical
separation of data makes it more powerful for further manipulation such
as queries and reporting.

Microsoft suggests that the following scenarios as some instances
when you should consider using Access :
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1. When you need to be able to collect contact information accurately
from large groups.

2. When you want a database that is easy for colleagues to explore your
information without training.

3. When you need to run the same report daily, weekly, or monthly.

4. When you want to know who your most valuable customers are so
you can target your marketing.

The list above is by no means exhaustive but in a nutshell you can
see how valuable a business tool access is. Very few if any business
activities can be executed efficiently and accurately without the use of some
form of database. In addition, Access provides various database templates
for different types and size of businesses. To provide a clearer picture of
the use of the access database Microsoft lists on its website (Fig 6.1) a
number of templates and what they are best suited for.

3.5 Access for Your Business :
Access is a mature and well supported relational database. You will

recall from Lesson 1.2 our discussion on flat file and relational data
structures. Access is a relational structure that can support huge volumes
of data for a variety of different industries. Access offers the standard
database tools in the forms of queries, reports macros etc. As an entrepreneur
or business operator you are interested in how this tool can be utilized to
support your business, and assist in improving efficiencies, increase market
share and realise profits.

Microsoft has tailored portions of the product specifically toward
business operators such as you. In so doing, you can concentrate your effort
on adopting and applying the software directly to your business needs.
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The product is available in Office 2010 called and is referred to as
"Access for your Business". It is a web based data base (cloud service) and
has three main featured components or templates

1. Turn your quotes into invoices

2. Mange your inventory and cut expenses

3. Target your customer marketing.

Turn your quotes into invoices with the services database template

Running a services business then you can appreciate how important
quotes and invoices are. The difficulty is that they are difficult to manage
and keep track of. This web based database template in access allows you
to do just that.

• Add data to your services database

• Track active quotes and invoices

• Manage all your quotes

• Manage all your invoices

• View and print reports

• Manage services, products employees and customers

Manage inventory and ship effectively
This ready–to–use–module allows you to use the goods web database

template to manage your inventory, track orders and ship efficiently if you
are running a business that sells goods. The following are some of the
functionalities that are already set up and available directly from the
template.

• Start the database

• Add existing products or goods to the database

• View orders and purchase status

• Manage products inventory and supplies

• Manage customer orders

• Restore your inventory

• View and print reports

Target your customer marketing

This database template is an excellent way to manage your customer
database by having the ability to manage essential contact information. Foe
each contact you can now manage emails, address, phone numbers, add
pictures and share documents. This detailed information on all your
customers can be used to automate your email advertising campaign. This
was discussed in Unit 3. The more you know about your customers the
better you are able to serve them, thus enhancing the speed and efficiency
of your organisation. We have spoken about using the template as a
customer database but the same templates can be applied to an employee
database, a suppliers data or any other list of stakeholders.



MICROSOFT ACCESS
BASIC FEATURES

201

3.6 Creating a Database :
The Microsoft website gives detail information on how to create and

manipulate the access database. The following section is taken from the
website to give you a sense of the major database activities. These include :

1. To create a database by using a template

2. To create a database without using a template

3. To create a table in Design View

4. To copy data from another source into an access table

5. To Import, append, or link to data from another source

Create a Database by Using a Template
Access comes with a variety of templates that you can use as–is or

as a starting point. A template is a ready–to–use database that contains all
the tables, queries, forms, and reports needed to perform a specific task.
For example, there are templates that you can use to track issues, manage
contacts, or keep a record of expenses. Some templates contain a few
sample records to help demonstrate their use. If one of these templates fits
your needs, using it is usually the fastest way to get a database started.
However, if you have data in another program that you want to import into
Access, you might decide it is better to create a database without using a
template. Templates have a data structure already defined, and it might
require a lot of work to adapt your existing data to the template's structure.

Create a database without using a template
If you are not interested in using a template, you can create a database

by building your own tables, forms, reports, and other database objects. In
most cases, this involves one or both of the following:

1. Entering, pasting, or importing data into the table that is created when
you create a new database, and then repeating the process with new
tables that you create by using the Table command on the Create tab.

2. Importing data from other sources and creating new tables in the
process.

Access creates the database with an empty table named Table1, and
then opens Table1 in Datasheet view. The cursor is placed in the first empty
cell in the Click to Add column.

Begin typing to add data, or you can paste data from another source.

Entering data in Datasheet view is designed to be very similar to
working in an Excel worksheet. The table structure is created while you
enter data. When you add a new column to the datasheet, a new field is
defined in the table. Access automatically sets each field's data type, based
on the data that you enter.
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3.7 Create a Table, Starting in Design View :
In Design view, you first create the table structure. You then switch

to Datasheet view to enter data, or enter data by using some other method,
such as pasting, or importing.

You can begin typing data in the table at any time by switching to
Datasheet view and clicking in the first empty cell. You can also paste data
from another source.

Set field properties in Design view Regardless of how you created
your table, it is a good idea to examine and set field properties. While some
properties are available in Datasheet view, some properties can only be set
in Design view. To switch to Design view, right–click the table in the
Navigation Pane and then click Design View. To see a field's properties,
click the field in the design grid. The properties are displayed below the
design grid, under Field Properties.

3.8 Copy Data from Another Source into An Access Table :
If your data is currently stored in another program, such as Excel, you

can copy and paste it into an Access table. In general, this works best if
your data is already separated into columns, as they are in an Excel
worksheet. If your data is in a word processing program, it is best to separate
the columns of data by using tabs, or to convert the data into a table in the
word processing program before you copy the data. If your data needs any
editing or manipulation (for example, separating full names into first and
last names), you might want to do this before you copy the data, especially
if you are not familiar with Access.

When you paste data into an empty table, Access sets the data type
of each field according to what kind of data it finds there. For example,
if a pasted field contains nothing but date values, Access applies the Date/
Time data type to that field. If the pasted field contains only the words "yes"
and "no", Access applies the Yes/No data type to the field.

Access names the fields depending on what it finds in the first row
of pasted data. If the first row of pasted data is similar in type to the rows
that follow, Access determines that the first row is part of the data and
assigns the fields generic names (F1, F2, etc.). If the first row of pasted data
is not similar to the rows that follow, Access determines that the first row
consists of field names. Access names the fields accordingly and does not
include the first row in the data. If Access assigns generic field names, you
should rename the fields as soon as possible to avoid confusion.

3.9 Import, Append, or Link to Data from Another Source :
You might have data that is stored in another program, and you want

to import that data into a new table or append it to an existing table in
Access. Or you might work with people who keep their data in other
programs, and you want to work with it in Access by linking to it. Either
way, Access makes it easy to work with data from other sources. You can
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import data from an Excel worksheet, from a table in another Access
database, from a SharePoint Foundation list, or from a variety of other
sources.

3.10 Open An Existing Access Database :

You can directly open a data file in an external file format, such as
dBASE, Microsoft Exchange, or Excel. You can also directly open any
ODBC data source, such as Microsoft SQL Server. Access automatically
creates a new Access database in the same folder as the data file, and adds
links to each table in the external database.

Check Your Progress :

State whether the following statements are true or false
1. A database is a collection of information centrally organized so that

various programs can have access to the same information set.

2. Access is a relational database that allows you to create and maintain
databases for small to medium size corporations and other
organizations.

3. Access creates the database with an empty table named Tuple–1

4. Access names the fields depending on what it finds in the first row
of pasted data.

5. Access comes with a variety of templates that you can use as–is or
as a starting point.

3.11 Let Us Sum Up :

Microsoft Access is a full–fledged well developed and supported
database application that is more than capable of meeting the needs of small
to medium business operations. Very few business tasks can be completed
without the use of a structured database. Some will argue what about
excel ? In unit 1 we explained the limitations on Excel

In this lesson we introduced the concept of access web templates for
business and highlighted the three templates that can support your business
activities, whether you are selling goods or services.

We also looked at the common database functions that you will be
undertaking once you are engaged in the access database environment.

As you work with databases in general and templates in particular,
you may discover that you want to do more with them or better modify
them to suit your needs. The how to page on the Microsoft website provides
a complete step by step set of instructions on how to create and modify
the access database.

3.12 Answers for Check Your Progress :
1. True 2. True 3. False 4. True 5. True
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3.13 Glossary :
Microsoft Access : Access is a relational database that allows you

to create and maintain databases for small to medium size corporations and
other organizations.

Database : A database is a collection of information centrally
organized so that various programs can have access to the same information
set.

RDBMS : A relational database is a type of database that stores and
provides access to data points that are related to one another. Relational
databases are based on the relational model, an intuitive, straightforward
way of representing data in tables.

3.14 Assignment :
• What is Microsoft Access ?

• What is database ?

• List and explain the major database activities

• Explain two ways of creating database in Microsoft Access

• How can we Import, append, or link to data from another source ?

• How can we open and existing Access Database

3.15 Activity :
• Create database for student admission data

3.16 Case Study :

• Are you currently using Excel in your business ? If yes, is it meeting
all your current database needs ? If not, migrate it into Microsoft
Access

3.17 Further Reading :

• http://office.microsoft.com/en–us/access–help/use–the–contacts–web–
database–template–to–target–your–customer–marketing–more–
efficiently–HA102420593.aspx#_Toc284427748

• http://office.microsoft.com/en–us/access–help/use–the–contacts–web–
database–template–to–target–your–customer–marketing–more–
efficiently–HA102420593.aspx#_Toc284427749

• http://office.microsoft.com/en–us/access–help/use–the–contacts–web–
database–template–to–target–your–customer–marketing–more–
efficiently–HA102420593.aspx#_Toc284427750

• http://office.microsoft.com/en–us/access–help/use–the–contacts–web–
database–template–to–target–your–customer–marketing–more–
efficiently–HA102420593.aspx#_Toc284427755

• http://office.microsoft.com/en–us/access–help/use–the–contacts–web–
database–template–to–target–your–customer–marketing–more–
efficiently–HA102420593.aspx#_Toc284427756
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• http://office.microsoft.com/en–us/access–help/use–the–contacts–web–
database–template–to–target–your–customer–marketing–more–
efficiently–HA102420593.aspx#_Toc284427757

• http://office.microsoft.com/en–us/access–help/use–the–contacts–web–
database–template–to–target–your–customer–marketing–more–
efficiently–HA102420593.aspx#_Toc284427758

• http://office.microsoft.com/en–us/access–help/use–the–contacts–web–
database–template–to–target–your–customer–marketing–more–
efficiently–HA102420593.aspx#_Toc284427759
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BLOCK SUMMARY

Tools, no matter how sophisticated, are simply tools. Moving from

the right tools to a good presentation involves perspective and planning.

We have learn two ways to create attractive and effective presentation i.e.

Microsoft PowerPoint and Google Slide. We have also learn how to create

database using Microsoft Access. We introduced the concept of access

templates for business and highlighted the three templates that can support

your business activities, whether you are selling goods or services.
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BLOCK ASSIGNMENT

Short Questions :

• What is presentation software ?

• What is database

• What is relational database ?

• What is template ?

• What is relation in relational database ?

Long Questions :

• Write detailed note on presentation softwares

• Explain in details about Microsoft Access Template and its uses

• Describe features of Microsoft Access
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 Enrolment No. : 

1. How many hours did you need for studying the units ?

Unit No. 1 2 3

No. of Hrs.

2. Please give your reactions to the following items based on your reading
of the block :

3. Any other Comments

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................
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